Table of Contents
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Introduction</td>
</tr>
<tr>
<td>8</td>
<td>Thanks!</td>
</tr>
<tr>
<td>8</td>
<td>About this Documentation</td>
</tr>
<tr>
<td>10</td>
<td>Making Audio Settings</td>
</tr>
<tr>
<td>11</td>
<td>Introduction</td>
</tr>
<tr>
<td>11</td>
<td>Windows Computers</td>
</tr>
<tr>
<td>14</td>
<td>Macintosh Computers</td>
</tr>
<tr>
<td>16</td>
<td>Overview and Basic Concepts</td>
</tr>
<tr>
<td>17</td>
<td>Introduction</td>
</tr>
<tr>
<td>17</td>
<td>Song Mode vs. Pattern Mode</td>
</tr>
<tr>
<td>18</td>
<td>Setting Values</td>
</tr>
<tr>
<td>19</td>
<td>Using the Computer Keyboard</td>
</tr>
<tr>
<td>19</td>
<td>MIDI</td>
</tr>
<tr>
<td>19</td>
<td>Real Time Operation</td>
</tr>
<tr>
<td>19</td>
<td>The Song Window</td>
</tr>
<tr>
<td>20</td>
<td>Pattern Selection</td>
</tr>
<tr>
<td>21</td>
<td>Using Shuffle</td>
</tr>
<tr>
<td>22</td>
<td>About Focus and the Focus Bar</td>
</tr>
<tr>
<td>23</td>
<td>The Mixers</td>
</tr>
<tr>
<td>24</td>
<td>About Levels</td>
</tr>
<tr>
<td>25</td>
<td>Programming Rhythm Patterns</td>
</tr>
<tr>
<td>26</td>
<td>Introduction</td>
</tr>
<tr>
<td>26</td>
<td>Preparations for Creating a Rhythm Pattern</td>
</tr>
<tr>
<td>27</td>
<td>Soloing the Rhythm Section</td>
</tr>
<tr>
<td>27</td>
<td>Programming and Playback</td>
</tr>
<tr>
<td>28</td>
<td>Selecting Sounds</td>
</tr>
<tr>
<td>29</td>
<td>Adding and Removing Notes</td>
</tr>
<tr>
<td>32</td>
<td>Tap Recording</td>
</tr>
<tr>
<td>33</td>
<td>Deleting notes via the Computer Keyboard</td>
</tr>
<tr>
<td>34</td>
<td>Working with Shared Instruments on the 808 section</td>
</tr>
<tr>
<td>35</td>
<td>Working with Accents</td>
</tr>
<tr>
<td>35</td>
<td>About Open and Closed Hi-hat</td>
</tr>
<tr>
<td>36</td>
<td>Clearing the Pattern</td>
</tr>
<tr>
<td>36</td>
<td>Working with Various Pattern Lengths</td>
</tr>
<tr>
<td>37</td>
<td>Sound Parameters</td>
</tr>
<tr>
<td>38</td>
<td>Programming Synth Patterns</td>
</tr>
<tr>
<td>39</td>
<td>Preparations</td>
</tr>
<tr>
<td>39</td>
<td>Soloing a Synth Section</td>
</tr>
<tr>
<td>40</td>
<td>Programming and Playback</td>
</tr>
<tr>
<td>40</td>
<td>Clearing the Pattern</td>
</tr>
<tr>
<td>40</td>
<td>Basic Procedures</td>
</tr>
<tr>
<td>42</td>
<td>Using Pitch Mode</td>
</tr>
<tr>
<td>43</td>
<td>Using the Keyboard for Creating and Editing Patterns</td>
</tr>
<tr>
<td>45</td>
<td>Working with Octave settings</td>
</tr>
<tr>
<td>45</td>
<td>Working with Accents</td>
</tr>
<tr>
<td>45</td>
<td>Working with Slide</td>
</tr>
<tr>
<td>46</td>
<td>Clearing the Pattern</td>
</tr>
<tr>
<td>46</td>
<td>Working with Various Pattern Lengths</td>
</tr>
<tr>
<td>47</td>
<td>The Synth Sound settings</td>
</tr>
<tr>
<td>48</td>
<td>Waveform</td>
</tr>
<tr>
<td>48</td>
<td>Tune</td>
</tr>
<tr>
<td>48</td>
<td>Cutoff</td>
</tr>
<tr>
<td>48</td>
<td>Resonance</td>
</tr>
<tr>
<td>49</td>
<td>Env. Mod. (Envelope Modulation)</td>
</tr>
<tr>
<td>49</td>
<td>Decay</td>
</tr>
<tr>
<td>49</td>
<td>Accent</td>
</tr>
<tr>
<td>49</td>
<td>The “Vintage ReBirth Synth Sound” switch</td>
</tr>
<tr>
<td>50</td>
<td>Pattern Editing Functions</td>
</tr>
<tr>
<td>51</td>
<td>Cut, Copy and Paste (Pattern)</td>
</tr>
<tr>
<td>52</td>
<td>Pattern Functions</td>
</tr>
<tr>
<td>55</td>
<td>Mixing &amp; Effects</td>
</tr>
<tr>
<td>56</td>
<td>Introduction</td>
</tr>
<tr>
<td>56</td>
<td>Setting Levels</td>
</tr>
<tr>
<td>57</td>
<td>Muting</td>
</tr>
<tr>
<td>57</td>
<td>Using Pan</td>
</tr>
<tr>
<td>58</td>
<td>Effect Routing</td>
</tr>
<tr>
<td>59</td>
<td>Dist (Distortion)</td>
</tr>
<tr>
<td>61</td>
<td>The PCF (Pattern Controlled Filter)</td>
</tr>
<tr>
<td>67</td>
<td>Compressor</td>
</tr>
<tr>
<td>69</td>
<td>Delay</td>
</tr>
<tr>
<td>71</td>
<td>Creating and Playing Songs</td>
</tr>
<tr>
<td>----</td>
<td>---------------------------</td>
</tr>
<tr>
<td>72</td>
<td>Introduction</td>
</tr>
<tr>
<td>72</td>
<td>About the Song/Pattern Modes</td>
</tr>
<tr>
<td>73</td>
<td>Playing Songs</td>
</tr>
<tr>
<td>74</td>
<td>How the Song Sequencer works – The “Signal Flow”</td>
</tr>
<tr>
<td>75</td>
<td>Preparations for Creating your own Songs</td>
</tr>
<tr>
<td>76</td>
<td>Building a String of Patterns</td>
</tr>
<tr>
<td>79</td>
<td>Correcting Mistakes and Making changes to the Pattern Order</td>
</tr>
<tr>
<td>80</td>
<td>Recording Control (knob) Changes</td>
</tr>
<tr>
<td>82</td>
<td>Correcting Mistakes and Making Changes to Control (knob) Recordings</td>
</tr>
<tr>
<td>84</td>
<td>Recording while Looping</td>
</tr>
<tr>
<td>84</td>
<td>About Recording Pattern changes vs. Control Changes</td>
</tr>
<tr>
<td>85</td>
<td>Making Modifications to Patterns</td>
</tr>
<tr>
<td>85</td>
<td>Moving, Removing and Repeating Measures in the Song</td>
</tr>
<tr>
<td>87</td>
<td>Using the Song Feature in a “live” situation</td>
</tr>
<tr>
<td>88</td>
<td>Using “Mods”</td>
</tr>
<tr>
<td>89</td>
<td>What is a Mod?</td>
</tr>
<tr>
<td>91</td>
<td>Creating a New Song with a Certain Mod</td>
</tr>
<tr>
<td>91</td>
<td>Switching Mods for an Open Song</td>
</tr>
<tr>
<td>92</td>
<td>Opening Songs that use Non-Standard Mods</td>
</tr>
<tr>
<td>94</td>
<td>The Mod dialog</td>
</tr>
<tr>
<td>95</td>
<td>Adding Mods to your Setup</td>
</tr>
<tr>
<td>96</td>
<td>Creating Your own Mods</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>101</th>
<th>ReWire – Using ReBirth RB-338 with Cubase VST</th>
</tr>
</thead>
<tbody>
<tr>
<td>102</td>
<td>Why use ReBirth RB-338 with Cubase?</td>
</tr>
<tr>
<td>102</td>
<td>Introducing ReWire!</td>
</tr>
<tr>
<td>103</td>
<td>System Requirements</td>
</tr>
<tr>
<td>103</td>
<td>Preparations for Using ReWire - Macintosh only</td>
</tr>
<tr>
<td>104</td>
<td>Launching and Quitting</td>
</tr>
<tr>
<td>105</td>
<td>Activating ReWire Channels</td>
</tr>
<tr>
<td>106</td>
<td>Signal Routing</td>
</tr>
<tr>
<td>108</td>
<td>Using the Transport and Tempo Controls</td>
</tr>
<tr>
<td>109</td>
<td>How the ReWire Channels are handled in Cubase VST</td>
</tr>
<tr>
<td>110</td>
<td>Converting ReWire Channels to Audio Tracks</td>
</tr>
<tr>
<td>110</td>
<td>Considerations and Limitations</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>111</th>
<th>Using ReBirth RB-338 with Other Equipment and Programs</th>
</tr>
</thead>
<tbody>
<tr>
<td>112</td>
<td>Cubase users – Read This!</td>
</tr>
<tr>
<td>112</td>
<td>Synchronization with Other Equipment</td>
</tr>
<tr>
<td>120</td>
<td>Using “Live Sync”</td>
</tr>
<tr>
<td>123</td>
<td>Running multiple Audio Applications on one Computer</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>126</th>
<th>Remote MIDI Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>127</td>
<td>Introduction</td>
</tr>
<tr>
<td>128</td>
<td>Setting up Remote MIDI Control from External MIDI Hardware</td>
</tr>
<tr>
<td>129</td>
<td>Setting up Remote MIDI Control from another Program</td>
</tr>
<tr>
<td>130</td>
<td>Standard Mapping vs Quick Mapping</td>
</tr>
<tr>
<td>131</td>
<td>Setting up Quick Mapping</td>
</tr>
<tr>
<td>133</td>
<td>Using Remote MIDI Control</td>
</tr>
<tr>
<td>134</td>
<td>Important Notes about MIDI Control</td>
</tr>
</tbody>
</table>
1

Introduction
Thanks!

Thanks for choosing ReBirth RB-338!

It is our sincere belief that this program will prove to be a valuable, exciting and creative tool in your music making. Our primary goal during the development of ReBirth RB-338 has been to deliver what software synthesis for so long has promised: a real alternative to expensive and – in this case – partly “extinct” hardware. We simply love synthesizers, and this love has been a major motivation during the development process.

Now we hand our creation over to you. We hope you will have as much fun using it as we had designing it!

We’d also like to take this opportunity to thank everybody that helped out during development, for the enormous support!

Please stay in touch, preferably via the web sites (www.propellerheads.se and www.steinberg.net). We need your comments and ideas for the future!

Again, thanks!

Propellerhead Software/Steinberg Soft- & Hardware GmbH

About this Documentation

- All the snapshots in this manual have been taken with the standard version of ReBirth RB-338. We recommend that you don’t start using “Mods” until you feel comfortable with the location of the various controls on the panel. The reason for this is that in a “Mod”, controls may be named differently and will certainly not look like in the standard version.

Using Acrobat Documents

The following methods will help you find the information you require:

- Use the Table of Contents provided by the Adobe Acrobat Reader program.
- Use the Adobe Acrobat Reader Find function.
- Click on a cross-reference (green text) to jump to the respective topic.

It is possible to print out this document or parts of it.

Additional Information on how to use the Adobe Acrobat Reader program can be found in its on-line Help.
How the Documentation is Organised

The documentation for ReBirth RB-338 is divided into two parts:

- **The printed documentation.**
  This describes how to install the program and gets you started using it.

- **This on-line documentation**
  This contains detailed instructions, reference material, troubleshooting and index.
Making Audio Settings
Introduction

It is extremely important that you make the correct audio settings on your computer. Please follow the instructions for each computer platform, below.

Windows Computers

The following text is a duplication of the help file that appears automatically when you first launch ReBirth for Windows. If you have just followed the on-screen instructions, you naturally don’t need to do this all again!

Selecting an Audio Card Driver

- If you are unsure about the terminology and concepts used in the following text, look up the chapter “Audio on Computers” in this manual.

First, you must determine if you have DirectX installed on your system, or not:

1. Open the Preferences dialog and locate the sound card settings.

![The sound card settings in the Preferences dialog.](Image)

2. Pull down the Audio Card driver pop-up and select the last item.

3. Check the text below the box, does it say "Driver type: Direct X"?
   - If it does, you have DirectX installed. Proceed to the next step, “Finding out if your DirectX Driver is Emulated or not”.
   - If it doesn’t, instead skip to the heading “Selecting an MME Driver” below.
Finding out if your DirectX Driver is Emulated or not

If (and only if) you have DirectX installed you need to find out if the audio card driver is emulated or not. You should not use an emulated DirectX driver with Re-Birth RB-338. To find out which type of driver you have, proceed as follows:

1. Pull down the Audio Card driver pop-up and select the drivers that correspond to the card you want to use, one by one.

2. For each one, check the text after “Driver type:” below the pop-up.
   - If one says Direct X only (and the word emulated is not mentioned), use this driver. Then proceed to the heading “Setting the Audio Card Buffer”, below.
   - If all say emulated, you should not use any DirectX driver. Instead read “Selecting an MME Driver”, below.

Selecting an MME Driver

To select the appropriate MME (Multimedia Extensions) driver, proceed as follows:

1. Pull down the Audio Card driver pop-up and select the first item on the menu that corresponds to the name of the card you want to use. You should avoid choosing generic driver names.

2. Check the text below the box, it should say ”Driver type: MME”. If it doesn’t, select another driver.

3. Proceed to the heading “Setting the Audio Card Buffer”, below.

Setting the Audio Card Buffer

It is very important that you trim the buffer setting properly. The buffer setting is a balance between fast response to control changes on one hand and “safe” audio playback on the other.

1. Open one of the demonstration songs.

2. Activate Playback.

3. Open the Preferences dialog, from the Edit menu.

4. In the Preferences dialog, locate the playback performance slider and drag it all the way to the right.

5. Now drag the playback performance slider to the left, a bit at a time. Try positions further and further to the left, until the sound starts ”breaking up” and the Underruns indicator starts incrementing.

6. Drag the fader a little bit to the right, so that the sound is OK again.
• If you use DirectX under Windows 95, you will normally be able to trim
the buffer sizes down to between 40 and 90 milliseconds.

• If you use MME under Windows 95, the same figure will normally be
around 160 milliseconds.

7. Close the dialog.

You are now finished with your audio settings for ReBirth. The settings you just
made are stored automatically.
Macintosh Computers

Why are there two ways of Playing back Audio?

ReBirth uses the Sound Manager on the Macintosh to play audio. This allows it to play in the background and happily co-exist with other audio applications. Great care has been taken to make ReBirth compatible with all other Sound Manager applications. This is what we call “Multitasking friendly” audio playback.

However, there’s a problem with some combinations of Sound Manager versions and certain Mac hardware, where ReBirth can’t automatically determine the correct “audio buffer size”. This might lead to crackles or glitches in the audio playback.

We recommend all users to check the buffer size, as described below, even if you don’t have problems with your audio. If you can use a lower buffer setting than the default, the program will be more responsive to control movements.

On some rare occasions, adjusting the buffer size might not be enough to remedy the Sound Manager problems. In this case, you have the option of selecting another method for playing back audio, which we call “Crackle safe”. Selecting this method has some drawbacks though, see the end of this chapter.

Setting the Correct Buffer Size

Normally you should leave the Sound Manager Audio setting at “Multitasking friendly”. However, you should make sure you have the correct audio buffer size setting. Proceed as follows:

1. Open one of the demonstration songs.

2. Activate Playback.

3. Open the Preferences dialog, from the Edit menu.

   ![Preferences dialog]

4. Locate the Buffer size pop-up.

5. Select the smallest buffer size that allows you to play back audio without problems.

6. If none of the buffer sizes seem to work, switch from “Multitasking friendly” to “Crackle safe”, in the Preferences dialog and set the buffer pop-up to the value closest to “(1024)”.
About the Crackle Safe Option

Selecting the Crackle Safe option will make sure that ReBirth RB-338 works properly in all situations. However, the mouse pointer will not move as smoothly and you might possibly run into audio problems with other programs playing via the Sound Manager. Furthermore ReBirth RB-338 might possibly disturb other background processes such as networking.

System 8 note

System 8 users should make sure virtual memory is turned off in the Memory control panel, since it affects audio playback.

If you have to have virtual memory activated for some reason, you might have to raise the buffer settings drastically to get clean audio playback.

System 8.1 Note

In Mac OS 8.1, Apple have reduced the size of their sound buffers, which means that latency has been cut in half. To take advantage of this, proceed as follows.

1. Open one of the demonstration songs.

2. Activate Playback.

3. Open the Preferences dialog, from the Edit menu.

4. Make sure the Multitasking friendly option is selected.

5. Locate the Buffer size pop-up.
   This allows you to adjust the audio buffer size.

6. Select the smallest buffer size.
   This will probably make the sound completely garbled.

7. Select the next larger buffer size.

8. Repeat with the next larger buffer size, until the sound is OK.
   You now have the smallest possible buffer setting that works on your system.
Overview and Basic Concepts
Introduction

This chapter introduces you to some basic methods and concepts in ReBirth RB-338. To get a “hands-on” introduction to the program, read the quick tutorials in the printed documentation.

All the snapshots in this manual have been taken with the standard version of ReBirth RB-338. We recommend that you don’t start using “Mods” until you feel comfortable with the location of the various controls on the panel. The reason for this is that in a “Mod”, controls may be named differently and will certainly not look like in the standard version.

Song Mode vs. Pattern Mode

The Song/Pattern Mode switch.

These are the two major modes in ReBirth RB-338. Basically, Pattern mode is for creating Patterns and experimenting with sounds and other settings. Song mode is for stringing Patterns together and recording the automation of controls. Here are a couple of the major differences between the two modes:

- In Pattern mode, the controls are all manual, that is, if you move them they stay where you left them. In Song mode, the controls are all automated, that is they will move automatically on playback, if movements have been recorded.

- In Pattern mode, the Loop feature has no function, the currently selected Patterns always loop. In Song mode the Loop is used for repeating any section of the Song.
Setting Values

Apart from the normal operations, double clicking, dragging, using menus, etc, Re-Birth RB-338 employs some special techniques for changing values:

Knobs

Knobs come in a number of different shapes.

Knobs are always operated in the same way: To change a value, press the mouse button over the knob, and drag up/down.

To change the value in smaller steps (fine tune) hold down [Shift] before pressing the mouse button.

Faders

An example of a fader.

To move a fader, press the mouse button over the handle and drag up/down.

Value displays

A value display.

The value displays have two small arrow buttons located beside them.

- Clicking either of these buttons changes the value one step up/down.
- Keeping the mouse button pressed over an arrow, makes the value change continuously.
Using the Computer Keyboard

The computer keyboard is used for four purposes:

- **For menu shortcuts.**
  These are listed on page 221.

- **For Transport controls (Play, Stop, Rewind etc).**
  This is mainly done from the numeric key pad. Again see page 224.

- **For quick programming of the 303 synthesizers.**
  To do this, activate “Program Synth from Keyboard” on the Options menu. For more information, see page 43.

- **Rhythm Tap recording.**
  See page 32.

- **For Pattern switching.**
  For this to work, “Select Patterns from Keyboard” must be active, on the Options menu. See page 224 and below for details.

MIDI

MIDI is used for two things in ReBirth RB-338.

- For synchronization to other equipment, see page 112.
- For Remote Control, see page 127.

Real Time Operation

All operations in ReBirth RB-338 can be executed while the program is playing, even saving to disk! There is no need to turn off playback to perform any operation!

The Song Window

There’s only one major type of window in ReBirth RB-338 – the Song window. This is a standard Windows/Macintosh window that can be moved and resized like any other. When you make the window smaller than maximum size, a scroll bar allows you to scroll the sections. The Transport bar, however, is always at the top of the window.
Pattern Selection

The Pattern selectors.

How to Select a Pattern

Each of the three main sections has 32 Patterns, arranged in 4 Banks of 8 Patterns.

- To select a Pattern in the current Bank using the mouse, simply click on the corresponding Pattern button.
- To select a Pattern from the computer keyboard, make sure “Select Patterns from Keyboard” is activated on the Options menu and press the relevant key, as indicated in the figure below.
- To select a Pattern in another Bank, first select a Bank, using the buttons labelled A to D, then select a Pattern.
  No change takes place until you actually select a Pattern.

You can also select Patterns via MIDI, see page 127.

Switching a Section Off

You can turn a section off completely, by deactivating it in the Pattern section. This is equivalent to selecting a silent Pattern.

A section, activated and deactivated.
Pattern Changes take Effect on the Next Downbeat

When you select a new Pattern, the change doesn’t take effect until the end of the Pattern.

This can be used to good effect, especially when switching Patterns from the computer keyboard; you have time to hit the right key in advance.

Please note that this is true for each individual Pattern, regardless of its length. For very short Patterns, it is more important to hit the key or press the mouse button at the right time.

Using Shuffle

ReBirth RB-338 has a Shuffle (swing) feature. It used to give the music a swing effect, often used in for example house music. This effect is achieved by delaying all sixteenth notes that fall in between the eight notes. Proceed as follows:

1. In the Pattern section, activate Shuffle for the desired sections.

2. Adjust the amount of Shuffle by using the knob to the left of the tempo display.
   Somewhere around the “two o’clock” setting you will find a classic “triplet” feel.
About Focus and the Focus Bar

Many operations may only be performed on one of the three main sections in Re-Birth RB-338 at a time. To see which section “has the focus”, look for the vertical orange bar, to the right of the Pattern selectors.

In this example, the 808 rhythm section has the focus, as indicated by the orange bar.

The focus can be moved to the relevant section, in one of three ways:

- **By clicking with the mouse in the relevant section.**
- **By selecting a Pattern in a section.**
  This automatically sets the focus to that section.
- **By using the up and down arrow keys on the computer keyboard.**
The Mixers

Section Mixers

In the Mixer parts of the various sections, you can adjust the relative balance of volume. You can also adjust things like panning (stereo positioning) and effects. This is all covered in great detail in the chapter “Mixing & Effects”. For now please note that:

- **If a section is too loud or weak, use the volume faders to balance it.** The small meter gives you an indication of the output level from this section.

- **If you want to move the sound left/right in the stereo image, use the Pan control.**

Master Level

The master level adjusts the overall audio output from the program. For more info, see the next paragraph.
About Levels

You have to be slightly careful when adjusting levels so that you don’t get any unwanted distortion on the master output, due to a phenomenon called clipping. On the other hand, levels that are too low can lead to an undesired amount of noise.

- Clipping cannot occur within an individual section, even when it’s volume is set to maximum. Any distortion that appears can always be removed by lowering the Master level, as described below.

Here’s our recommended procedure for setting levels:

1. **Set up a rough balance between the three sections.**

2. **Lower or raise the master level so that the signal on the meters only hit “the red”, during the loudest passages.**

3. **If you change your mixer levels, or adjust the sound on the 303 synth section, be sure to re-check the master level.**

So why is it so important to adjust the levels correctly? Those of you who only have experience of analog equipment should note that digital levels are completely different in nature. A digital audio system can by definition only represent a limited range of levels correctly. This is called the dynamic range.

When you try to exceed the dynamic range (when the signal is amplified to a level the system can’t handle), hard clipping occurs, and the sound will be distorted in a very harsh, unpleasant way (if you like this distortion, go ahead and use it, we don’t mind. We just want to make sure you don’t run into it unintentionally.)

On the other hand, if the levels are too low the signals may not be represented accurately enough and unwanted noise will be audible.

Systems based on personal computers are slightly different compared to dedicated digital audio systems, by nature. Maintaining the dynamic range properly is even more critical in a personal computer system. Therefore, in our efforts to provide you with the best possible sound quality in all situations, we have handed over some of the responsibility to you, the user.

It’s up to you to check and adjust the master level. This method ensures the highest possible sound quality, in all situations.
Programming Rhythm Patterns
Introduction

There are two rhythm sections in ReBirth RB-338. The upper is based on the Roland TR-808 and the lower on the Roland TR-909. In this chapter we refer to them as the 808 and 909 sections.

Preparations for Creating a Rhythm Pattern

1. If required, create a New song or Open an existing one.

2. Make sure that Pattern mode is selected.
   You can only program Patterns in Pattern mode. See page 17.

3. Set the focus to the rhythm section you want to program.
   See page 22 for details.

4. Select a Pattern to program.
   How to do this is described on page 20.

5. The Pattern you select can be empty or it can be one already playing some rhythm, it doesn’t matter. If it already plays something, you can either clear it (see later in this chapter) to start over from scratch, or modify the existing rhythm as you like.

Please note that it is often convenient to make copies of the same basic rhythm into a few Pattern locations. You can then make minor or major variations to this rhythm, in each of the Patterns, and use them in various parts of the Song. For more info on copying, see page 51.
Soloing the Rhythm Section

If you want to make sure that you are only hearing the rhythm section you are working on, while programming, you will want to turn off all other sections:

- Click on the on/off button (in the upper left corner) in the mixer for all other sections, to turn them off.

In this example, the synths and the 909 are turned off, so that only the 808 will be heard.

Programming and Playback

You can program rhythms, either when the program is in stop mode or when it is playing. It doesn’t really matter which, but the most convenient is probably to have playback going so that you will hear how the Pattern evolves as it repeats.
Selecting Sounds

Before you can start programming any notes, you must of course select a sound. This can be done in several ways:

- **On the 808, you can use the large rotary knob to the right.** Drag up/down, as always.

  ![The 808 sound selector knob.](image)

- **On both rhythm section you can click directly on the sound name legends.**

  ![The sound selector buttons in the 808 section.](image)
  ![The sound selector buttons in the 909 section.](image)

- **Via MIDI, see page 127.**

  A list of all sounds can be found on page 149.

**About “Shared slots” in the 808 section**

Some instrument “slots” in the 808 are shared by two sounds. One example is Low Tom (LT) and Low Conga (LC). You select between shared instruments as the illustration below indicates:

![First click in either of these two places ...then click on the switch.](image)

More about shared instruments on page 34.
Adding and Removing Notes

808 Section – Clicking to Add or Remove notes

To add notes with the selected sound, proceed as follows:

- **Click on the colored step buttons, to add a note with the selected sound.**
  The step buttons that are lit up indicate programmed notes.

The sixteen step buttons represent sixteenth notes in a measure. If you for example add notes at step 1 and step 9, you will get sounds at the downbeat and on the third quarter.

Here, a bass drum is programmed on step 1 and 9 in the 808 section.

- **You can remove notes in the same way, by clicking on steps that are already lit up.**

808 Section – Dragging to add or Remove Notes

You can also drag to add/remove a number of notes at the same time. Whether the drag operation adds or removes notes depends on the step where you start dragging. If this is empty, you will be adding, if it already plays a note, you will be removing.

If for example you want to add a sound at all sixteenth notes in a Pattern, proceed as follows:

1. **Locate a step where there is no note (not lit up).**
2. **Position the pointer over this step, and press the mouse button.**
3. **Drag back and forth over the steps, without releasing the mouse button.**
4. **When all step buttons are lit up, release the mouse button.**

Dragging to add notes on all sixteenths.
909 Section – Clicking to Add or Remove notes

This is very much like the 808, but each sound can play with one or two levels.

- **Click once on a “dark” (as opposed to light) step buttons, to add a note with low level.**
  The step button displays a light color.

- **Click again on the same button to switch to a note with high level.**
  The step button displays a brighter color.

- **Click a third time to turn off the step.**
  The button goes dark again.

909 – Flam Programming

The 909 section features flam programming, that is, a double hit with a short time interval in between, like when a drummer hits a drum with both sticks, but not exactly at the same time. To program flams with the selected instrument, proceed as follows:

1. **Activate the Flam button.**

2. **Click once on a step to make it play a flam hit. Click again to turn that step off.**

3. **Adjust the “width” of the flam (the time between the two hits), using the Flam knob.**
   This setting is global for all hits.

4. **When you are done with Flam programming, deactivate the Flam button.**
909 – Quick Programming using Modifier Keys

You can use modifier keys to quickly access the step programming functions above. This allows you to specify the type of hit for a step regardless of what type of hit it played before. It also means you don’t have to use the Flam button for programming flams.

- **To program a step with low volume, hold down [Command] (Mac)/[Ctrl] (Windows) and click once.**
  To turn the step off, click again.

- **To program a step with high volume, hold down [Option] (Mac)/[Alt] (Windows) and click once.**
  To turn the step off, click again.

- **To program a flam hit, hold down [Command]+[Option] (Mac)/[Ctrl]+[Alt] (Windows) and click once.**
  To turn the step off, click again.
Tap Recording

The computer keyboard can be used for programming any and all rhythm sounds, by “tapping” the correct keys.

The key row starting with A is used for accessing the drum sounds, starting with BD, Bass Drum. The accent is reached from the minus key in the top row.

808 Section

All key mapping is based on an American keyboard layout!
On the Macintosh, the keys are always in the positions indicated in the picture above, but the labels on the keys may be different in your country.
Under Windows, you may need to press other keys, depending on the keyboard layout in your country.

Performing the Tap Recording

To use Tap Recording, proceed as follows:

1. Make sure you are in Pattern mode.

2. Create a simple beat as a metronome, so that you know where in the beat you are.

3. Make sure “Program Synth from Keyboard” is activated on the Options menu.
4. Activate playback.

5. **Make sure the desired rhythm section has the focus.**
   See page 22 for more info on focus.

6. **Hit the relevant key at the time you want the drum played.**
   Getting the rhythm right might take a little bit of practice, since a computer keyboard wasn’t really designed for playing drums.

7. **Keep playback going and add as many notes as you like.**

   ● Please be aware that the latency phenomenon (see page 183) applies to tap recording as well. If your system has a large latency, you will need to hit the keys slightly in advance.

---

**Deleting notes via the Computer Keyboard**

You can also delete notes from the computer keyboard:

1. **Select the drum instrument you want to delete.**

2. **With playback activated, press and hold the [Shift] and [Tab] keys, when the notes you want to delete are playing.**
   Notes get deleted for as long as you keep [Shift] and [Tab] pressed.
Working with Shared Instruments on the 808 section

There are 16 sounds to select from in the 808 section, plus the Accent (see page 35). However, there are only 11 sound *slots* (not counting the Accent), that is, you can only have up to 11 sounds playing at any time (techniques for extending the number of sounds used in a Song can be found on page 34).

An example of a “shared instrument” is Low Tom (LT) and Low Conga (LC). You can only have either Low Tom or Low Conga in one Pattern.

Selecting “Shared” Sounds

To select one of the two sounds in a shared “slot”, proceed as follows:

1. **Select the basic sound in the pair, using the rotary knob.**

2. **Flick the switch on the panel that selects between the two sounds in a shared slot.**

   ![Switches](image)

   These switches selects between two sounds in a pair.

You can flip the shared instruments switches at any time, even after programming a sound. The Pattern will then play back with the newly selected sound, rather than the other.

Using Song Mode to play two Shared Instruments in one Song

- If you are not familiar with Song mode, the text below might not make sense to you. Please get back to this section once you have acquainted yourself with Song automation.

The settings of the shared instrument switches are part of the Song automation, like most other controls on the panel. This means that a Pattern programmed with Toms might be played back with Congas, if that is the way the switches are set in the *Song*. While this might be confusing at first, it can also be used to good effect. You can program sound changes as part of your song automation, and therefore have both (for example) Toms and Congas in one Song. See page 72 for more information.
Working with Accents

The sound to the far left on both rhythm panels is labelled AC, for accent. This is not a drum sound as such, but rather a way to control the dynamics for a Pattern. Steps where an Accent is programmed will be louder than other steps. The effect is global for all sounds, that is, they will all be louder by the same amount.

1. **Select the Accent Instrument.**

2. **Add an Accent to steps you want to be louder.**

3. **Adjust the Accent volume knob, to set the difference in volume between accented and un-accented steps.**

   Accent is most often used for adding “life” to a rhythm part. To check out the effect, try this example:

   1. **Program a simple Pattern that plays a closed hi-hat on all sixteenth notes.**

   2. **Add accents to every other step, that is step 1, 3, 5, 7 etc.**

   3. **Adjust the Accent level.**

About Open and Closed Hi-hat

Open hi-hat (OH) and closed hi-hat (CH) are mutually exclusive in each of the rhythm sections. That is, only one of them can sound at a time. Here are the rules:

- **If you program an open hi-hat on one step, and a closed on the next, the closed hi-hat will cut off the sound of the open hi-hat.**

- **on the 808, if you program open and closed hi-hat on the same step, you will get a very short open hi-hat sound, that sounds very much like a closed hi-hat.**

- **on the 909, if you program open and closed hi-hat on the same step, you will hear the open hi-hat sound.**
Clearing the Pattern

If you wish to clear the Pattern, proceed as follows:

1. Move the focus bar to the desired rhythm section, either by clicking between the Pattern selector and the actual “drum machine”, or by using the up/down keys on the computer keyboard. Either way, you want the orange indicator to be in the rhythm section you plan to clear.

![Focus set to the 808 rhythm section.](image)

2. Select Clear from the Edit menu.
The Pattern is cleared.

Working with Various Pattern Lengths

By default all Patterns are one bar long, that is they are made up of sixteen sixteenth note steps. However, you can shorten a Pattern to any number of sixteenth notes, between 1 and 16. This allows you to program rhythms in unusual time signatures.

- To set the Pattern length, use the Length indicator arrow buttons.

![The Pattern Length setting.](image)

This operation can be performed at any time, whether the Pattern is empty or not, and both in playback and stop mode. The change takes effect immediately.
Sound Parameters

The 808 section sound parameters.

The 909 section sound parameters.

Each individual sound has one or more parameters for adjustment of sound character and level. Every sound has a level control and many sounds have additional parameters. Below follows a summary of the available parameters:

**Level**
This is simply the volume for the sound.

**Tune**
This is the pitch of the sound, the tuning. For the snare, please note that this only affects the “body” of the sound, not the “rattle”.

**Tone**
On the 808 snare, this is a pitch control for the body of the sound.
On the 909 snare, this is a decay control for the “rattle”. The higher the setting the longer the sound.

**Dec(ay)**
This adjusts the length of the sound.

**Snap(py)**
This is only available for the snares. It adjusts the balance between the “body” of the sound and the “rattle”.

**Att(ack)**
Adjusts the “click” in the beginning of the 909 bass drum.
5

Programming Synth Patterns
Preparations

1. If required, create a New song or Open an existing one.

2. Make sure Pattern mode is selected.
   This is done using the Song/Pattern switch on the Transport panel. You can only program Patterns in Pattern mode.

3. Select a Pattern to program.
   How to do this is described on page 20.
   The Pattern you select can be an empty one or one already playing something, it doesn’t matter. If it is filled with notes you can either clear it to start over from scratch, or modify the existing Pattern as you like.

Soloing a Synth Section

If you want to make sure that you are only hearing one of the synths while programming, you will want to turn off all other sections:

- Click the on/off button in the mixer for the rhythm sections and the other synth, to turn them off.

In this example you will only hear the upper synth.
Programming and Playback

You can program synth Patterns, whether the program is in stop mode or playing. It doesn’t really matter which, but the most convenient is probably to have playback going so that you will hear the notes you have programmed so far as the Pattern repeats.

Clearing the Pattern

In a new default Song document, all Patterns are already programmed. You might want to clear the Pattern before you start, using Clear on the Edit menu. For more info, see page 46.

Basic Procedures

Basically, creating a Pattern is a question of selecting each of the sixteenth note steps, and making settings for each one. These settings determine whether each of the steps plays a note or a pause, what the pitch should be etc.

Here’s a step by step instruction for the basic method of making a Pattern:

1. Make sure you are not in Pitch mode. If the Pitch mode light is lit, click on it to turn it off. See page 42 for more information on Pitch mode.

2. Use the Step and Back buttons to move to the step you want to make changes for.
   The step counter shows you where in the Pattern “you are”.

   If you want to move to step one, there’s a shortcut: Click on the Pitch mode button twice.
3. **Adjust the settings for each step, as desired.**
   Below follows a quick description of the possibilities, details about each one follows later in this chapter.

4. **Use the Step button to move to the next step, and make settings for this.**
   If you are already at the last step, this button takes you to the first step in the Pattern.

5. **If required, use the Back button to step back through the steps and adjust the settings as needed.**
   If you’re at the first step, this button takes you to the last step.

6. **Repeat steps 2 to 5 above for the remaining steps until the Pattern plays as desired.**
Using Pitch Mode

When Pitch mode is activated, the programming procedure is slightly different. In this mode, as soon as you select a pitch on the keyboard, the program automatically advances to the next step. This can be used for two things, for programming a Pattern quickly from scratch, and for altering the pitches in an existing Pattern.

Programming a Pattern from Scratch in Pitch Mode

1. Set up an empty Pattern and make sure you are at the first step. Check the step counter if you are unsure.

2. Activate Pitch mode.

3. For the first step, set the note/pause, octave, accent and slide switches as desired.

4. Select a pitch for the step by clicking the keyboard, and the program automatically advances to the next step. Note that selecting the pitch should be the last thing you do, since the program then advances to the next step.

5. Repeat steps 3 to 4 until the Pattern is finished.

Changing the Pitches in an Existing Pattern

Pitch Mode is extremely useful if you have a Pattern with the correct rhythmic phrasing etc, but want to use it in different places in the song, with other pitches (for example to fit different chord progressions).

1. Select the Pattern and make sure you are at the desired step, probably the first.

2. Activate Pitch mode.

3. Select a new pitch for the step by clicking the keyboard, and the program automatically advances to the next step.

4. Repeat until the Pattern is finished.

If you have a step where the pitch is already correct, you can instead just click the Step button to advance to the next step.
Using the Keyboard for Creating and Editing Patterns

There are computer keyboard equivalents for all the step settings. On the next page there is a diagram of these. We strongly recommend you to take some time to get acquainted with using the keyboard, it is a much faster way of programming Patterns than using the mouse, once you get used to it.

Switching Keyboard Input to Synth programming

On the Options menu, you will find a switch for what the keyboard is used for. To use the keyboard for synth Pattern editing, set it to “Program Synth from Keyboard”.

Setting the focus to the correct section

Since there are two synthesizer sections, you must also make sure that your keyboard input is routed to the correct one. This is done by moving the focus bar to that section (see page 22). This is done by clicking in the relevant section or by using the cursor up/down keys.

In this example, the focus is set to a synth section.

The keys used for editing synth Patterns. The illustration shows a US keyboard. Note that the keys are on the positions indicated, regardless of which letters are printed on the keys in your particular country.
Tapping the Rhythm

Tapping can be used for defining a rhythm for a synth pattern. The way this works is that when you tap, that step is set to Note (as opposed to Pause) regardless of its previous state. That is, tapping only adds notes, it never deletes them.

1. Set up a Rhythm Pattern so that you have something to go by.
2. If you like, clear the synth Pattern before you start tapping.
3. Make sure “Program Synth from Keyboard” is activated on the Options menu.
4. Activate playback.
5. Make sure the desired synth section has the focus. See page 22 for more info on focus.
6. Hit the [Tab] key at the time you want to add a note. It will play back on the next lap, at whatever pitch as programmed for that step.
7. Keep playback going and add as many notes as you like.

Please be aware that the latency phenomenon (see page 183) applies to tap recording as well. If your system has a large latency, you will need to hit the keys slightly in advance.

Deleting Notes

You can also delete notes using the computer keyboard. Technically this means switching the steps from Note to Pause mode.

• With playback activated, press and hold the [Shift] and [Tab] keys, when the notes you want to “delete” are playing. Notes get switched to Pause mode for as long as you keep [Shift] and [Tab] pressed.
Working with Octave settings

The Octave settings transpose a step one octave up/down. This gives you a total octave range of three octaves, from the lowest C transposed down to the highest C transposed up (not counting the tuning parameter, see page 48).

- You can activate both octave switches at the same time, but this is the same as having no transposition at all.

Working with Accents

When Accent is activated for a step, the step will be louder, different in sound character and the note will be shorter. Exactly how different it will be is determined by the Accent knob setting.

If the Accent knob is all the way down, notes with Accent will only be shorter.

Working with Slide

When Slide is activated for a step, the note will be tied to the next and the pitch will continuously “glide” to the pitch of the following step.

- Please note that Slide should be activated on the note you slide from, and not the note you slide to.

There are a few special cases you should be aware of:

Sliding from a Pause

If a step is set to pause it won’t sound. However, if Slide is activated for that silent step, the next note will still slide in to the right pitch. The slide will start at the pitch set for the silent step and end at the pitch of the next step.

Several Sliding Notes after each other

If you have several sliding notes, one after the other, they will all be tied together to one long legato phrase. This can be used to good effect to create “wavy” or pitch bend effects.
Sliding to Notes with the same Pitch – Long Notes

If two or more notes are tied together with the slide feature, but they all have the same pitch, the result will be one long note. This is how to create longer notes (eighth notes, quarter notes etc).

Sliding and Accents

Among other things, the accent affects the envelope – the device that shapes the sound over time. However, if a note is sliding from previous notes, and you add Accent for one ore more steps, the exact effect of the Accent depends on a number of parameters. Sometimes the Accent has less effect on sliding notes. Experiment to get the hang of it!

Clearing the Pattern

If you wish to clear the Pattern, proceed as follows:

1. Move the focus bar to the desired synth section, either by clicking between the Pattern selector on the actual ‘synth panel’, or by using the up and down keys on the computer keyboard. Either way, you want the orange indicator to be in the synth section you want to clear.

2. Select Clear from the Edit menu.
The Pattern is cleared.

Working with Various Pattern Lengths

By default all Patterns are one bar long, that is they are made up of sixteen sixteenth note steps. However, you can shorten a Pattern to any number of sixteenth notes, between 1 and 16. This allows you to program rhythms in different time signatures.

- To set the Pattern length, use the Length indicator arrow buttons.

The Pattern Length setting.

This operation can be performed whether the Pattern is empty or not, and both in playback and stop mode. The change takes effect immediately.
The Synth Sound settings
Waveform

This allows you to select between two waveforms for the synth oscillator:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sawtooth</td>
<td>This is a full and rich waveform where all harmonics are included.</td>
</tr>
<tr>
<td></td>
<td>Square</td>
<td>This waveform only contains odd harmonics, which gives the sound a more “hollow” quality.</td>
</tr>
</tbody>
</table>

Tune

This sets the tuning of this synth section. The range is ±1 octaves in steps of semitones. This control can be used for matching the pitch of Patterns programmed in different keys, for real time transposition and for effects.

- Please note that there is also a Transpose function (on the Edit menu), that allows you to alter all notes in a Pattern (in steps of semi-tones) to fit a particular key.

Cutoff

This is the overall filter setting for the sound. The higher the setting, the ‘brighter’ the sound. This setting interacts with Envelope Modulation as described in more detail under the Envelope Modulation heading later in this chapter.

Resonance

This is another control for the overall character of the sound. Technically it routes the sound at the output of the filter back to the input, in a feedback loop. Soundwise it gives the sound a more hollow, pronounced character. Together with envelope modulation, slide and accent (see page 59), it is largely responsible for the 303 sound character. To try this out, turn the resonance all the way up, and twist the Cutoff and Envelope Modulation knobs.
Env. Mod. (Envelope Modulation)

This adjusts the way the envelope affects the cutoff frequency. Let’s describe this in more detail:

As described above, the cutoff setting is a basic tonal setting for the filter. In addition to this there is the *envelope*, which makes the cutoff frequency vary as the note decays. This is the way many “real” instruments work, as the sound decays it also gets less bright. The envelope simulates this by making the cutoff frequency continuously lower as the sound decays. How fast this decay actually occurs is set with the Decay knob, see below.

- In its lowest position, the envelope has little effect on the sound.
- At higher values, the envelope makes the filter open further, that is the sound will be brighter.

Decay

This adjusts the length of the envelope, to make notes decay faster or slower.

Accent

This knob is used for setting to what extent the steps with Accent activated should be different from the other steps. The setting does not only affect volume, but also the shape and character of the sound.

The “Vintage ReBirth Synth Sound” switch

This switch, on the Edit menu, allows you to select between two types of envelope decay settings:

- When this switch is turned on, the decay is shorter. This corresponds to the way the envelope always behaved in ReBirth RB-338 version 1.5 and earlier.
- When this switch is set to off, the decay is slightly longer. This is the standard setting in ReBirth 2.0 and later.

When you create new Songs, this switch is by default turned off. However, when you open Songs saved in ReBirth RB-338 version 1.5 or earlier, this switch is automatically activated, so that the Song plays back with the same sound as when it was created.
Pattern Editing Functions
To have access to the functions described in this chapter, you must be in Pattern mode, not in Song mode!

**Cut, Copy and Paste (Pattern)**

These functions allow you to move and copy Patterns between Pattern locations. You can cut, copy and paste within one Song document, or between two Song documents. Proceed as follows:

1. **Set the focus to the section you want to cut or copy from.**
   See page 22 for details about the focus.

2. **Select the Pattern you want to cut or copy.**

3. If you want to move the Pattern to a new location, select Cut from the Edit menu. If you want to make a copy of it, instead select Copy.

4. If you want to paste into another Song, click on its window, so that it becomes active.

5. **Move the focus to the section where you want to paste the Pattern you just cut/copied.**
   If you want to Paste it in the same section, this step is not required.

6. **Select the Pattern location where you want to paste.**

   Note that when you select Paste, the Pattern that was currently in this location, will be overwritten and can not be retrieved.

7. **Select Paste from the Edit menu.**
   The Pattern you cut or copied is pasted in at the selected Pattern location.

   You can not paste Synth Patterns into the Rhythm Section and vice versa.
Pattern Functions

There are a number of menu functions that allow you to perform various types of editing to your Patterns.

Selecting the Pattern to be Affected

All of the functions described below always operate on one Pattern in one section. Before you use the function you must make sure the right Pattern will be affected.

Please proceed as follows:

1. Set the focus to the correct section.
   See page 22 for details about the focus.

2. Select the Pattern you want to be affected.

3. Select the function from the Edit menu.

About Multiple Menu items

Some functions appear more than once, depending on the various options. What items are available (not dimmed) might also vary with the focus. If a rhythm section has the focus, other options are available than if a synth section has a focus. Let’s take Shift as an example of this:

- If a synth has the focus, there will be two active Shift items: Shift Pattern Left and Shift Pattern Right.
- If the rhythm section has the focus there will be four active Shift items: Shift Pattern Left, Shift Pattern Right, Shift Drum Left and Shift Drum Right.

Clear

To clear a Pattern completely, use this function.

- For the rhythm sections, this will deactivate all steps for all instruments.
- For the synth sections, this will set all steps to pause (as opposed to note), no accent, to the pitch C, no slide, and no octave transposition. In both cases, this means the Pattern will be silent after the operation.
**Shift Pattern/Drum Left/Right**

This function moves the notes in your Patterns “left” or “right”. It either acts on the whole Pattern (Shift Pattern Left/Right), or – for rhythm Patterns – it can be used for shifting the selected drum instrument only (Shift Drum Left/Right).

If you for example use Shift Pattern Right on a synth Pattern, notes that were on step 1 will be moved to step 2, notes that were on step 2 will be on step 3, and so on, up to the notes on the last step which will be moved to the first.

This function can be used for interesting rhythmic effects. It can sometimes also be used as a rescue. If, for example, you have created a great synth Pattern but realize that the downbeat as you hear it, is not on the fist step, use this function to rectify the situation. To move the Pattern several steps, simply use the function repeatedly.

- This function does not take Pattern length into consideration. It always operates on all 16 steps.

**Random Pattern/Pitches/Accents etc./Drum**

These functions can be used for creating a completely new Pattern, or to only randomize certain aspects of it.

Use this is as a way to generate music automatically, or as an inspirational tool. Patterns that are generated in this way can be edited as any other, so if you don’t think the result is exactly what you need you can change it in whatever way you require.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Random Pattern</td>
<td>Creates a complete Pattern with random pitches, accents, slides etc.</td>
</tr>
<tr>
<td>Random Pitches</td>
<td>Randomizes the pitches of the Pattern without changing anything else.</td>
</tr>
<tr>
<td>Random Accents etc.</td>
<td>Randomizes the Note/Pause, Accent, Slide and Octave settings for the steps.</td>
</tr>
<tr>
<td>Random Drum</td>
<td>Randomizes the programming for the selected rhythm instrument.</td>
</tr>
</tbody>
</table>
Alter Pattern/Pitches/Accents etc./Drum

This alters existing synth and rhythm Patterns, by randomly shuffling the data in an existing Pattern. Note that there must be some material to alter for this function to work. In other words, applying it to an empty Pattern will leave you with an empty Pattern.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alter Pattern</td>
<td>Alters all aspects of the Pattern.</td>
</tr>
<tr>
<td>Alter Pitches</td>
<td>Alters the pitches.</td>
</tr>
<tr>
<td>Alter Accents etc.</td>
<td>Alters the Note/Pause, Accent, Slide and Octave settings.</td>
</tr>
<tr>
<td>Alter Drum</td>
<td>Alters the rhythm of the selected instrument.</td>
</tr>
</tbody>
</table>

If you want to create a pseudo-randomized Pattern that stays within certain musical boundaries, try the following:

1. **Activate Pitch Mode in a synth section.**

2. **Play the notes you want included in the Pattern, in no particular order.**

3. **Deactivate Pitch Mode.**

4. **Select Alter Pattern or Alter Pitches.**

- This function does not take Pattern length into consideration. It always operates on all 16 steps.

**Transpose**

This function allows you to change the pitch of the notes so that the Pattern fits another key. The dialog box that appears allows you to specify the number of steps you want to transpose up/down (±12 semitones).

![Transpose dialog (Macintosh version).](image)

- Please note that there’s a limitation to how much you can transpose notes. If they already have very high pitches, they might be moved one octave in either direction, so that they “appear” within the valid range of pitches.
Mixing & Effects
Introduction

This chapter describes how to use the various features for creating a final mix of the sounds: levels (volumes), panning and effects.

The effects in ReBirth RB-338 consist of a compressor, a distortion unit, a delay and the PCF (Pattern Controlled Filter). These work just like their physical counterparts, you connect them in the signal chain and make settings for intensity and other characters of the effect.

Setting Levels

Section Levels

Each of the sections has a level control, the slider. This is used for adjusting the balance of this section against the others. Here are some guidelines for setting levels:

- Don’t worry about cranking a section all the way up. Any distortion (clipping) that occurs can always be removed with the Master Level control, see page 24.
- To get the lowest amount of noise, keep the levels up as much as possible at all times. For example, set the loudest section to play at full level and adjust the other levels downwards to this, to get the right balance.

Master Level and Meter

This is used for adjusting the overall level from ReBirth RB-338. It is also used for compensating for any clipping that occurs on the output, due to loud levels from the three sections and the effects. Again, see page 24.

The Comp switch in the Master section is described on page 67.

The Master level setting is not part of the Song automation!
Muting

In each mixer there’s an on/off setting, a mute function. This is used for temporarily silencing the audio from a section.

- This setting is not part of the Song automation. To incorporate silent parts in the Song, use the Pattern on/off switches instead, see page 72.

Using Pan

Panning allows you to position a section anywhere in the stereo image. There are several uses for this:

- To increase separation between the sections, by giving them different stereo positions.
- To create interesting effects by panning a section one way and adding a delay to it, panned the other way.
- To pan sections fully hard/left to use the stereo output as two separate outputs. You can then get total separation of sections when recording to other media or using external effects.
- Using the Song automation you can create sounds that move “automatically” across the stereo image.
Effect Routing

- There are three *insert* effects: Dist, PCF and Compressor. These are connected in series. That is, if you apply all three to one section, the sound will first pass through the Dist, then through the PCF, and last through the Compressor.

- There is one *send* effect, Delay. By using the Delay amount controls in each Mixer section, Delay can be applied to all sections, by varying amounts.
Dist (Distortion)

Distortion makes the sound dirtier and grungier, like when you turn up the volume on a guitar amplifier. The distortion in ReBirth RB-338 is an insert effect. This means it will be inserted into the signal, just after the output of one of the sections. There are actually four distortion units in the program. This means that all sections can use the distortion. However, there’s only one set of controls that applies to all sections.

Trying out the Distortion

1. Activate playback, in Pattern mode.

2. Make sure only one of the synthesizers sound, by using the Mute buttons in the mixers.

3. Activate the Dist in that synth's mixer, by clicking the switch so that it lights up.

4. Activate the Distortion, by clicking the on/off button in the Dist section.

5. Raise the Amount switch in the Dist section to about one o'clock.

6. Check the sound with and without distortion by clicking the on/off button in the Dist section. Also check the Distortion controls, Amount and Shape, and how they affect sound at various cutoff and resonance settings.
Routing

To decide which sections will use the distortion, you use the Dist switches.

- As many sections as you like can have Dist activated.
- You can turn Dist off for all sections, should you wish.

Activating/Deactivating

Once you have decided which section will use the Dist effect, you need to activate the effect itself. This is done in the Dist section by clicking the on/off button.

- When this is on, one of the sections will pass through the Distortion effect.
- When this is deactivated, no sound will pass through the distortion effect (bypass).

The Amount and Shape Settings

There are two settings for the distortion:

Amount
The higher this setting, the dirtier the sound.

Shape
This controls the character of the distortion, the higher the value, the “grungier” the sound.
The PCF (Pattern Controlled Filter)

Introduction

The PCF is an extremely versatile synth effect. It allows you to change the sound, from any of the sections in ReBirth RB-338, in a number of ways.

The PCF is an insert effect that can be applied on the output of one of the sections. There is only one PCF. This means that only one section at a time can use it.

Basically, the PCF is a filter with an envelope, just like there are filters with envelopes in the synth sections. You route the output of one of the sections through the PCF and thereby shape the tonal character of the sound.

The main difference between the PCF and the synth filters is that this filter is “pattern controlled”. There are a large number of preset patterns that allow the filter to “superimpose” pumping effects, slow sweeps and rhythmic phrasing onto the sound. But before we go into the technical details, let us give you an example of how the PCF can be used.

Trying out the PCF

1. Make sure you are in Pattern mode.

2. Create a simple rhythm Pattern to use as a guide.

3. Create a synth Pattern that only plays one long droning note.
   One way to do this is as follows: Clear a Pattern, step through it, activating Slide for each step, and switch each step from Pause to Note.

4. Mute the other synth and rhythm sections.

5. Turn off Delay and Distortion.

6. Play back to make sure you hear the long note with a basic sound (set Cutoff at two o’clock). Leave playback on.

7. In the Mixer section of the synth you are listening to, click on the PCF button, so that it lights up.

8. Activate the PCF by clicking in its upper left corner, so that the LED lights up.

9. In the PCF, select Pattern “5” and set the filter type switch to BP. Then set up the faders approximately as in the picture below.
You will now hear a repeating effect occurring on quarter notes. What happens is that the filter envelope is being retriggered on quarter notes.

10. Step through PCF Patterns 0 to 11 and listen to the various rhythmic figures.

11. Before you test Pattern 12 to 21, raise the Decay and Q settings as the picture below indicates.

You will hear that Pattern 12 to 21 more or less imitate filter “sweeps”, rather than repeat effects.

12. Set the controls back as they were before, and test Patterns 22 to 33. These Patterns are more complex, they contain various rhythmic figures including dynamic changes and various time signatures.

13. Finally, test the Patterns between 33 and above. 34 to 45 are all triggering on 32nd notes, rather than on sixteenth notes. The ones above this are mixed variations.

14. Experiment with various settings and apply the PCF to other Patterns than the one you have now.

15. Mute the synth you are hearing.

16. In the Rhythm section Mixer, click on the PCF button, so that it lights up. You will note that the LED goes out for the synth, since only one section at a time can use the PCF.

17. Experiment with various settings in the PCF section. You will notice that it is quite simple to create really interesting electronic sounding drum sounds.

To find out more about the various controls and the technical details, read on.
How the PCF Works - Background Information

The PCF is built from two major components:

1. The Filter
This is a 12dB/octave (2-pole) design that can be switched between lowpass and bandpass operation and has cutoff and resonance controls.

2. An Envelope with Patterns
This is a simple Attack/Decay envelope. The Decay time can be set on the PCF panel. The Attack is controlled via the Patterns, as described below. By using the AMT (Amount) control on the PCF panel, you can set to what extent the envelope affects the filter.

Block diagram of the PCF.
About the Patterns

There are a large number of preset patterns that provide various rhythmic effects. They do this by controlling the following envelope parameters:

- **Retriggering**
  This is the most basic type of control. In Pattern 0 for example the envelope is retriggered (restarted) at each whole note, in pattern 1 on each half note etc.

- **Dynamic and Attack control.**
  In many of the Patterns, the envelope is triggered with different dynamics on different “beats”. Some “beats” also have a different attack.

The Patterns are preset, they can not be changed. Their length vary, most are one or two bars, but some have been created in odd time signatures (a full list can be found on page 205 and onwards).

Routing

To decide which section will use the Pattern Controlled Filter, you use the PCF switches in the Mixers.

- **The PCF comes after the Distortion, in the signal chain.**
  That is, if you activate both distortion and PCF for a section, it passes through the distortion first and then the PCF.

- **Only one section at a time can have PCF activated.**
- **You can of course turn the PCF off for all sections.**

Activating/Deactivating

Once you have decided which section will use the PCF effect, you need to activate the effect itself. This is done in the PCF section by clicking the on/off button.

- **When this is on, one of the sections will pass through the Pattern Controlled Filter.**
- **When this is deactivated, no sound will pass through the Pattern Controlled Filter (bypass).**
The PCF Settings

Pattern
The patterns are roughly divided into the following categories:

<table>
<thead>
<tr>
<th>Pattern number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 5</td>
<td>Even rhythms, no dynamics.</td>
</tr>
<tr>
<td>6 to 11</td>
<td>Simple rhythms, no dynamics.</td>
</tr>
<tr>
<td>12 to 17</td>
<td>Simple sweeps, slow dynamics. Try these with long decay times!</td>
</tr>
<tr>
<td>18 to 21</td>
<td>Complex sweeps (more or less random).</td>
</tr>
<tr>
<td>22 to 33</td>
<td>Complex rhythms with dynamics and varying attacks.</td>
</tr>
<tr>
<td>34 to 45</td>
<td>32nd note patterns.</td>
</tr>
<tr>
<td>46 and up</td>
<td>Mixed variations.</td>
</tr>
</tbody>
</table>

See page 205 for diagrams of the various patterns.

Mode (BP/LP)
This switches the filter between its two major modes, lowpass and bandpass.

- The lowpass filter (LP) is similar to the one used in the synth sections in ReBirth. It lets all harmonics below a certain frequency (the cutoff frequency) pass through.
- The bandpass filter (BP) only lets frequencies within a certain band (a range of frequencies) pass through.

Freq (Frequency)
This is the main frequency range the filter should operate in.

The Freq parameter is related to the Amount (Amt) parameter:

- If the Amount slider is set to zero, there will be no pattern effect at all. The filter can then be used as a fixed “tone control” by adjusting the Freq and Q parameters.
- If the Freq slider is all the way up, the Amt slider has no effect since the filter is already fully open.
Q
This is the same as the “Reso” control in the synth sections. Technically it routes the sound at the output of the filter back to the input, in a feedback loop. Soundwise it gives the sound a more hollow, pronounced character.

- Be careful when combining large Q values in the PCF with large Reso values in a synth, since this might lead to overloading the output of the PCF, causing distortion.

Amt (Amount)
This control determines the amount of effect the envelope has on the filter. For any Pattern effect at all, this must be set to some value above zero.

Dec
This adjusts the length of the envelope decay. This has a significant effect on the “feel” of the Pattern.

- At low values there will be a clear pumping effect.
- When the Decay is raised, the pattern effect will be “smeared”. This can be used to good effect with Patterns 12 to 17 for smooth “LFO” effects.
- At very high values, the envelope will not be given a chance to decay very much until it is retriggersed, giving a “stepping” effect (similar to the old synth effect “sample and hold”). This is most noticeable on patterns with dynamics (12 and above).

The picture below shows the same Pattern with three different envelope settings.
The Compressor section.

A compressor evens out levels to make the sound “tighter”. At high settings it can introduce a “pumping” effect. The compressor in ReBirth RB-338 is an insert effect that can be applied on the output of one of the sections or on the master out. There is only one Compressor. This means that only one section or the master output can use the compressor.

**Trying out the Compressor**

1. **Activate playback, in Pattern mode.**

2. **In the 909 section, set up a busy drum pattern with a prominent bass drum.**

3. **Activate the compressor in that section’s mixer, by clicking the Comp switch so that it lights up.**

4. **Activate the Compressor, by clicking the on/off button in the Comp section.**

5. **Set the Ratio button at its lowest position.**

6. **Set the Threshold knob somewhere between “nine o’clock” and “twelve o’clock”.**

7. **Raise the Ratio button continuously.**
   You will note how the level difference between the sounds is evened out. Some sounds will also get a more prominent attack. You might also note an overall reduction in level, but this can be compensated for, by using the Level fader.
Routing

To decide which section will use the compressor, you use the Comp switches found in the section mixers and in the Master section.

- Only one section at a time can have the Compressor activated. This is a mono compressor that only affects that section.
- Alternatively you can activate the Compressor for the Master section. This invokes a stereo compressor which acts on the entire mix.
- You can turn compression off for all sections, should you wish.

Activating/Deactivating

Once you have decided which section will use the Compressor, you need to activate the effect itself. This is done in the Comp section by clicking the on/off button.

- When this is on, one of the sections or the entire mix will pass through the Compressor effect.
- When this is deactivated, no sound will pass through the compressor (bypass).

The Settings and Display

Threshold

This a setting for which signals should be affected. As the name implies, only levels above the one you specify here (the Threshold) will be affected. Levels below this value will pass through unprocessed.

Ratio

This is the amount of level reduction, that is, the resulting reduction in level difference. The higher the setting, the more drastic the effect.

Level Reduction meter

This display shows you how much the level of the signal is reduced at any given time. The “0” setting (in the middle) means no change, whereas an indication to the left implies a level reduction.
Delay

Delay adds echoes, or repeats, to the sound. The Delay effect in ReBirth RB-338 is a send effect, which means it can be utilized by all the sections, by variable amounts. In addition, the Delay appears after the other effects in the signal chain.

Trying out the Delay

1. Make sure only one of the synthesizers sound, by using the Mute buttons in the mixer.

2. Select a pretty simple synthesizer Pattern and activate playback, in Pattern mode.

3. Raise the Delay setting in that synth's mixer, to about two o'clock.

4. Activate the Delay, by clicking the on/off button in the Delay section.

5. Set the delay controls as the picture below indicates:
   This will give you a basic delay with a length of three sixteenth notes with approximately three repeats.
The Delay Amount Setting

The Delay knob in each section is used for determining how much of the signal from this section that should be “fed” into the delay unit.

- If you set this all the way down, no delay will be added to this section.
- If you raise it all the way up, the first repeat from the delay will have the same level as the original signal.

Activating/Deactivating

In addition to setting the Delay level for each section, you need to activate the Delay section itself. This is done by using the on/off switch in the Delay section on the front panel.

The Delay Settings

<table>
<thead>
<tr>
<th>Setting:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of sixteenth notes</td>
<td>This is the length of the delay. The shortest setting is one sixteenth note, the longest is 32 eighth note triplets (see below).</td>
</tr>
<tr>
<td>(Steps)</td>
<td></td>
</tr>
<tr>
<td>Straight notes/Triplets</td>
<td>This allows you to switch between repeats at eighth note triplets and straight sixteenth notes.</td>
</tr>
<tr>
<td>Feedback</td>
<td>This is used for setting the number of repeats, by adjusting how much of the signal from the output of the delay is fed back into the input. When this is all the way down, there will only be one repeat. When it is all the way up, there will be an infinite number of repeats, which means the delay will keep sounding even if you stop playback.</td>
</tr>
<tr>
<td>Pan</td>
<td>This is used for setting where in there stereo image the delay signal will appear. For example, you might pan the sound from some section to the left and the delay right, to get a stereo effect.</td>
</tr>
</tbody>
</table>
Creating and Playing Songs
Introduction

In Song mode you record series of Pattern changes and knob settings and movements, to create a complete Song. Practically all front panel control can be recorded. You can create automation of filter sweeps, level changes, effect controls, etc.

- The only controls that are not affected by automation are Tempo, the Mute buttons in the Mixer and the Master Level controls!

About the Song/Pattern Modes

The Song/Pattern mode switch.

The Song mode is drastically different from Pattern mode. Here are some of the differences you will encounter:

- **Knobs and buttons are automated.**
  In Song mode, settings and movement of panel controls are always under automation control. You can move controls manually, but if the same control is automated, there will be a conflict between the two. See page 74 for more information.

- **Pattern selection is automated.**
  Again, you can switch Patterns manually, but when a Pattern change appears in the Song, this will be effectuated immediately. See page 76 for more information.

- **You normally don’t perform Pattern editing in Song mode.**
  You can re-program the currently playing Pattern. However, since the Song might switch to another Pattern during playback, be careful so that you don’t re-program the wrong Pattern!
Playing Songs

When you open a Song, it will play back just as recorded, together with all Pattern changes, panel settings and automation.

The following possibilities are available:

- You can use the Transport controls (see the printed documentation) to move to any position within the Song and start playback from there.
- The Song doesn’t really have an end. All Songs can be up to 999 measures in Length and playback will continue up to that point, unless you stop it before.
- You can set up and use the Loop to repeat a section, infinitely. If you want the whole Song to repeat over and over, set up the Loop to encompass the whole piece.
- You can move all controls on the front panel. However, note that if a certain control has already been recorded, there will be a conflict between this and your manual input. See page 76.
- You can always mute and unmute sections, adjust the master faders and adjust the Shuffle. These controls are not part of the Song automation.
How the Song Sequencer works – The “Signal Flow”

Below follows a little bit of theory that will help you get the most out of the ReBirth sequencer.

When you are creating a Song, there are actually a number of components that interact with each other:

- **The ReBirth Front Panel and MIDI Input.**
  The front panel and incoming MIDI control messages are first mixed together into one “control” signal. This input can be used both for recording messages into the Song Sequencer (in Record mode) and for “manual” access to the various controls (in Play and Stop mode).

- **The Song Sequencer**
  The sequencer records front panel and MIDI input “control data” and then plays it back to the sound engine. This is how you are able to automate Pattern and control changes. While the sequencer records, it plays back previous recordings. For example, while you record the Pattern automation for one of the synth sections, it plays back the automation already recorded for the other sections.

- **The ReBirth sound engine.**
  This receives control information both from the Song Sequencer and from front panel and MIDI, all at the same time.

---

About “Conflicts” between the Various inputs

As stated above you can use MIDI and front panel input at any time, even during automated Song playback. The output from the sequencer is mixed with the data from the front panel and MIDI and this mixed signal is sent to the audio engine. Normally this is completely natural. There is only one situation to be aware of:

If you have already recorded some automation for a control, and move the same control manually, at the same time as it is being controlled by the automation, there will be “conflicting” input to the audio engine. This may lead to a control “flickering” on screen and possibly slightly strange sound. Then again, it might just sound cool.
Preparations for Creating your own Songs

Pattern mode Preparations

1. **In Pattern mode, create all the Patterns you want to use in the Song.**
   There’s actually nothing preventing you from switching back to Pattern mode at any time, to add and modify Patterns, but you probably want all the basic Patterns to be ready before you assemble the Song.

2. **Try out the basic Pattern changes, to make sure everything works alright.**
   A good way to do this is to use the computer keyboard for Pattern switching, see page 224.

3. **Set up a basic mix including all the sounds for the Song, even including effects.**

4. **Save your Song document so you can go back to this stage later.**
   You are now done with the Pattern mode work. Let’s switch to Song mode.

Song Mode Preparations

1. **Switch to Song Mode.**

2. **Select “Initialize Song from Pattern mode” from the Edit menu.**
   This accomplishes two things:
   - **The whole Song is completely cleared.**
   - **Events are inserted at the beginning of the Song so that it plays exactly like Pattern mode, just before you switched over to Song mode.**
   This includes the control (knob) settings.
Building a String of Patterns

When creating a Song you most likely will want to create the basic chain of Patterns first, and work on the levels, sounds and effects afterwards. To create the Pattern changes, proceed as follows:

Preparations

1. **Follow the preparation steps outlined above, so that you have an empty Song to start from.**

2. **Turn off the Loop.**
   
   While this is not required, Loop recording introduces some new concepts, described on page 84. Therefore, to get started with Song creation, turn the Loop off.

3. **Press Stop to “rewind” to the beginning (bar counter says “1”).**

4. **Press the Record button so that it lights up.**

5. **Select the Patterns for the first bar, by clicking the corresponding Pattern selectors in the three sections.**
   
   From here on there are two ways to go: Step Mode writing and Real Time writing.

Real Time Writing of Pattern Changes

1. **With Record mode still activated, activate Play.**

2. **Change Patterns as the Song plays back.**

   You should hit the Pattern buttons before the downbeat. The program will then move it to the exact bar. In fact, Pattern changes can only happen on the beginning of a measure.

   You can make changes in just one section, or in several, it doesn’t matter. Some people will feel confident using the mouse to create the changes for just one section at a time, others will use the keyboard to arrange the whole song on the fly, it’s all a matter of personal taste.

   ● Please check the special notes for creating an end for the Song, see below.

3. **When you are done, hit Stop.**
4. **Rewind and play back to check.**
   If you made any mistakes, you can correct them now or later, as described below. For now we will assume everything is OK, and that you will want to add Pattern changes for the other sections now.

5. **Rewind to the beginning of the Song.**

6. **Activate Record and Play and perform the changes for the next section.**

7. **Repeat as needed.**

**Step Mode Writing of Pattern Changes**

If you prefer to “punch in a list” of the Pattern changes, without activating playback, proceed as follows:

1. **Follow the steps under Preparations, above. Record mode should be activated.**

2. **While you are still at the first bar of the Song, make sure the correct Patterns are selected for this step. If they're not, select them.**

3. **Click on the up arrow in the Bar section, to advance to the next Bar.**

   ![Bar up arrow](image)

   The arrow up button allows you to step through the bars in the Song, one bar at a time.

4. **Select the Patterns that should play at this bar.**
   You only need to select actual Pattern changes. If a section should play the same Pattern as in the last measure, you don’t need to make any Pattern changes for this section.

5. **Advance to the next Bar and select Patterns for this.**
   As soon as you do this, the previous Pattern recording for this measure is deleted, and whatever you now have selected will play instead.

6. **Repeat steps 4 and 5 as needed.**

   ● Please check the special notes for creating an end for the Song, see below.

7. **When you are done, hit Stop.**

8. **Rewind and play back to check.**
   If you made any mistakes, you can correct them now or later, see below.

   ● Do not touch Fast Forward, Rewind or the down arrow in the Bar section while step recording. If you do, recording is automatically deactivated!
Creating an “End” for the Song

A song is actually always 999 bars, it has no real end before that. Playback always continues up until bar 999, unless you stop it. Furthermore, all measures in the Song always play something. This has the effect that you must make sure that there are enough silent measures at the end of the Song, for your purposes:

1. Set the start of the Loop to the position of the first bar that should be silent.

2. Set the Length of the Loop to maximum value.

3. Activate Recording.

4. Either select silent Patterns or deactivate Pattern playback completely, in the Pattern sections.

   ![Pattern Section](image)
   
   A deactivated Pattern section.

   - Do not use the level faders in the mixers for this purpose, it might lead to confusing results, unless you are absolutely sure of what you are doing.

5. Select “Copy touched controls to Loop” from the Edit menu.

6. Deactivate Recording.
Correcting Mistakes and Making changes to the Pattern Order

Starting Over

If you realize you would rather start over completely, you can always use the “Initialize Song from Pattern mode” command at any time, to clear the Song completely.

Making Changes to some Part of the Song – “Punching In and Out”

If some Pattern change is not as you’d like it to be, proceed as follows:

1. Move to the position of the first bar where you want to change Patterns.

2. Activate Recording.

   You can make changes in Step or Real Time (Play) mode, technically it doesn’t matter. However, since in Play mode it can be tricky to deactivate recording at exactly the right point in, you might want to perform changes like this in step mode.

   • As soon as you “touch” a Pattern selector, Pattern selection in that section is considered “punched in” and will from now on be showing and playing it’s current setting, rather than the settings recorded in the Song. However, this happens individually for each section. Pattern selectors in sections that you haven’t touched during this recording pass are not affected in any way.

3. Proceed in Step mode or Real Time (Play) mode and select Patterns for all the relevant measures.

   • Don’t touch any other controls than the Pattern selectors, or you will have “punched in” on those too! See later in this chapter for details.

4. When you are at the last bar where you want to make any changes, make those changes and then deactivate recording just before the bar ends.

5. Rewind and check.
Recording Control (knob) Changes

Once you have your Pattern changes down, it is time to record all the front panel controls. Use this to “mix” the Song (volumes, panning and effects) and to set the sound for the synth and rhythm sections (any sound parameter).

Real Time Recording

1. Make sure you are in Song mode. You will probably also want to make sure that all Pattern changes are as you want them.

2. Turn off the Loop.
   While this is not required, Loop recording introduces some new concepts, described on page 84. Therefore, to get started with control recording, turn the Loop off.

3. Rewind so that you are sure you are at the first step of the Song (bar counter says “1”).

4. Press the Record button so that it lights up.

5. Activate Play.

6. Move the controls as the Song plays back.
   You can make changes to just one control, or to several, it doesn’t matter. Also note that you can move the controls via MIDI, as described on page 127.

7. When you are done, hit Stop.

8. Rewind and play back to check.
   If you made any mistakes, you can correct them now or later, as described below. For now we will assume everything is OK, and that you will want to add changes for other controls now.

9. Rewind to the beginning of the Song.

10. Activate Record and Play and perform the changes for the next control(s).

11. Repeat steps 9 and 10, as needed.
Step Recording Control Changes

You can step record control changes, just like with Pattern selections. There are two cases:

If move a control and then punch out before advancing to the next measure, that control setting will only be valid for a short moment at the beginning of the measure.

If you advance to the next bar, the setting you leave the control at will be valid for the entire previous measure. In other words, that control will remain at a static position throughout that measure.
Correcting Mistakes and Making Changes to Control (knob) Recordings

Punching In and Out – Making Changes to some Part of the Song

If some control recording is not as you’d like it to be, proceed as follows:

Punching in on the fly
1. Move to a position one or a few bars before the mistake.

2. Activate Recording and playback.
   Nothing gets recorded until you actually “touch” a control.

3. When you are at the right position, press the mouse button with the
   pointer over the control you want to record, and start moving it. Perform
   the recording.

   As soon as you “touch” a control in this way, that control is considered
   “punched in” and will from now on be showing and playing it’s current set-
   ting, rather than the settings recorded in the Song. Old events for this control
   will now be deleted, as long as recording continues. However, “punch-in”
   happens individually for each control, controls that you haven’t touched dur-
   ing this recording pass are not affected in any way.

Recording from a specific position
1. Move to the position where you want to start recording.

2. Activate Record but not playback
   • Set the control(s) to the desired initial position.
     That/Those controls are now considered “punched in” (see above) and will
     now be showing and playing their current settings, rather than those recorded
     in the Song.

3. Activate playback, press the mouse button with the pointer over the con-
   trol you want to record, and start moving it.

Stopping Recording
1. When you reach the Song position where you want to return to the previ-
   ously recorded changes, hit Stop or deactivate Recording (by clicking the
   Record button or by pressing [*] on the numeric key pad).

2. Rewind and check.

3. Repeat the recording procedure as desired.
Filling Measures with “Static” Control Settings

There might be situations where you want to make a “static” change to a number of bars. You might for example want to lower the volume for the first synth between bars 13 and 21, or make sure the dist Amount is constant throughout the entire Song. Proceed as follows:

1. If you want to perform this action for just a section of the Song, set up the Loop to encompass that section.

2. Activate Recording.

3. If you want to, also activate playback.

   It is often convenient to make a change in playback mode, since you will then hear what you are doing! However, note that when you touch a control in this mode, you will also record that action. Then again, this might not matter since you will in a short while fill the measures in the Loop or in the whole Song, with new settings for the control you just touched!

4. When you have the setting right, select “Copy touched controls to Loop/Song” from the Edit menu.

5. Now, events for the controls you have touched during this recording pass, will be inserted at the beginning of the Loop/Song.

6. Deactivate Recording.

Using “Initialize Loop from Pattern Mode”

This item, on the Edit menu, is used for “initializing” the measures inside the Loop. This can be used as a convenient way to use the settings currently in Pattern mode, as initial settings for some measures in the Song you are building.

- Please note that this command clears all the Pattern changes and knob recordings currently inside the Loop!

Proceed as follows:

1. Switch to Pattern mode and select the correct Patterns and set up all controls as you want them to be inside the Loop.

2. Switch back to Song mode and set up the Loop to encompass the measures you want to change.

3. Select “Initialize Loop from Pattern Mode” from the Edit menu,

   Events that correspond to the settings currently made in Pattern mode, will be inserted at the beginning of the Loop. The rest of the loop is cleared completely.
Recording while Looping

A loop between bar 17 and 33.

All of the text above has assumed the Loop has been turned off. However, you can also record in Loop mode. Basically this is the same as when you record with looping off, except for one situation: when you reach the position where the Loop starts over.

As described above, as soon as you touch a control, this is considered as “punched-in” for this recording pass, and will show and play the settings you give it now, not the ones previously recorded in the Song.

However, when you reach the loop end, all controls will be “punched out”, so that on the next lap, they will instead play back movements recorded on the previous lap.

- Please note that if you move the control just when the Song loops, it will be considered as “punched-in” again. That is, you will again be recording that control, which means you erase actions performed on previous laps.

To avoid this, release the mouse button just before you reach the Loop end.

About Recording Pattern changes vs. Control Changes

Actually there is only one technical difference between recording Pattern changes and controls. Pattern changes are only recorded on downbeats (the beginning of a measure) while control changes are recorded on each 32nd note.

The only reason we have described a working order of first creating the Pattern changes and then the control recordings, is because that is the way most people seem to prefer to work.

If you like, you can do things in any order. Record some Pattern changes, then some controls, then re-record the Pattern changes, for example. Whatever control recordings you have made will now affect the new Patterns instead!

You can even start by recording the controls and then make the Pattern changes!
Making Modifications to Patterns

To make modifications to the actual Patterns, we recommend that you switch over to Pattern mode and make the changes there.

You can re-program Patterns in Song mode as well. However any changes you make will affect the currently playing Pattern. Since the Song probably switch Patterns on the fly, you need to be very careful so that you don’t reprogram the wrong Pattern.

Secondly, you should be aware that any changes you make to a Pattern (in Pattern or Song mode) will immediately be reflected everywhere in the Song where that pattern is used. The Song always plays back the Patterns just as they play in Pattern mode. In other words, what you record in the Song are switches between Pattern numbers, not the actual Patterns themselves.

Moving, Removing and Repeating Measures in the Song

Removing Measures

You may want to completely Remove some measures from the Song:

1. Set up the Loop to encompass the measures you want to remove.
2. Select Cut Loop from the Edit menu.
   The measures are removed.

Cutting and Pasting Measures

If you want to move or duplicate some measures, proceed as follows:

1. Set up the Loop to encompass the measures you want to move/duplicate.
2. Select Cut Loop or Copy Loop from the Edit menu.
   If you select Cut, the measures inside the Loop are removed and copied to the Clipboard, an “invisible” memory location from where they later can be Pasted. If you select Copy, the measures are only copied to the Clipboard.
3. Move the Song Position to the place where you want to Paste In the measures you just Cut/Copied.
4. Select Paste at Song Position or Paste Replace at Song Position.
The Difference between Paste and Paste Replace

- **When you use “plain Paste”, the measures are inserted into the Song, so that is lengthened.**
  If you for example have Cut four bars, and use “Paste at Song Position”, at Song Position 13, you will get four new measures between measure 13 and 16. These contain the pasted material. Whatever was at bar 13 before the operation, is now at bar 17.

- **When you use “Paste Replace”, the Pasted material replaces whatever was at those measures before.**
  Again, if you Cut four bars, and use “Paste Replace at Song Position”, at Song Position 13, the contents of measures 13, 14, 15 and 16 will be replaced by the measures on the Clipboard.

Repeating Measures

This is just a special case of Copy and Paste, as described above. If you are used to using Copy and Paste in for example a word processing program, you will see that this is the equivalent of that.

1. Set up the Loop to encompass the measures you want to repeat.

2. Select Copy Loop from the Edit menu.

3. Select Paste at Song Position as many times as you want extra copies of the measures to appear, after each other, in a repeated fashion.
Using the Song Feature in a “live” situation

In a live situation you might want to have “partial automation”. That is, you might want Pattern switching to be automatic, but control changes to be manual, or vice versa. Or you might want some controls automatic but others manual.

To achieve this, proceed as follows:

1. **Create a Song that only contains the automation you want, for example only the Pattern switching or only a limited set of the controls.**
   It is very important that there’s no “conflict” between the changes you want to make manually and those that you want to be automated. For example, if you want to manually control the Cutoff button on one synth in bar 17 to 32, make sure you don’t record any changes for that knob in those particular measures.

2. **Make sure the Song starts in the right way with all the correct Pattern and initial control settings.**

3. **In the live situation, load up the Song, and position to the beginning.**

4. **Hit Play and perform any Pattern switching or control changes you want to do live.**
Using “Mods”
What is a Mod?

A Mod is a file that makes ReBirth RB-338 look and sound different. When you start creating a Song, you normally begin by selecting a Mod so that you get the drum sounds you want. But you can also “transform” existing Songs by changing to another Mod at any time.

A few Mods are included with the program and get installed with it. Additional Mods can be added. Mods are for example available for free download from the Internet, see page 95.

You can also create your own Mods, from scratch, see page 96!

A Mod may:

- Replace all the drum sounds with new ones, in both rhythm sections.
- Change the appearance of the front panel completely.
  An exact list of the Mod contents can be found on page 96.

However, there are two important things that a Mod doesn’t do:

- It does not affect the functionality of the program in any way.
  All controls will work in the same way, and will be located in the same place on the front panel, regardless of which Mod you use.

- A Mod can not modify the sound of the synthesizer sections or the effects in any way whatsoever.

Mods and Memory Requirements

The graphics and sounds in a Mod uses up primary memory, RAM. The longer the drum sounds in the Mod, the more RAM is required.

Since the drum sounds in a Mod can be of practically any length, there’s no easy way to determine how much memory is required to use a certain Mod.

Furthermore, you can have several Song documents up on screen, which all use different Mods. This requires that all these Mods are loaded into memory, which eats up even more RAM.

If there is not enough memory available to use a certain Mod, a dialog will inform you.

General Memory Strategies

If you run out of memory, the first thing to do is to close other windows, specifically those that use other Mods than the one you plan to use right now.
PC Memory Strategies

On the PC, memory is “allocated” dynamically to the programs. This means that you don’t really have much control over how much memory ReBirth RB-338 uses. If you run out of memory, there are basically three things you can do:

- Quit other programs.
- Turn off background tasks and system additions that require RAM.
- Install more physical RAM.

Mac Memory Strategies

On the Mac, memory control is more “manual”. You can for yourself see how much memory you have available for applications, by selecting “About This Computer” from the Apple menu. You should do this after start-up, before you launch any programs. By checking the amount of memory available for applications, you are able to determine whether it is possible to assign more memory to ReBirth RB-338 or not.

If you want to assign ReBirth RB-338 more memory, proceed as follows:

1. Quit ReBirth if it is running.

2. Locate the ReBirth RB-338 icon in the Finder and select it.

3. Select Get Info from the File menu.

4. In the dialog that appears, assign more memory to the program.
   For exact details on this dialog, see your Macintosh manuals.

- Avoid assigning the program so much memory that none is left for the system once ReBirth RB-338 and other programs are running. The Sound Manager (the routines in the Macintosh that handle audio) require that some system memory is left unused after all applications have been launched.

If there is not enough memory available, you may consider trimming your system to free up memory. You then have the following options:

- Turning of System Extensions and Control Panels that you don’t need.
- Removing Fonts that you don’t use.

If none of this is enough, you need to install more physical RAM.
Creating a New Song with a Certain Mod

To create a New Song document with a certain Mod, proceed as follows:

1. Select New from the File menu.

2. Select the desired Mod from the Mod menu.
   The Mod startup sound is played (this feature can be turned off in the Preferences dialog).

   The options on the Mod menu depend on what Mods you have “installed” in your system, see later in this chapter.

   When you save the Song, the Mod selection is included as part of the Song document. However, the actual Mod is not stored in each Song file, just information about which Mod it uses, see “Opening Songs that use Non-Standard Mods”, below.

Switching Mods for an Open Song

You can switch Mod for any Song document, at any time. However, please note that the musical result is unpredictable, since the creator of the Mod may have used any types of sounds for the rhythm sections.

If you Save the Song after switching Mod, the next time you open the Song, it will use that last selected Mod instead.
Opening Songs that use Non-Standard Mods

If the Song you open uses a Mod that is not installed on your system, a dialog will inform you. You then have the following options: Download (only available if the Mod creator specified it), Standard and Cancel. Here are the details:

Download

If you select this option, a dialog informs you that the program will launch your Internet browser and take you to an ftp site specified by the Mod creator. This will download the file onto your computer.

1. Click OK and your preferred browser launches.
   More information on this can be found on page 180.

2. The browser takes you to the ftp site where the Mod is located (according to the information in the Song), and downloading begins.
   Normally this works like a charm. However, there are two things that can “go wrong”:

   • You browser may not recognise files of the type”rbm”. This means that instead of downloading the file, it might display it as garbage characters in a text window.
     If this happens you need to make settings in your browser that specify “rbm” files as a file typ valid for downloading.

   • Instead of you specifying where you want the file (it should be in your Mods folder, in the ReBirth folder) it might get automatically downloaded into some predefined folder on your hard disk.
     If this happens you may want to modify your browser’s settings so that it asks you where you want to store the file before you start downloading it.
     It is also possible that you might be able to specify things so that “rbm” files are automatically downloaded into your Mods folder.
     If you don’t have any control over where the file is stored, you will have to manually move the file to the Mods folder after downloading is finished.

3. After downloading, make sure the Mod is located in the ReBirth Mods folder and that it really is in “rbm” format.

4. Switch back to ReBirth and click OK.
   The Song now opens with the right Mod. If it doesn’t, the file is either not in the correct format, it doesn’t have the right extension (.rbm), or you put it in the wrong folder.

For more installation information, see page 95.
Standard

This will open the Song using the standard sounds in ReBirth RB-338 rather than the intended Mod. However, this means the Song will not play as intended by the composer.

Cancel

This cancels the whole operation. The Song will not be opened.
The Mod dialog

The Mod Selector dialog (Macintosh version).

This dialog can be used to select Mods, just as you can directly from the Mods menu. However, the dialog provides a few additional options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mod pop-up</td>
<td>This list the Mod files found in your Mod folder in your ReBirth folder. Selecting one and clicking OK, applies it to the active Song.</td>
</tr>
<tr>
<td>Mod Splash Screen</td>
<td>An “About” screen for the Mod.</td>
</tr>
<tr>
<td>Mod Information text</td>
<td>Text added by the Mod creator that tells you more about this particular Mod.</td>
</tr>
<tr>
<td>Web Site link</td>
<td>An optional link to the Mod creator’s web site. On this page you should find more information about the Mod, and the author. To go to this web page, click the Browser button.</td>
</tr>
<tr>
<td>OK</td>
<td>This closes the dialog and applies the Mod to the active Song document.</td>
</tr>
<tr>
<td>Cancel</td>
<td>This closes the dialog without making any changes.</td>
</tr>
<tr>
<td>Demo Song</td>
<td>This plays a demo Song, supplied by the Mod author, that should give you a hint as to what kind of sounds the Mod provides.</td>
</tr>
<tr>
<td>Browser</td>
<td>This launches your web browser and takes you to the web site specified for the Mod. See page 180 for details on the web browser mechanism.</td>
</tr>
</tbody>
</table>
Adding Mods to your Setup

About the Mod Files

Mods are files saved in a special “rbm” file format. The exact same Mod file can be used on both the Mac and PC platforms without any conversion. Since the file may have been created on either platform, there are two things to note for Mac users:

• A Mod file created on the PC will not have a proper icon, it will most likely use the default “blank page icon”. It will still work perfectly, though.
• A Mod file must have the extension “rbm”. That is, the file name must end with that text, for example, a Mod can be called “myrebirthmod.rbm”.

Downloading

A number of Mod files are available for download from the Internet. Some are available on the Propellerhead web pages (www.propellerheads.se) and some will be available on other web pages.

New Mods are continuously created by ReBirth users all over the world. To find out what Mods are currently available we recommend that you check the Propellerheads web pages and search the Internet using any of the search engines available. You may also want to subscribe to mailing lists and news groups that discuss Re-Birth RB-338.

Once you have located a Mod file, you can download it just like any other file you retrieve from the Internet, normally using an ftp client.

We strongly recommend anyone putting Mod files on the Internet to use ftp archives rather than web pages (ftp as opposed to http) since the automatic downloading mechanism (see page 92) in ReBirth will then work as intended. If you find a Mod file on a regular web page (http) please note that it may be packed into an archive, using a program such as WinZip (PC) and ZipIt (Mac). You then need to unpack the file before you can use it!

Installing

To Install a Mod “manually”, proceed as follows:

1. Copy/move the “.rbm” file to the “Mods” folder in your ReBirth folder.

2. Select “Scan for New Mods” from the Mods menu.

3. Check that the new file appears on the Mods menu.
   If it doesn't, the file is either not in the correct format, it doesn't have the right extension (.rbm), or you put it in the wrong folder.
Creating Your own Mods

For those so inclined, there is a possibility to create your own Mod files! This is done by assembling a number of graphical files and audio files etc, and running these through a utility included with ReBirth RB-338, called the ReBirth ModPacker. However, making a full Mod (graphics and sound) is not for the faint of heart. For example you need to create over fifty very detailed image files!

- The descriptions below assumes you are familiar with computers and have experience with image editing, audio editing and text editing applications.

Install ModPacker!

If you are interested in creating a Mod yourself, you need to install the ModPacker program and example files. An installer for these components is located on the CD, next to the ReBirth installation.

What Exactly is in a Mod File?

The following components make up a ReBirth Mod file. To check them out for yourself, locate the folder “Standard Components” in the ModPacker folder on your hard disk. This contains all the files that make up the standard ReBirth RB-338 graphics and sounds. Open the files in your preferred graphics/audio/text editor and examine the contents. To determine which image files goes where, compare the separate pictures to the complete front panel image in the program.

Here are some more details about the files:

<table>
<thead>
<tr>
<th>File Type:</th>
<th>Comment:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drum Sounds in AIFF format (.aif)</td>
<td>These are the sounds used in the rhythm sections. The name gives you a hint about where the sound is used.</td>
</tr>
<tr>
<td>Startup Sound in AIFF format (.aif)</td>
<td>This is the sound that is played when you select this Mod.</td>
</tr>
<tr>
<td>Front Panel images in JPEG format (.jpg)</td>
<td>These make up the front panel graphics. There's one file for each component. Some files contain animation strips. For example, there's one image for the synth knobs that consist of one “frame” for each possible knob position.</td>
</tr>
<tr>
<td>Splash screen in JPEG format (.jpg)</td>
<td>These is the “About screen” for the Mod, as displayed in the “Select Mod…” dialog.</td>
</tr>
<tr>
<td>Web and ftp links in text format (.txt)</td>
<td>These are simple text files that contain the links to the Mod creator’s web and ftp sites.</td>
</tr>
</tbody>
</table>
Creating a Mod

To create your own Mod, proceed as follows:

1. **Make a copy of the folder “Standard Components” and its contents and rename it to avoid confusion.**

2. **In this folder, replace the files, one by one, with your own files. Be sure to use the exact names and file formats as the current files.**
   It is not required that you replace all files. It is for example perfectly possible to make a Mod that only contains new sounds. If any file is completely missing it will simply be replaced by the corresponding standard ReBirth component. For more content guidelines, see below.

3. **Drag and drop the new folder onto the application “ModPacker”.**
   A file dialog allows you specify a name and location for the Mod file.
   
   * Please make sure the file name has the extension “.rbm” (for example “my-modfile.rbm”), even if you create it on a Macintosh computer.

4. **Install your new Mod in the ReBirth Mod folder, as described earlier in this chapter.**

Content Guidelines

**Images**

ReBirth utilizes compressed JPEG graphics (uncompressed JPEG is not supported). The amount of compression is technically of no relevance.

* Your images must be of the exact same width and height as the original ones!

**Sounds**

All sounds files must be in 44.1kHz, mono, AIFF format. If your sounds are in another format (for example Wave) there are a number of utilities available that can convert to AIFF for you.

<table>
<thead>
<tr>
<th>File Type:</th>
<th>Comment:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mod Name and Comments in text format (.txt)</td>
<td>Text files that specify the exact name of the Mod plus any comment the creator wants to convey to users of the Mod.</td>
</tr>
<tr>
<td>Demo Song in rbs format (.rbs)</td>
<td>This is a regular ReBirth RB-338 Song file. This Song will play when you click the “Demo” button in the “Select Mod...” dialog. This allows the creator to give users a hint about what sounds to expect from the Mod.</td>
</tr>
</tbody>
</table>
Here follows some notes about the individual sounds:

<table>
<thead>
<tr>
<th>Drum</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>808 BD</td>
<td>Single sample. The Decay knob controls a software envelope (decay only) and the Tone knob controls a low-pass filter.</td>
</tr>
<tr>
<td>808 SD</td>
<td>Nine samples in total; Five samples of a “clean” 808 snare (no snappy) and four high-pass-filtered “noise” samples (snappy). The Tune knob crossfades between the five clean samples. The Snappy knob controls the volume of the noise sample(s). The noise samples are played one at a time, in random order.</td>
</tr>
<tr>
<td>808 CB, CH, CL, CP</td>
<td>Single samples.</td>
</tr>
<tr>
<td>808 CY</td>
<td>Single sample. The Decay knob controls a software envelope (decay only) and the Tone knob controls a low-pass filter.</td>
</tr>
<tr>
<td>808 LC, MC, HC, LT, MT, HT</td>
<td>Single samples. Tune knob controls sample playback speed.</td>
</tr>
<tr>
<td>808 MA, RS</td>
<td>Single samples.</td>
</tr>
<tr>
<td>909 BD</td>
<td>Four samples that the Tune knob crossfades between. The Dec knob controls a software envelope (decay only) and the Att knob controls a low-pass filter.</td>
</tr>
<tr>
<td>909 SD</td>
<td>Eight samples in total; five samples of a “clean” 909 snare (no snappy) and three high-pass-filtered “noise” samples (snappy). The Tune knob switches between the five clean samples. The noise samples are played one at a time, in random order. The Snappy knob controls the volume of the noise sample(s). The Tone knob controls the length of the noise samples.</td>
</tr>
<tr>
<td>909 LT, MT, HT</td>
<td>Single samples. The Tune knob controls sample playback speed. The Decay knob controls a software envelope (decay only).</td>
</tr>
<tr>
<td>909 RS, CP</td>
<td>Single samples.</td>
</tr>
<tr>
<td>909 CH, OH</td>
<td>Single samples with a common level control. The Decay knob controls a software envelope (decay only).</td>
</tr>
<tr>
<td>909 CC, RC</td>
<td>Single samples. The Tune knob controls sample playback speed.</td>
</tr>
<tr>
<td>Startup sample</td>
<td>This sample of a Japanese drum machine powering up(!) is played back each time ReBirth boots.</td>
</tr>
</tbody>
</table>

**Important notes:**

- Be careful about the layout of your custom drum kit! All drum sounds are monophonic except the bass drums (BD). If you place bass drum samples or other samples of low frequency audio on the other “slots”, you may experience a nasty “snap” if the sample is retriggered before it's been played back in full.
For each of the two components of the snares (snappy’ and ‘tone’ samples) there are a number of variations. All the variations must have identical lengths, or some sound may not play in its entire length, under certain circumstances. Insert silence at the end of the shorter samples, if required.

Text Files

• Use international characters only in all texts. Basic umlauts are allowed, but avoid special characters.

• The Name is the identifier for the Mod. This text should not contain any version number, just the plain name. It is this text that will be used to “connect” Song files to this particular Mod. This means that if you update your Mod, you should not change the Name since then, existing Song files will require the old version of the Mod.

• The maximum text for the Comment is 600 characters.

• We recommend that you use the Comment text to describe the types of sounds your Mod contains.

• The web and ftp links should contain the complete link text and only the link text. For example, write http://www.propellerheads.se/index.htm (web) or ftp://ftp.propellerheads.se/mods/supermod.rbs (ftp).

• The web link should take you to a page with more information about the creator of the Mod. This should not be a download page! If you don’t have a web page, leave this file blank.

• The ftp link should be a direct link to an ftp site (not a web page!) from where the Mod can be downloaded. The link should contain a path to the file itself (for example (ftp.propellerheads.se/pub/Mods/supermod.rbm). If you don’t have access to an ftp site, leave this file blank and no downloading options will appear in ReBirth RB-338. Alternatively, contact us! If you follow our guidelines (see page 100) we might put it on our ftp site for others to download.

Demo Song

This is any Song file you think is appropriate for demonstrating the qualities of your Mod.

Uploading to the Internet

If you want other people to be able to download your Mod, put it on the Internet and specify the link in the actual Mod file. Whenever someone creates a Song with your Mod, the address to the actual Mod will be included in the Song. If someone then tries to play the Song without the Mod, they will be directed to your ftp site, as described on page 92.

You can put the file on a web page or in an ftp archive. Just note the following:

• You must put the file on an ftp site for the automatic downloading mechanisms to work.
• Do not archive the file using utilities such as WinZip, ZipIt or StuffIt. It is completely unnecessary (the data is already compressed) and it will only create extra work and confusion for downloaders.

• If you don’t have access to an ftp site, you will have to put the file on a web page. The automatic downloading mechanisms will not work with web pages, so don’t specify any link in the ftp.txt file. Furthermore, if you put the file on a web site, you will probably need to archive it, due to the way web browsers download binary files.

• Even if you are a Mac user, never use StuffIt if archiving is required. Instead use a PC compatible archiving program, such as ZipIt, so that both Mac and PC users can download and unpack your Mod without problems!

About Making an “Approved ReBirth Modification”

If you send us your Mod and we like it, we will distribute it through our “Mod” page. However, to get your ReBirth modification approved and distributed by Propellerhead Software, it must be made according to certain guidelines, namely:

• The modification must NOT be based on any copyrighted material. This includes both sounds and graphics. Any “mimics” of existing products, such as hardware drum machines etc, are completely ruled out. You have to create something of your own design!

• The Mod must include both completely new graphics and new audio.
ReWire – Using ReBirth RB-338 with Cubase VST
Why use ReBirth RB-338 with Cubase?

While ReBirth RB-338 is a complete music tool in its own right, you might want to add other elements to the music, such as:

- Other synthesizers (controlled via MIDI).
- Samples and loops (via a sampler connected via MIDI).
- Vocals.
- Instrumental recordings.

And what better way to do it than to use ReBirth together with Steinberg’s ‘state of the art’ audio sequencer, Cubase! Using this as a companion to ReBirth RB-338 allows you to expand and integrate your ReBirth Songs with any other type of music, MIDI and acoustic recordings. By recording ReBirth onto audio Tracks in Cubase you can also add more synth lines than is possible when using ReBirth by itself!

Introducing ReWire!

To make this integration between two audio programs possible, Propellerhead Software and Steinberg have developed ReWire. This technology provides the following possibilities and features:

- Real time streaming of up to eighteen separate ReBirth audio channels, at full bandwidth, into Cubase VST’s audio mixer.
- Automatic, sample accurate, synchronization between the audio in the two programs.
- The possibility to have the two programs share one sound card and take advantage of multiple outputs on that card.
- Linked transport controls that allows you to play, rewind etc, from either program.
- Automatic audio mixing functions that separate channels as required.
- Less total system requirements than when using the programs together in the conventional way.

How Does it Work?

Basically the key to ReWire is the fact that ReBirth RB-338 is divided into three components:

- The ReBirth application.
- The ReBirth Engine (a DLL on the PC and a Shared Library file on the Macintosh)
- ReWire (also a DLL on the PC and a Shared Library on the Macintosh).

ReWire and the ReBirth Engine are common resources to the two programs (Cubase and ReBirth) that generate the audio and passes it onto Cubase VST.
System Requirements

CPU, RAM and Hard Disk

To run Cubase VST and ReBirth RB-338 you need a fast computer with a healthy amount of RAM:

- Exactly how fast the computer needs to be is impossible to say, because it depends on how many audio channels and plug-in effects you want to use in Cubase VST. However, for serious works we recommend a Pentium at 233 MHz or faster or a Macintosh with a 604 processor or better.

- Exactly how much RAM you need is also hard to determine in advance. Again this depends on the number of audio channels that you plan to use for hard disk recording in VST. But here, ReBirth RB-338 itself is also an important factor. The more (and bigger) Mods you want to be able to use, the more RAM is required. However, we recommend that you have at least 64 MBytes of physical RAM, preferably more.

- ReWire does not put any extra requirements on your hard disk.

Cubase Versions

To use ReWire you need Cubase VST 4.0 (or later) for Macintosh or Cubase VST 3.6 (or later) for Windows.

Preparations for Using ReWire - Macintosh only

Memory Settings

When you use ReWire, some of the system resources normally occupied by ReBirth are “transferred” to Cubase VST:

More specifically, the RAM required for loading Mods in ReBirth, must now be provided by Cubase VST instead. Therefore, when using ReWire we recommend you to make the following changes to your memory settings for the two programs (for details, see your Macintosh manual):

1. If you have raised the maximum memory setting in ReBirth RB-338 (to be able to use more Mods) lower it back to the recommended value, but make a mental note of how much it was set to.

2. Raise the Maximum memory for Cubase VST by at least the amount that you just lowered for ReBirth.

OMS – Very Important!!!

- If you have OMS installed, Cubase VST must be set to use OMS as well. The OMS Compatibility setting in the MIDI System Setup dialog must be set to “IN & OUT”!
Launching and Quitting

When using Rewire, the launch and quit order is very important:

Launching for normal use with ReWire

1. First launch Cubase VST.

2. Launch ReBirth.
   Please note that it takes slightly longer for ReBirth to start when you are using it with Cubase VST.

Quitting a ReWire session

When you are finished, you also need to Quit the applications in a special order:

1. First quit ReBirth.

2. Then quit Cubase VST.

Launching Cubase VST for use without ReBirth/ReWire

If you don’t plan to run ReBirth, just launch Cubase VST as usual.

We recommend that you then also open the ReWire window and deactivate all ReWire channels (see page 105 in this chapter). But this is not completely critical, ReWire does not use up very much processing power when it isn’t used.

Launching ReBirth for use without Cubase VST/ReWire

If you want to use ReBirth RB-338 as it is, without Cubase VST, just launch it as you normally do.

Launching both programs without using ReWire

We don’t know exactly why you would want to run ReBirth and Cubase VST at the same time on the same computer, without using ReWire, but you can:

1. First launch ReBirth.

2. Then launch Cubase VST.
   You will get an error message in Cubase VST, but you can safely ignore it. Please also note that the two programs now compete for system resources such as audio cards, just as when running either with other, non-ReWire, audio applications.
Activating ReWire Channels

To activated the desired inputs from ReBirth RB-338, in Cubase VST, proceed as follows:

1. Pull down the Panels menu and select ReWire.

2. Click on the green buttons to activate/deactivate the desired channels. Exactly what signal are carried on each channel is described below. Please note that the more ReWire channels you activate, the more processing power is required.

3. If desired, double click on the labels in the right column, and type in another name. This is the label that will be used in VST to identify the ReWire channel.

![ReWire window in Cubase VST (Macintosh version). Here, only the stereo mix is activated.](image)
Signal Routing

What Signals are on the Inputs?

**Mix-L and Mix-R**
This is the regular master output in ReBirth RB-338. These are the only stereo channels, all other channels are in mono.

- **If none of the other channels are used, then this carries all the sound from ReBirth.**
- **Signals that are activated separately are removed from this mix.**
  If for example the 909-Mix channel is activated, then Mix-L and Mix-R carries all the sound from ReBirth RB-338 *except* the 909, which will appear on its own channel.

- **The only signal that can never be removed from these channels is the returns from the Delay effect.**

**303-1 and 303-2**
These are separate mono outputs for each of the 303 synth sections.

**808-Mix**
- **This is a separate mono output for the complete 808 rhythm section.**
- **Individual 808 drum sounds that are activated (see below) are removed from this mix.**
  If, for example, you activate the 808-BD, then this signal will carry all the sounds from the 808, *except* the bass drum, which will appear on its own channel.

**808-BD, SD, Tom, Per, HH and CY**
These are separate sounds and mixes of sounds from the 808 rhythm section:

- “**BD**” is the bass drum.
- “**SN**” is the snare.
- “**Tom**” is a mix of the three Toms/Congas.
- “**HH**” is the hi-hats (open and closed)
- “**CY**” is the cymbal.
- “**Per**” (percussion) carries all the remaining 808 rhythm sounds in a mono mix.

**909-Mix**
Just as 808-Mix, but for the 909 rhythm section.
909-BD, SD, Tom, Per, HH and CY
Just as the corresponding 808 individual sound outputs, but for the 909 section.

- “BD” is the bass drum.
- “SN” is the snare.
- “Tom” is a mix of the three Toms.
- “HH” is the hi-hats (open and closed)
- “CY” is both cymbals.
- “Per” (percussion) carries all the remaining 909 rhythm sounds in a mono mix.

Levels, Pan and Effects

Mix-L and Mix-R
For the stereo mix, all level controls, panning and effects apply, just as when you use ReBirth RB-338 by itself.

303-1, 303-2, 808-Mix and 909-Mix
- For the mono outputs for each section, mixer level and pan are disabled.
- All level and sound controls in the actual sections still apply.
- The insert effects – Distortion, Compression and PCF – still apply.
- The Delay send control is still active, but the actual Delay return signal always appears on the Mix-L and Mix-R channels.

Separate Rhythm Section Outputs
- For the separate rhythm section outputs (BD, SD, Tom etc.), all levels are still enabled.
- All individual sound controls (Tune, Tone, Decay etc.), still apply.
Using the Transport and Tempo Controls

Basic Transport Controls
When you run ReWire, the transports in the two programs are completely linked. It doesn’t matter in which program you Play, Stop, Fast Forward or Rewind. Recording, however, is still completely separate in the two applications.

Loop Settings
The Loop in ReBirth and the Cycle in Cubase VST are also linked. This means that you can move the start and end point for the Loop/Cycle or turn the Loop/Cycle on/off in either program, and this will be reflected in the other.

Tempo Settings
As far as tempo goes, Cubase VST is always the Master. This means that both program will run in the tempo set in Cubase VST.

However, if you are not using the Master Track in Cubase VST, you can adjust the tempo on the transport in either program, and this will immediately be reflected in the other.

- If you are using the Master Track in Cubase VST (if Master is activated on the Cubase transport), do not adjust the tempo on the ReBirth transport, since that tempo the doesn’t have any effect on playback!
How the ReWire Channels are handled in Cubase VST

When you activate ReWire channels in the ReWire window in VST, as described above, new channels are added to the Audio Channel Mixer.

A few ReWire channels in the VST Audio Channel Mixer.

These have the following properties:

- **The ReWire channel strips are red and appear in the far right of the Audio Channel Mixer, to the right of the group channels.**

- **ReWire provides mixed mono and stereo channels.**

- **The name of the ReWire channel is printed at the bottom of each strip, for identification.**

- **These channels are identical to regular VST audio Channel Mixer strips, except that they have no input. That is, they have all the fx, eq, bussing and automation facilities provided by regular hard disk recording channels.**

- **For information about how to set levels, panning, eq, fx and bussing, and how to create automation, see the Cubase VST documentation.**
Converting ReWire Channels to Audio Tracks

If you want to “convert” your ReWire channels into hard disk tracks, use the Export Audio feature in Cubase VST (see the Cubase VST operation manuals for details). Please note the following points:

- In the Export Audio dialog you have options for automatically reimporting the created audio file onto a Track. See the Cubase VST documentation for details.

- The Export Audio function converts all unmuted audio channels to a stereo or mono mix. If you want to convert only your ReWire channels, mute all the hard disk recording Tracks.

- If you want a separate mono track for a particular ReWire channel, solo that channel and use the Export Audio function.

- Once you have converted one or more synth lines in ReBirth to hard disk tracks, you can reprogram the synths in ReBirth to add more. This allows you to layer practically infinite amounts of synth lines!

Considerations and Limitations

Sample Rates

ReBirth RB-338 is limited to 44.1kHz audio playback. If you have Cubase VST set to any other sample rate, ReBirth will play back at the wrong pitch.

Synchronization

All synchronization to other equipment is handled from Cubase VST, not ReBirth. In fact there are no special synchronization issues. All that is said in the Cubase VTS documentation about synchronizing audio channels is true for ReWire channels as well.

Play in Background

Do not deactivate Play in Background (on the Options menu in Cubase VST). If you do, the communication between the two programs will be lost.

ASIO Drivers

ReWire works well with ASIO drivers. by using the Cubase VST bussing system you can route ReBirth sounds to various outputs on an ASIo compatible audio card.

Multi Processing

When running ReWire, multi processor support should be disabled in Cubase VST.
Using ReBirth RB-338 with Other Equipment and Programs
Cubase users – Read This!

This chapter does not apply to users of Cubase VST. If you are a Cubase user, you do not need to worry about OMS, audio sharing and synchronization issues. Please refer to the chapter, “ReWire – Using ReBirth RB-338 with Cubase VST” on page 101 instead.

Synchronization with Other Equipment

- Synchronization on the Macintosh computer requires you to have OMS installed.

What is Synchronization and MIDI Clock?

Synchronization, in this context, is when you make ReBirth play at the same tempo as another device; where both start, stop and can locate to certain positions, together. This is done by transmitting MIDI Clock signals between ReBirth and the other device. MIDI Clock is a very fast “metronome” that can be transmitted in a MIDI Cable. As part of the MIDI Clock concept there are also instructions for Start, Stop and locating to sixteenth note positions.

You can set up synchronization between ReBirth and hardware devices (tape recorders, drum machines, stand alone sequencers, workstations etc) and other computer programs running on the same or another computer.

Master/Slave

In a synchronized system there is always one master and one or more slaves. In our case, the master is the one that controls the tempo. In other words, it is only the tempo setting on the master device that is of any relevance, since the slaves slavishly follow the master's tempo.

- ReBirth always acts as a slave. That is it receives MIDI Clocks, it never transmits them.

Before you create any serious projects that require sync, try out the features described below and check out “Synchronization Considerations” on page 117.
Slaving ReBirth RB-338 to an External Device

This example assumes you have an external device, such as a drum machine, hardware sequencer, another computer, tape recorder etc, that transmits MIDI Clocks that you want to synchronize ReBirth to.

1. Connect a MIDI Cable from the MIDI Out on the other device to a MIDI In on the computer running ReBirth.

2. Set up the other device so that it *transmits* MIDI Clock signals to the MIDI Out you just connected to the computer running ReBirth.

3. In ReBirth, pull down the Edit menu and open the Preferences dialog.

4. In this dialog, pull down the Input menu in the MIDI Input section and select the MIDI Input to which you connected the MIDI cable from the other device.
   On the Macintosh, if you do not understand which Input this is, or if that MIDI input doesn't appear in the list, consult your OMS documentation for information on MIDI interfaces, MIDI ports and naming.

   ![MIDI Input from OMS](image)

   ReBirth Mac set up to sync to MIDI Clock coming in via the Printer port on an Opcode Studio 4 interface.

   Under Windows, if you can't find the MIDI Input you want to use, there is either something wrong with the installation of the interface, or some other program is holding on to it. Consult the documentation for the MIDI interface, the other program and Windows, for more information.

   ![MIDI Input](image)

   ReBirth Windows set up to sync to MIDI Clock coming in via the MIDI interface on a Sound Blaster card.

5. Close the dialog.

6. Activate Sync to MIDI Clock from the Options menu in ReBirth.

7. Activate playback on the other device.
   ReBirth will start playing ‘in sync’ with it and the Sync LED on the Transport will indicate the beats.
Macintosh Platform – Slaving ReBirth RB-338 to Another Program on the Same Computer, using OMS

ReBirth supports the OMS IAC (Inter Application Communication) system, which allows you to run MIDI Clock signals from another program to ReBirth.

1. **Install OMS, and make sure that IAC gets installed properly.**
   This might require you to use the Custom install option. To verify, check the OMs folder in your System Folder, after installation. It should contain a file called “OMS IAC Driver”.

2. **Make sure you have an IAC symbol in your OMS Setup document.**
   If not, create a new Studio Setup, and when you’re asked whether you want to use IAC, activate that option.

3. **Open the OMS MIDI Setup dialog in OMS Setup and make sure that “Run MIDI In Background” is enabled.**

4. **Quit OMS Setup.**

5. **Set up the other program, so that it transmits MIDI Clock to one of its dedicated “program ports” or to the OMS IAC port.**
   It doesn’t matter which you choose. If you feel unsure about which port to use, select IAC. If you want use a “program port” make sure you launch the other application before you launch ReBirth.

6. **In ReBirth, pull down the Edit menu and open the Preferences dialog.**

7. **In this dialog, pull down the Input menu in the MIDI Input section and select the MIDI Port you selected for Output in the other application.**

   ![Input](image)

   ReBirth Mac set up to sync to MIDI Clock coming in via an OMS IAC port.

8. **Close the dialog.**

9. **Activate Sync to MIDI Clock from the Options menu in ReBirth.**

10. **Activate playback on the other device.**
    ReBirth will start playing ‘in sync’ with it and the Sync LED on the Transport will indicate the beats.
Macintosh platform – Slaving ReBirth RB-338 to a non-OMS Program on the Same Computer

If the MIDI program you use does not support the professional standard for MIDI on Macintosh computers, OMS, you can still set up synchronization, but this requires two MIDI interfaces, each connected to one of the serial ports on your computer.

1. Set up OMS so that it uses only one of the MIDI interfaces installed.

2. Set up the other application so that it uses the other MIDI interface.

3. Connect a MIDI cable from an output on the “other application” interface to an input on the OMS-controlled interface.

4. Set up the other application so that it transmits MIDI Clock signals to the output you connected the cable to.

5. In ReBirth, pull down the Edit menu and open the Preferences dialog.

6. In this dialog, pull down the Input menu in the MIDI Input section and select the MIDI Port you connected the cable to.
   If you do not understand which Input this is, or if that MIDI input doesn’t appear in the list, consult your OMS documentation for information on MIDI interfaces, MIDI ports and naming.

7. Close the dialog.

8. Activate Sync to MIDI Clock from the Options menu in ReBirth.

9. Activate playback on the other device.
   ReBirth will start playing ‘in sync’ with it and the Sync LED on the Transport will indicate the beats.
Windows platform – Slaving ReBirth RB-338 to an Another Program on the Same Computer

ReBirth synchronizes to other programs on the same computer via a utility called "Hubi’s Loopback Device". This utility is included on the ReBirth RB-338 CD-ROM, in the folder “Hld” (Hubi’s Loopback Device).

Installing
1. Insert the ReBirth RB-338 CD-ROM into your computer.
2. Locate the folder “Hld” on the CD-ROM.
3. Find the file “How to Install HLD” in this folder, and double click on it.
4. Follow the instructions on screen.

Setting up the applications
With the "Hubi’s Loopback Device" utility installed, you will find a number of new MIDI Inputs and Outputs in your MIDI applications. These are “invisible MIDI cables” that run between the MIDI programs on your computer.

1. In the other application, set things up so that it transmits MIDI Clock signals to the desired output ("LB1" if you haven’t renamed the MIDI “ports” in Hubi’s Loopback Device).

2. In ReBirth, pull down the Edit menu and open the Preferences dialog.
3. In this dialog, pull down the Input menu in the MIDI Input section, and select the corresponding Input (possibly “LB1”).
   Now, ReBirth will receive MIDI Clock signals from the other application, via Hubi’s Loopback Device.

4. Close the dialog.
5. Activate Sync to MIDI Clock from the Options menu in ReBirth.
6. Activate playback on the other device.
   ReBirth will start playing ‘in sync’ with it and the Sync LED on the Transport will indicate the beats.

Note that this makes the two programs play at the same time, that is, they both “run” when you “hit play”. It does not means they can both play audio at the same time. See page 123 for details about “sharing audio".
Synchronization Considerations

trimming Adjust Sync

| Sync to MIDI Clock | Adjust Sync: 23ms |

Adjust Sync (Mac version)

Because of the latency problem described on page 183, you might need to adjust ReBirth RB-338’s playback in relation to the sync master, so that they are in perfect time. The tempo will not differ between the two, but ReBirth might play ahead or behind the other application. You might need to adjust this. However, this is something you only need to do once. The setting is stored with your other preferences, so you don’t need to adjust it again.

Proceed as follows:

1. **Set up the other application so that it generates a solid click, on for example quarter or eighth notes, preferably with a special sound on the downbeat.**
   This click can either come from an internal metronome or from a MIDI source. If you use a MIDI source, make sure you pick one that has solid MIDI timing.

2. **Set up ReBirth so that it plays a similar rhythm as the other application.**
   You might for example use the CB and CL sounds.

3. **Start the two applications in sync.**

4. **Make sure you hear both applications at approximately equal level.**

5. **Open the Preferences dialog in ReBirth.**

6. **Trim the “Adjust Sync” setting until the “clicks” from the both sources sound at exactly the same time.**

7. **Close the Preferences dialog in ReBirth.**
About the beginning of the Song

Due to the latency phenomenon, described on page 183, ReBirth needs some time to correct it’s playback speed when it first receives the Start command. This can be noted as a small glitch in the audio playback, when the program starts. If this is a problem, you need to insert a couple of empty measures at the beginning of the Song. Proceed as follows:

1. Make sure you are in Song mode, in ReBirth.
2. Set up the Loop so that it starts at Bar 1 and is two Bars long.
3. Move to Bar 1, the beginning of the Song.
4. Select Copy from the Edit menu.
5. Select Paste from the Edit menu.
   You now have two more measures at the beginning of the Song. Let’s make them silent:
6. Activate recording, but not playback.
7. Deactivate all three sections, in the Pattern selector.
8. Move the Song Position to Bar 2.
9. If required, deactivate all three sections in this measure too.
10. Deactivate Recording.
11. Set up the other device/application, so that it also plays two empty bars at the beginning.

About MIDI Song Position Pointers

MIDI Clock actually consists of five type of messages: The actual clock (the metronome that establishes the tempo), Start, Stop and Continue commands and Song Position Pointers. This last type of message contains information about positions, so that a program for example “knows” where in a Song to start playback from. Normally, this ensures that you can locate to any position and activate playback from there. In older devices, Song Position Pointers might not be implemented. This means that you will be able to synchronize properly only if you start both devices from the absolute beginning of the song.

About Tempo readouts

If the other program/device also has a tempo display, you might note slight differences in tempo readout between ReBirth and the other device/application. This is normal, especially if the other is an external device, and does not mean the two do not sync properly. MIDI Clock does not contain numeric information about which tempo to play in. Rather, the tempo has to be calculated by the receiving device, by measuring the pace the clock signals are coming in at. Just like with two watches,
there will always be minor differences in their “speed”.

**About Tempo Changes**

Again, due to the latency phenomenon, ReBirth RB-338 needs a bit of time to adjust to changes in tempo. If there are abrupt changes in the MIDI Clock, due to drastic tempo changes on the master, you will note that ReBirth RB-338 will require up to one measure to adjust itself to the change. How long this actually takes also depends on the precision of the incoming MIDI Clock. The more precise it is, the faster ReBirth can adjust to it.

If this adjustment is a problem, try to use gradual tempo changes rather than immediate ones.

Also note that drastic tempo changes might introduce “clicks” in the output from the Delay unit in ReBirth.
Using “Live Sync”

Background Information

What is commonly referred to as “MIDI Clock” is actually four different types of MIDI messages:

- Start and Stop
  These are the messages sent out when you Start and Stop your sync master.

- Song Position pointers
  These are messages used for sending out positions, so that a slave can determine where in a Song to start from. If you for example fast forward your master to bar 80 and hit play, ReBirth will also start from bar 80.

- The actual clock messages.
  Once playback is going, the only messages that are sent are the actual clock messages, that allow the slave to play in the same tempo as the master.

ReBirth RB-338 responds correctly to all these messages. Understanding the difference between them will help you make the most out of the live sync feature in the program, see later in this chapter.

The Sync and MIDI LEDs

The MIDI LED

The MIDI LED indicates the program is receiving MIDI data.

The MIDI LED on the front panel lights up on all types of MIDI messages, including MIDI Clock. This means that if this is lit, MIDI clock messages are actually coming in on the MIDI port specified in the Preferences dialog. This can be used for determining whether the MIDI ports are set up correctly and whether the master is actually set to transmit MIDI Clock messages.

- Most devices (but not all) transmit MIDI Clock messages even when in Stop mode. This means that if the Master is set to transmit MIDI Clock, the MIDI LED on the ReBirth transport panel might be lit constantly, regardless of whether the master is playing or not. This is completely normal!
The Sync LED

The Sync LED indicates the program is in sync with another program or device. The Sync LED shows the status of the incoming sync and provides a visual indication of the bar position. It blinks red on the downbeat and green on all other beats.

This LED is only operational when the master has been started. This is an indication that ReBirth is in sync mode. Again, this can be used for troubleshooting: If you get an indication on the Sync LED but still have no sync, there can only be two reasons:

- Sync to MIDI Clock is not activated on the Options menu, (or in the Preferences dialog), or...
- You have hit Stop on the ReBirth transport panel. Hit Play again.

Stopping, Starting, and Opening Songs in Sync mode

When ReBirth RB-338 has received a Start message it is by definition “in sync” until it receives a Stop message from the master.

You can hit Stop on the ReBirth transport panel, but the program will keep counting clocks “in the background”. This allows you to:

- **Hit Stop, wind the Song Position to any position in the Song and hit Play again.**
  Playback will start again on the next downbeat.

- **Switch to another Song window, move the Song position to any position and hit Play.**
  Playback will stop immediately in the Song that is now playing, and will resume in the current Song document, at the next downbeat.

- **Open a Song document, move the Song position to any position and hit Play.**
  Opening another document does not affect playback. Not until you hit Play does the newly opened document actually start playing (at the next downbeat).

Windows 95 users might experience short audio playback glitches while Song documents are being loaded from disk. The risk of this happening depends on a number of factors; among others the speed of your computer and hard disk and the size of the audio buffers as set in the ReBirth Preferences dialog (the larger the safer). If this is a problem, open all Songs you intend to play back, before you start your “syncing session”.

- 121 -
Repositioning the Master

As described above, you can Start and Stop ReBirth RB-338 as much as you like during playback. This will naturally introduce a difference between the Song positions in the master and in ReBirth. For example, when the master indicates bar 80, ReBirth might be playing bar 12 or 257, all depending on your use of the ReBirth transport panel.

However, if you change the Song position on the master, for example by winding or rewinding, it will most likely send out a Song Position Pointer message to ReBirth, which will adjust itself so that the two program play the same measure.

When the Master Device is in Stop mode

If you Stop the Master, you can still activate Playback in ReBirth RB-338. It will then play in the tempo set on the Transport bar, not necessarily the same tempo as the master is set to.
Running multiple Audio Applications on one Computer

You might want to run ReBirth RB-338 together with another audio application, at the same time. Since ReBirth synchronizes, you might for example want to run it “in tandem” with an audio sequencer. Exactly how to do this depends on your computer configuration and the platform you are on.

Windows

Under Windows, two applications normally do not share an audio card. If you launch two applications, one of them will “grab” the audio card, which means the other will stop sounding.

How can I make ReBirth RB-338 and another application play audio at the same time?

There are three ways:

• **Use two audio cards.** You can then assign one to ReBirth (see the installation instructions) and one to the other audio application. However, this assumes the other application does not “grab” all the audio cards in your computer. Please refer to that program’s documentation for details.

• A few audio cards can mix the audio from several applications. An example of such an audio card is Terratec EWS-64. This card “fools” Windows into thinking there is more than one card installed into the system. If you have such a card, you can set up both applications to use it.

• **If all applications are compatible with DirectX 3 or later and support the “secondary buffer feature” in DirectX** (see page 184), they can all “share” one audio card. ReBirth of course fulfills both these DirectX requirements.

A note about background playback

If you access the audio card via DirectX version 2, ReBirth will not be able to play in the background. That is, as soon as you switch to another application, ReBirth will stop sounding.
ReBirth RB-338 plays audio via the standard audio procedures on the Macintosh, called the Sound Manager. The Sound Manager has the ability to mix audio from several applications. This means that if you run ReBirth together with another standard audio application, the audio from both will automatically be mixed and will appear at the stereo outputs on the computer.

If the other application uses special audio routines, that “grab” the sound on the computer, ReBirth will not be able to play.

Some audio applications that use audio cards installed into the computer, access these cards directly (as opposed to using the Sound Manager). If you run such an application, you can still play audio from both applications at the same time. ReBirth uses the Sound Manager (the audio appears on the standard Macintosh outputs) and the other application uses the sound card.

Using “Export Loop as AIFF/Wave” to Overcome the “One Audio Card Only” Problem.

If you only have one audio card, or for other reasons can not get ReBirth RB-338 to play at the same time as another audio program, there are still ways to integrate the audio from the two applications:

1. Create a Song in ReBirth.
   You can do this either without running any other application at the same time, or while being synchronized with another application, only utilizing its MIDI capabilities, so that ReBirth has access to the audio on your computer.

2. Export the ReBirth Song as an audio file (see page 142).

3. Quit ReBirth.

4. Import the audio file into the other application, as a stereo audio track.

5. Continue working on the Song in the other program. If you need to make changes in the ReBirth material, either use the editing capabilities of the other program, or go back into ReBirth, make the necessary change, export the file and re-import into the other program, replacing the previous ReBirth track.

About differences in tempo between applications

Computer applications handle tempo in different ways. Some drive their tempo from the clocking of the digital audio (ReBirth RB-338 uses this method) while other programs use other types of timing methods. This means that when you set two applications to 120 BPM (without any synchronization between them) and start them at the same time, they might tick away at slightly different speeds, even if they run on the same computer.

For this reason, an audio file generated in ReBirth at a certain tempo, might not play back in perfect time with the material in the other program, even if they play at the same tempo.
To get around this, use the other application’s tempo adjustment methods to match the material already present in the other program to the audio file.
Remote MIDI Control
Introduction

This feature allows you to control practically all parameters on the ReBirth panel, via MIDI. This can be used either as a way of playing ReBirth RB-338 “live” or when you want to control it via a MIDI sequencer, rather than using ReBirth’s built-in automation.

Standard Mapping vs Quick Mapping

There are two major modes for Remote MIDI control, which you can select between from ReBirth’s Preferences dialog:

Standard Mapping
This is the preferred mode for those with advanced MIDI setups, for example programmable fader panels etc.

Quick Mapping
This is the preferred mode if you want to control the most common parameters, for example from your keyboard synth’s wheels and pedals.

More on these modes later in this text.

About MIDI Channels and Inputs

The MIDI Input and Channel settings in the Preferences dialog are used to determine which external device should be used for Remote MIDI control.

- ReBirth RB-338 only receives MIDI messages, it does not transmit any MIDI.
Setting up Remote MIDI Control from External MIDI Hardware

If you have some MIDI device connected to your computer that you want to use for controlling ReBirth RB-338, proceed as follows:

1. Set things up so that the device you want to use for transmitting MIDI messages is connected to the desired MIDI input. Please note that if you want to synchronize ReBirth at the same time as using Remote MIDI Control, you must set things up so that the synchronization messages come in on the same MIDI input as the controller messages.

2. If you are running ReBirth on a Macintosh computer, create a device in OMS setup that corresponds to your external MIDI device and save your setup. See the OMS documentation for details.

3. Launch ReBirth. If you run ReBirth on a Macintosh it is important that you launch ReBirth after making changes to OMS, or the changes you have made will not be available in ReBirth.

4. In ReBirth, open the Preferences dialog. The MIDI section of the Preferences dialog (Macintosh version shown here).

5. Activate Remote MIDI Control.

6. Select the MIDI Input port and MIDI channel that your controller is transmitting on.

7. Choose Standard or Quick Mapping, and if required, click the Edit button to set up the Quick mapping. The details on these modes and the Quick Remote MIDI Mapping dialog are described on page 130 and onwards.
Setting up Remote MIDI Control from another Program

If you have another program running on the same computer, that you want to use for controlling ReBirth RB-338, proceed as follows:

1. Set up the other program so that the Tracks you want to use for controlling ReBirth transmit to a MIDI port and MIDI channel that ReBirth can receive on.
   If you are running ReBirth RB-338 on the PC this will probably be one of the ports added to your system by HLD (Hubi’s Loopback Device – see page 116). If you are using a Macintosh, this will be an OMS IAC port (page 114).

2. Launch ReBirth.

3. In ReBirth, open the Preferences dialog.


5. Select the MIDI Input port and MIDI channel that the other program is transmitting on.

6. Choose Standard or Quick Mapping, and if required, click the Edit button to set up the Quick mapping.
   The details on these modes and the Quick Remote MIDI Mapping dialog are described below.
Standard Mapping vs Quick Mapping

Standard Mapping

In the Standard Mapping mode practically all controls can be accessed. However, this mode more or less assumes you have access to a special hardware or software control panel, where the controls can be programmed to send arbitrary MIDI messages. Since there is such a multitude of controls available in Standard Mapping mode, accessing them from for example a normal synth keyboard or master keyboard, with only a few sliders, becomes ergonomically difficult.

The MIDI implementation used in Standard mode can be found on page 194 and onwards.

Quick Mapping

Quick Mapping, on the other hand, is perfect for those with limited MIDI equipment. Even if you only have access to a modulation wheel on your synth, it can be put to good use when recording knob movements in Song mode or when playing live.

How to set up the relation between your controller devices and ReBirth’s functions is described in the next paragraph.
Setting up Quick Mapping

1. Setup Remote MIDI Control as described earlier in this chapter.

2. Open the Preferences dialog and make sure Quick Mapping is selected.

3. Click the Quick Mapping Edit button.

The Quick Mapping dialog (Macintosh version).

Manual Setup

1. Select a function you want to use, from the set of pop-up menus.

2. Click in the field to the right of the pop-up and type in the number of the controller message you want to use.

Using Learn

1. Select a function that you want to use, from the set of pop-up menus.

2. Move the controller you want to use for this function.
   The field at the bottom of the dialog shows the number for this controller. If it doesn’t, this is an indication your MIDI connection is not set up correctly. See Checking Your Setup, below.

3. Click the Learn button associated with the function you want to use.
   This controller number is entered in the corresponding value field.

Checking your Setup

There are a few techniques you can use to check that your setup is done correctly:
• **Use the MIDI LED on the Transport panel.**
  This responds to on all MIDI messages except System Exclusive. If it lights up, this means some type of MIDI data on some MIDI Channel is coming in on the MIDI port selected in the Preferences dialog. If this doesn’t light up, check your other device, your MIDI interface and your MIDI port setup (Macintosh users should check OMS Setup).

![MIDI LED](image)

The MIDI LED indicates incoming MIDI data.

• **Changes that you make in the Quick Mapping dialog are effective immediately, even while the dialog is up on screen.**
  This means you can have playback going while you set up the Quick Mapping dialog. Make sure you are in Pattern mode and check your mapping as you go along.

• **The controls move on the screen when they receive MIDI messages, even when the dialog is up on screen.**
  This can be used as visual feedback. If a control moves, it is mapped correctly.
Using Remote MIDI Control

Once your Remote MIDI Control connection is up and working it can be used in numerous ways:

- **To run the program “live”, in Pattern or Song mode.**
  See the tips on live usage on page 87.

- **To record your Song automation in a more natural way than when using the mouse.**
  This is convenient even if you only have a couple of MIDI controllers to use at a time. After each recording pass you can open the Quick Mapping Edit dialog and map those controllers to other functions in the program.

- **As a way of completely controlling ReBirth from an external hardware device.**
  This assumes you have a very advanced hardware controller with many buttons, knobs and faders.

- **To record parts of, or all of your Song automation in another program.**
  You would then remain in Pattern mode but send Pattern changes and control messages from the other program. Essentially, you then move all of the Song mode functionality over to the other program.
Important Notes about MIDI Control

- There is only one MIDI input port to the whole program.
  If you want to synchronize and control knobs, etc – all at the same time – you have to make sure both the MIDI clock signals and the controller data is supplied on the MIDI input selected in the Preferences dialog. Use the MIDI LED on the transport bar to check whether any MIDI data is coming in via the selected port.

- Only one MIDI Channel is used at a time.
  All Controller data must be transmitted on the same MIDI Channel, the one selected in the Preferences dialog.

- Only MIDI Control Change messages are received in Quick Mapping mode.
  Do not confuse Control Change messages with other, similar types of MIDI messages, such as pitch bend, aftertouch, key pressure etc.

- ReBirth only reads OMS ports on startup.
  Macintosh users should be aware that your OMS configuration is only checked when you launch ReBirth. Any changes made to your OMS Setup will not take effect until you Quit ReBirth RB-338 and launch it again.

- Minimize Latency!
  As described in the main ReBirth manual, there is a short delay between the moment when you move a control with the mouse and when this takes effect on the sound output. This is called latency. Exactly the same delay affects Remote MIDI control. Make sure the sound buffer settings in the Preferences dialog are adjusted to the lowest possible values, as described in the main ReBirth manual.
File and Song Window Handling
New Songs – Changing the Default Settings

To create a new “blank” Song, select New from the File menu.

New songs can either use default settings for Patterns and controls, or you can customize the settings so that New Songs appear just as you want them:

Customizing

1. Set up a Song so that it is exactly as you want New Songs to be.
2. Open the Preferences dialog.
3. Click the “Use Current Song” button at the bottom of the dialog.
4. Close the dialog.

The Default Song plays a number of “factory Patterns” intended to get you started with the program. To “silence” a Pattern, click the Clear button in the relevant synth section.

When you get better acquainted with the program you might want to customize it as described above. One quick way of doing this is to load one of two Song files located in the ReBirth folder, and then use the “Use Current Song” feature described above:

• “ReBirth 1.0 Default Song”. This makes the program behave as in version 1.0. New Songs play silent rhythm Patterns and repeating 16th note synth Patterns.
• “Silent Default Song”. This contains all silent Patterns.

Mod selection for New Songs

When you first launch the program, New Songs that you create will use the standard ReBirth panel. After that, New Songs will use the same mod as you last selected.
Saving Songs

When you save your Song, using the Save and Save As commands, you save all the Patterns, all settings in Pattern mode, the entire Song and which Mod was used, all in one file.

The file dialog used for saving is the standard Windows/Macintosh one. For details about saving, hard disks, floppy and other media, see the manual that came with your computer and storage devices.

The Song Information Feature

If you like you can enter information about your Song. This is useful for example if you intend to distribute your files via Internet and want to make people aware of who the creator is.

Filling in the Dialog

1. Select Song Information from the File menu.

2. Fill in the three fields:
   - Text in Window Title will always appear in the Song window title.
   - “More Information” and “Creator’s web page” will appear in the Information dialog and in the “splash screen” that appears when you load the Song (if Show Information...” is activated, see below”).

3. If you like, activate “Show Information on Song Open”.
   This ensures everybody will see the information when they load the Song.

Linking to the Song creator’s web page

If the Song creator has entered a URL to a web page, you can launch your preferred web browser and display the page. Proceed as follows:

1. Open the Song Information dialog.

2. Click on the Browse button.
   On the PC, your default browser launches directly. On the Macintosh you have to select a browser in a dialog. In either case, the browser takes you to the specified web page.
Opening Songs

- **Using the Open Dialog**
  You can of course open saved Song files using a regular Open dialog.

- **Using Drag and Drop**
  ReBirth supports standard Drag and Drop features on each platform.

- **Using The Recent Documents Menu Items**
  There is a “recent documents” section on the File menu. This lists the four most recently opened Song files. Selecting one re-opens that file.

**Mod Note**

Please note that a Song may require a Mod that is not installed on your system. If this happens, you will be given various options, one being to download the Mod from the Internet. See page 92 for details.

**Macintosh Memory Note**

If you can’t open a Song, this is probably because you haven’t assigned enough memory to the program. This is especially true if the Song uses another Mod than your currently open Song(s) do. Proceed as follows:

1. Quit ReBirth.
2. Locate the ReBirth RB-338 icon in the Finder and select it.
3. Select Get Info from the File menu.
4. In the dialog that appears, assign more memory to the program.
   For exact details on this dialog, see your Macintosh manuals. Exactly how much memory you can assign to the program depends on the amount of memory installed in your Macintosh.

   Avoid assigning the program so much memory that none is left for the system once ReBirth RB-338 and other programs are running. The Sound Manager (the routines in the Macintosh that handle audio) require that some system memory is left unused after all applications have been launched.

**Switching between Windows**

You can have as many Song documents open as you like, or as memory permits. However, only one of them can play back at a time.

You can switch between windows by clicking on them, or by using the Windows menu. This does not affect which window is playing back. Not until you click the Play button in the active Song window does that Song start playing.
Switching to Other Programs

As described on page 123, ReBirth RB-338 can play “in the background”, if some basic criteria are met. This means that the current Song will keep playing even if you switch to another program.

Stay on Top (Windows only)

The Windows version of ReBirth RB-338 has an item on the Windows menu, called “Stay on Top”. When this is activated, the ReBirth window will always stay on top of other program’s windows. This is intended mainly for when you sync ReBirth to another music program. Since the other program is always the Master, you will use its transport panel for playing and stopping. Activating this function ensures you can do this without having your ReBirth windows hidden behind other windows.

Copying and Moving Patterns between Songs

Since there is no Pattern file format, only the Song format, it might not be obvious how to Copy and move Patterns between Songs. This is done using Cut, Copy and Paste, as described on page 51.
Moving ReBirth Song files and Mods between Macintosh and PC Computers

Moving ReBirth RB-338 files between Mac and PC platforms is easy. As with any file, getting it from the Mac to the PC or vice versa, requires some kind of portable media (DOS-formatted floppies for example) or a network. However, once the file is on the desired computer disk, the following applies for loading it into ReBirth RB-338:

Loading Mac files on the PC

Songs
On the PC, Song files must have the extension “.rbs”. This allows you to double click the file to open it, and it will have the right file icon.

Mods
Mod files must have the extension “.rbm” to be recognized properly.

Using PC files on the Mac

Song
On the Mac a Song file must meet at least one of two criteria:

• File Type “TSSQ” and Creator “ReBi”.
  This ensures the file has the right icon. However, changing the File Type and Creator requires special software, see below. Ask your computer dealer if in doubt.

• File extension “.rbs”.
  This will allow you to open the file, but it will probably not have the right icon in the Finder.

• Regardless of whether the file has the right icon or not, you can always open it using the Open dialog in ReBirth or by using Drag and Drop.

• However, if the file doesn’t have the right icon you can not open the file by double clicking it in the Finder.
  When you re-save a file it automatically gets the correct File Type and Creator.

Mods

• Mod files should always have the file extension “.rbm”.
  This will allow you use the Mod. However, it may still have the wrong icon in the Finder.

• To ensure the file has the right icon in the Finder, make sure it has the File Type “RBM” and Creator “ReBi”.
Setting the File Type and Creator

There are numerous ways of setting the File Type and Creator of files brought from a PC to the Mac. Let us just mention two:

- **Using PC Exchange.**
  This utility is included with every Macintosh computer. It allows you to set up “mapping”, so that when a DOS formatted floppy disk (and some other types of media) is inserted, files with a certain extension are automatically given the correct File Type and Creator.

- **Using ZiptIt.**
  This shareware program can be used for unpacking files archived in the common PC format, “Zip”. ZiptIt can be set up so that when a file with a certain extension is extracted from an archive, it automatically gets the desired File Type and Creator.
Exporting Songs and Patterns as Audio (AIFF/Wave) files

You can save your entire Song, or parts of it, as an audio file. This file can be in AIFF (Audio Interchange File Format – the standard audio file format on the Macintosh) or Wave (“WAV” – the standard audio file format on the PC). Proceed as follows:

1. Make sure you are in Song mode.

2. Set up the Loop so that it encompasses the part of the Song you want to convert.
   This can be a Loop of any Length, from a one bar Pattern to the whole Song. If you want to export the whole Song, remember to include some extra bars at the end, so that any repeats from the Delay section get included.

3. Select “Export Loop as Audio File” (PC) or “Export Loop as AIFF/Wave file” (Mac) from the File menu.

4. Specify a name and location for your file.
   On the PC platform, select a file format (AIFF or Wave), from the pop-up at the bottom of the dialog.

5. Click Save.

Audio files are relatively big! For example, a three minute Song will occupy over 30 MBytes of hard disk space.
Reference
Transport Panel

Song Mode/Pattern Mode

This switches ReBirth RB-338 between its two major modes: Pattern mode and Song mode. The two modes have major differences. Below we will list the properties for each one, in list form:

Pattern Mode

- Is designed for programming the synths and rhythm sections.
- The Fast Forward and Rewind controls are not used.
- Always loops the selected Patterns.
- The Record button isn’t used.

Song Mode

- Allows you to build a complete Song by recording Pattern changes and knob movements.
- Introduces the loop feature which allows you to repeat any section of the Song infinitely.

MIDI Indicator

This “LED” lights up to indicate incoming MIDI messages. It reacts on all MIDI messages except System Exclusive. Use this as a visual indication that your MIDI setup is done correctly.
Sync Indicator

This “LED” indicates incoming MIDI sync. It blinks red on the downbeat and green on all other beats. Use this as an indication that the master device (the one transmitting the MIDI Clock messages) is actually started and the MIDI setup is done correctly.

This indicator is also used in conjunction with the “Live Sync” feature, which allows you to start and stop ReBirth and even switch between Song documents, without losing sync. See page 120 for details.

Tempo

Here you can set the tempo for your Song in “bpm” (beats per minute). The range is 20 to 500 bpm (80 to 160 is a “normal” range of tempos).

When ReBirth is synchronized to another device (including when you use ReWire), this setting is of no importance, since ReBirth will play in the tempo of the other device.

Bar Display

This shows the current position in bars (measures). Only relevant in Song mode. If you click one of the arrow buttons the Song Position is moved one measure back/forward. If you keep the mouse button down, it scrolls continuously.

Play

This activates playback. If you are in Song mode, this should be thought of as “continue play”, that is it will start playback from the current position.

Stop

- When you click this during playback, the program stops.
- If the program is already stopped, the Song Position moves to the Loop Start.
  There's an exception to this: If the Song Position is already at an earlier position than the Left Locator, it moves to the beginning of the Song.
- If you click one more time, the Song Position moves to the beginning of the Song.
  In other words, clicking three times always moves you to the beginning of the Song.

Rewind

Every click on this button moves the Song position ten bars back. If you keep the mouse button pressed, it rewinds continuously.
Fast Forward

Every click on this button moves the Song position ten bars forward. If you keep the mouse button pressed, it fast forwards continuously.

Record

This button is used for recording Pattern changes and knob movements in Song mode. It has no function in Pattern mode.

Loop On/Off

When this is activated, the section specified by the Start and Length settings is looped.

Loop Start and Length

The Loop start is the bar where you want looping to start.

The Length setting is the number of bars you want looped.
Pattern Section

Bank and Pattern Selectors

These are used for selecting between the 32 Patterns available for each section in each Song.

- **To select another Pattern, in the same Bank, simply click one of the Pattern buttons.**
- **To switch to another Pattern in another Bank, first select the Bank, then the Pattern.**

No Pattern gets selected until you click one of the Pattern buttons 1 to 8.

You can also switch Patterns from the computer keyboard, see page 20 and page 224.

Step Display and Setting

This is used for setting the length of the Pattern, in steps of 16th notes. This can be done at any time and affects playback immediately.

You can even have different Pattern lengths for different sections. Each one loops independently. Different Patterns can have different lengths.

Shuffle On/Off

When this is activated, this section will play with a shuffle rhythm as opposed to straight timing. Exactly how much Shuffle is applied is determined by the Shuffle knob on the Transport, which is a global setting for all sections. See page 21 for more information.
808 Rhythm Section

The red knobs set the levels of the individual sounds.

The white knobs are used for adjusting the various sound parameters.

The colored step buttons are used for programming the selected instrument into the Pattern.

Click on the light instrument legends to select an instrument.

The large knob is used for selecting instruments.

Sound Selector

This knob is used for selecting between the main sounds.

For more info about selecting sounds, see page 28.

For information about the “shared instruments”, see page 34.
Sounds

As stated in the table above, some instrument “slots” can only play one of two sounds. In these cases, there’s a small switch that allows you to select which sound will be played by this instrument “slot”. You can flick the switch any time. Whatever is programmed for this “instrument slot” will be played by the sound selected at that time.

Tone

This knob adjusts the “color” of the sound. Exactly in which way depends on the sound, but the higher the setting, the “brighter” the sound.

Decay

This adjusts the length of the sound. The higher the setting, the longer the sound.
**Tune**

This adjusts the pitch of the sound. On the Snare Drum it only affects the “tone” part of the sound, not the “noise” part.

**Snappy**

This is only available for the Snare Drum. It is actually a level control for the “snare” (noise) part of the sound. The higher the setting, the more of the “snare” you will hear.
909 Rhythm Section

The Flam knob is used to adjust the length of flam hits.

Click on a legend to select an instrument.

Use the knobs to adjust volume and various sound parameters.

When this is activated, the step buttons are used for programming flam hits.

The step buttons are used to program the selected instrument into the Pattern. Click twice to get an accented hit.

Sounds

<table>
<thead>
<tr>
<th>Legend</th>
<th>Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC</td>
<td>Accent</td>
<td>This is not a sound, but rather a way to control dynamics. The steps where Accent is activated will be louder. Exactly how much louder is determined by the Accent Level control. This control has equal effect on all sounds.</td>
</tr>
<tr>
<td>BD</td>
<td>Bass Drum</td>
<td>Has Tune, Attack and Decay controls.</td>
</tr>
<tr>
<td>SD</td>
<td>Snare Drum</td>
<td>Has Tune, Tone and Snap controls.</td>
</tr>
<tr>
<td>LT</td>
<td>Low Tom</td>
<td>Has Tune and Decay controls.</td>
</tr>
<tr>
<td>MT</td>
<td>Middle Tom</td>
<td>Has Tune and Decay controls.</td>
</tr>
<tr>
<td>HT</td>
<td>High Tom</td>
<td>Has Tune and Decay controls.</td>
</tr>
<tr>
<td>RS</td>
<td>Rim Shot</td>
<td>Has no sound controls.</td>
</tr>
<tr>
<td>CP</td>
<td>(Hand) Claps</td>
<td>Has no sound controls.</td>
</tr>
<tr>
<td>CH</td>
<td>Closed Hi-hat</td>
<td>Has a Decay control. Shares Level with Open Hi-hat. Cuts off the Open Hi-hat.</td>
</tr>
<tr>
<td>OH</td>
<td>Open Hi-hat</td>
<td>Has a Decay control. Shares Level with Closed Hi-hat. Is cut off by the Closed Hi-hat.</td>
</tr>
<tr>
<td>CC</td>
<td>Crash Cymbal</td>
<td>Has a Tune control.</td>
</tr>
<tr>
<td>RC</td>
<td>Cymbal</td>
<td>Has a Tune control.</td>
</tr>
</tbody>
</table>

Level

This is simply the volume for the sound.
Tune

This is the pitch of the sound, the tuning. For the snare, please note that this only affects the “body” of the sound, not the “rattle”.

Tone

This is a decay control for the snare “rattle”. The higher the setting the longer the sound.

Dec(ay)

This adjusts the length of the sound.

Snap(py)

This is only available for the snare. It adjusts the balance between the “body” of the sound and the “rattle”.

Att(ack)

Adjusts the “click” in the beginning of the 909 bass drum.

Flam Button and Knob

- When the flam button is activated, steps that you activate will be played as flams (two hits very close to each other).
- You can adjust the “width” of the flam using the Flam knob.
**Pitch Mode**

- When this is activated, the sequencer will automatically advance to the next step as soon as you select a pitch, using the Pitch buttons.
- When this is deactivated, the sequencer never advances automatically to the next step.
- If you deactivate and then immediately activate Pitch mode, you return to the first step in the Pattern.

**Clear**

This Clears the Pattern completely. This means all steps are set as follows:

<table>
<thead>
<tr>
<th>Function</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch</td>
<td>Low C</td>
</tr>
<tr>
<td>Note/Pause</td>
<td>Pause (no sound!)</td>
</tr>
<tr>
<td>Down</td>
<td>Off</td>
</tr>
<tr>
<td>Up</td>
<td>Off</td>
</tr>
<tr>
<td>Accent</td>
<td>Off</td>
</tr>
<tr>
<td>Slide</td>
<td>Off</td>
</tr>
</tbody>
</table>

**Pitch buttons**

These are used for specifying a Pitch for the selected step.
Down

This transposes the pitch of the selected step down, one octave.

Up

This transposes the pitch of the selected step up, one octave.
You can activate both Up and Down at the same time, if you wish. However, this is the same as activating none of them.

Accent (button)

This activates Accent for the selected step. For more information on what effect Accent has, see the Accent knob, page 156.

Slide

When this is activated, the selected step will be tied to the next (legato – no “retriggering”) and the pitch will slide continuously to that of the next step. For a more thorough explanation of how Slide works, see page 45.

Note/Pause button and indicators

This is used for specifying whether the selected step will sound or not.

Back

This takes you to the previous step in the Pattern. When you are at the first step, this takes you to the last step in the Pattern.

Step

This takes you to the next step in the Pattern. When you are at the last step, this takes you to the first step in the Pattern.

Step display

This indicates which step you are currently at, when entering notes. This changes when you press Next or Back or when you specify pitches in Pitch mode. It does not move on playback.
Waveform

This allows you to select between two waveforms for the synth oscillator:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="symbol.png" alt="Sawtooth" /></td>
<td>Sawtooth</td>
<td>This is a full and rich waveform where all harmonics are included.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Square" /></td>
<td>Square</td>
<td>This waveform only contains odd harmonics, which gives the sound a more “hollow” quality.</td>
</tr>
</tbody>
</table>

Tune

This allows you to set the tuning of the synthesizer. The range is two octaves in steps of one semitone.

Cutoff

This sets the basic cutoff frequency for the filter. The higher this setting, the brighter the sound. This is the basic filter setting. The final filter curve is determined by other settings, like Env. Mod, Decay and Accent.

For a more thorough description of the filter section, see page 48.

Reso

This also determines the character of the sound. The technical explanation is that it routes the output of the filter back into the input, in a “feedback” loop. This knob determines the amount of feedback. The higher the sound, the more of the typical hollow character you will get.

Env. Mod

This determines the amount of effect the filter envelope has on the filter setting.

- In its lowest position, the envelope has little effect on the sound.
- At higher values, the envelope makes the filter open further, that is the sound will be brighter.

Decay

The higher this setting, the longer it will take for the notes to decay.
Accent (knob)

This determines the amount of change to those steps that have the Accent switch activated.

- Steps with Accent will be perceived as shorter, louder and with a slightly different tonal character than other steps, when this setting is increased.
- When this knob is all the way down, steps with Accent will only be shorter.

For more information on the relationship between Accent and other parameters, see page 49.
Mixers

On/Off switch

This turns the output of the relevant section on/off.

Meter

This shows the output level from the section. Use this as a diagnostic tool if the level from a section is very low or if you don’t hear it at all. If this meter shows any indication at all, the section is playing.

Volume fader

This determines the level of the output from the relevant section. Use this to balance the relative levels between the synths and the rhythm section.

- Please note that as you increase levels you might run into distortion. To compensate for this, use the Master fader. See page 24 for more details about levels and “clipping”.

Pan

This determines the section’s position in the stereo image.

The range of the parameter is fully left (L), through centre (“twelve o’clock”) to fully right (R).

Delay

This determines the amount of delay (echo) to be added to this section. The final amount of delay is determined by a number of other settings in the actual Delay section. See page 69 for details on how to use the delay.
Dist

This is a switch which routes the output of this section through the Distortion (Dist) unit. For more information on how to use the Distortion effect, see page 59.

PCF

This is a switch that routes the output of this section through the PCF (Pattern Controlled Filter) unit.

Comp

This is a switch which routes the output of this section through the Compressor (Comp) unit. For more information on how to use the Compressor effect, see page 67.
The PCF effect is basically a filter with an envelope, just like there are filters with envelopes in the synth sections. You route the output of one of the sections through the PCF and thereby shape the tonal character of the sound.

The main difference between the PCF and the synth filters is that this filter is “pattern controlled”. There are a number of preset patterns that allow the filter to “superimpose” pumping effects, slow sweeps and rhythmic phrasing onto the sound.

**On/Off switch**

This turns the PCF effect on/off. When turned off, sound will pass through the effect without any filtering. This button is very similar to a Bypass button on a regular effect unit.

**Meter**

This shows the input level to the PCF. Use this as a diagnostic tool if you are unsure whether any signal appears at the input of the PCF section. If this meter shows any indication at all, some signal is coming in.

**Pattern**

There are a large number of preset patterns that provide various rhythmic effects. They do this by controlling the following envelope parameters:

- **Retriggering.**
  This is the most basic type of control. For example, in Pattern 0 the envelope is retriggered (restarted) at each whole note, in pattern 1 on each half note etc.

- **Dynamic and Attack control.**
  In many of the Patterns, the envelope is triggered with different dynamics on different “beats”. Some “beats” also have a slightly different attack.

The Patterns are preset, they can not be changed. Their length varies, most are 16 or 32 steps (one or two bars), but some have been created in odd time signatures.

See page 205 for a list of all Patterns.
**Mode (BP/LP)**

This switches the filter between its two major modes, lowpass and bandpass.

- The lowpass filter (LP) is similar to the one used in the synth sections in ReBirth. It lets all harmonics below a certain frequency (the cutoff frequency) pass through.
- The bandpass filter (BP) only lets frequencies within a certain band (a range of frequencies) pass through.

**Freq (Frequency)**

This is the main frequency range the filter should operate in.

The Freq parameter is related to the Amount (Amt) parameter: If the Amount slider is set to zero, there will be no pattern effect at all. The filter can then be used as a fixed “tone control” by adjusting the Freq and Q parameters. If the Freq slider is all the way up, the Amt slider has no effect since the filter is already fully open.

**Q**

This is the same as the “Reso” control in the synth sections. Technically it routes the sound at the output of the filter back to the input, in a feedback loop. Soundwise it gives the sound a more hollow, pronounced character.

- Be careful when combining large Q values in the PCF with large Reso values in a synth, since this might lead to overloading the output of the PCF, causing distortion.

**Amt (Amount)**

This control determines the amount of effect the envelope has on the filter. For any Pattern effect at all, this must be set to some value above zero.

**Decay**

This adjusts the length of the envelope decay. This has a significant effect on the “feel” of the Pattern.

- At low values there will be a clear pumping effect.
- When the Decay is raised, the pattern effect will be “smeared”. This can be used to good effect with Patterns 12 to 17 for smooth “LFO” effects.
- At very high values, the envelope will not be given a chance to decay very much until it is retriggered, giving a “stepping” effect (similar to the old synth effect “sample and hold”). This is most noticeable on patterns with dynamics (12 and above).
Delay

Delay is an effect which adds repeats or echo to the sound.
This is a “send effect”, which means that any and all sections can be routed to this effect, by variable amounts.
For more detailed information on how to use the Delay effect, please see page 69.

On/Off switch

This turns the Delay effect on/off. When turned off, any sound will pass through the effect without any delay added. This button is very similar to a Bypass button on a regular effect unit.

Meter

This shows the input level to the Delay. Use this as a diagnostic tool if you are unsure whether any signal appears at the input of the Delay section. If this meter shows any indication at all, some signal is coming in.

Step and Straight/Triplet switch

These two controls determine the length of the Delay.
- If the Straight/Triplet switch is set to straight 16th notes, Steps is used for setting the length in 16th note steps.
- If the Straight/Triplet switch is set to triplets, Steps is used for setting the length in steps of 8th note triplets.

F.Back

To get more than one echo, you can route the output of the Delay unit back to its input. This is often referred to as Feedback. The F.Back knob on the ReBirth delay does exactly this.

- Please be careful when raising this knob to high values. At full value, the echo repeats infinitely. While this can be used to good effect, it is something to be aware of.
Pan

This determines the position of the delay output, in the stereo image.
The range of the parameter is fully left (L), through centre (“twelve o'clock”) to fully right (R).
Dist (Distortion)

Distortion is an effect which makes the sound “dirtier”. One section at a time can be routed to the Distortion effect, using the Dist switches in the mixers.

For more detailed information on how to use the Distortion effect, please see page 59.

On/Off switch

This turns the Distortion effect on/off. When the Distortion is turned off, any sound will pass through the effect without being distorted. This button is very similar to a Bypass button on a regular effect unit.

Meter

This shows the input level to the dist. Use this as a diagnostic tool if you are unsure whether any signal appears at the input of the Dist section. If this meter shows any indication at all, some signal is coming in.

Amount

This determines the amount of distortion. The higher the setting, the dirtier the sound.
Compressor

A compressor, evens out levels to make the sound “tighter”. At high settings it can introduce a “pumping” effect. The compressor in ReBirth RB-338 is an insert effect. This means it will be inserted into the signal, just after the output of one of the sections or on the master out. Only one section or the master output can use the compressor.

On/Off switch

This turns the Compressor on/off. When the Compression is turned off, any sound will pass through the effect without being compressed. This button is very similar to a Bypass button on a regular effect unit.

Meter

This shows the input level to the compressor. Use this as a diagnostic tool if you are unsure whether any signal appears at the input of the Comp section. If this meter shows any indication at all, some signal is coming in.

Threshold

This a setting for which signals should be affected. As the name implies, only levels above the one you specify here (the Threshold) will be affected. Levels below this value will pass through unaffected.

Ratio

This is the amount of level reduction, that is, the resulting reduction in level difference. The higher the setting, the more drastic the effect.

Level Reduction meter

This display shows you how much the level of the signal is reduced at any given time. The “0” setting (in the middle) means no change, whereas an indication to the left implies a level reduction.
**Master**

The Master level and faders.

**Meters**

These show the Output level from the entire program. Adjust this with the fader, so that the meters show as high levels as possible during loud passages, without ever hitting the red top segment. For more information see page 24.

**Fader**

This is used for adjusting the overall output level from the program. Use this together with the meters to retain maximum level without clipping.

**Comp**

When this is activated, the master signal passes through the Compressor effect unit (in stereo).
Menus and Dialogs

Apple menu (Mac only)

About ReBirth RB-338...
This menu item opens up a dialog that informs you about the version of the program and the people behind it.

File menu

New
This creates a new ReBirth panel. Use this when you want to start on a Song from scratch. The settings and Patterns in this window are determined by the Preference setting “Pattern and knob settings for new songs”, see page 136.

Open...
This menu item is used for opening saved Song documents. It brings up a regular file dialog where you can locate a Song file on disk and open it.

Close
This menu item closes the currently active window. If it is a document window, and you have made any changes since you saved it last (or not saved the document at all) you will be asked whether you want to save those changes before closing the window.

Save
This menu item allows you to save any changes you have made to the currently active document (the one you’re working on, or playing). If you have not yet saved the document, selecting this is the same as selecting Save As, see below.

Save As...
This is used for saving a document the first time, or to save an existing document under a new name or at a new location. A regular file dialog allows you to specify a name and location for the file.

Windows users might want to note that ReBirth RB-338 songs have the document extension “.rbs”.

- 166 -
**Song Information**

This allows you to enter some information about your Song. This is useful for example if you intend to distribute your files via Internet and want to make people aware of who the creator is.

<table>
<thead>
<tr>
<th>Item:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text in Window Title</td>
<td>This text always appears in the Song window title.</td>
</tr>
<tr>
<td>More Information</td>
<td>This text will appear in the Information dialog and in the “splash screen” that appears when you load the Song (if Show Information... is activated, see below)</td>
</tr>
<tr>
<td>Creator's Web Page</td>
<td>Same as above.</td>
</tr>
<tr>
<td>Show information on Song open</td>
<td>If this is activated, “More Information” and “Creator's Web Page” will appear in a window when the Song opens.</td>
</tr>
<tr>
<td>Browser</td>
<td>When you click this, you will be taken to the web page specified in the dialog.</td>
</tr>
</tbody>
</table>

**Export Loop As AIFF/Wave File (Mac)/Export Loop As Audio File (PC)**

This menu item allows you to export the current Song (or a section of it) as an audio file. This file can later be played back from any program that can read audio files in the specified format.

Only the area inside the Loop is saved. This allows you to specify any section of the Song to be saved, down to a single measure.

**Run Benchmark Test**

This function allows you to test whether your computer is fast enough to run Re-Birth RB-338 successfully.

1. **Quit all other programs.**
   This will ensure that the results are as accurate as possible.

2. **Select “Run Benchmark Test” from the File menu and press [Return] to start the test.**

3. **Wait while the test finishes (this may take a couple of minutes).**
   - A score of 100 or more means that the computer is enable to run ReBirth.
   - A higher number means that there is processing power left for other programs. For example, a score of 500 indicates that this computer has five times the processing power required to run ReBirth.
   - A score of less than 100 means that this computer is not able to run Re-Birth properly. You might still be able to use for example just one synth or one drum machine, but not all sections and effects at once.
Recent Documents
In this section of the menu you will find up to four of your most recently opened Song documents. Selecting one of these opens it.

Quit
This will quit the program. If any documents have unsaved changes you will be asked if you want to save those changes before quitting.
Edit menu (Pattern items)

About the “focus”
All the Pattern operations below act on the Pattern that currently has the “focus”. This means the Pattern with the focus bar. See page 22 for details.

Cut Pattern
This function is mainly used together with Paste to move Patterns between Pattern locations.
It will copy the contents of the Pattern into the Clipboard, from where it can later be Pasted in to another Pattern location. In addition the Pattern will be Cleared, see below.

Copy Pattern
This function is used together with Paste to copy Patterns between Pattern locations. It will copy the contents of the Pattern into the Clipboard, from where it can later be Pasted in to another Pattern location.

Paste Pattern
This will paste the Pattern currently on the Clipboard, into the selected Pattern location. The Pasted Pattern will replace whatever was previously at that location.

Clear Pattern
This empties the selected Pattern.
For synth Patterns this means that all steps are set as follows:

<table>
<thead>
<tr>
<th>Function</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch</td>
<td>Low C</td>
</tr>
<tr>
<td>Note/Pause</td>
<td>Pause (no sound!)</td>
</tr>
<tr>
<td>Down</td>
<td>Off</td>
</tr>
<tr>
<td>Up</td>
<td>Off</td>
</tr>
<tr>
<td>Accent</td>
<td>Off</td>
</tr>
<tr>
<td>Slide</td>
<td>Off</td>
</tr>
</tbody>
</table>

Shift Pattern/Drum Left/Right
This shifts the contents of the Pattern one sixteenth note in either direction. For example, if you shift right, what was on the first step will be on the second, what was on the second will be on the third, and so on. In the same example, whatever was on the last step will be on the first.
• When the focus is on a synth section, only Shift Pattern Left/Right is available. This shifts the entire content of the Pattern one step in the selected direction.

• When the focus is on a rhythm section, you have the option of shifting the whole Pattern or just the selected drum sound.

Random Pattern/Pitches/Accents etc./Drum
This creates random synth and drum Patterns. This can be used as an inspirational tool (create a Pattern and modify the parts you don’t like) or for completely computer generated music.

The exact options available depend on the focus (synth section or rhythm section). See page 53.

Alter Pattern/Pitches/Accents etc./Drum
This randomly shuffles the synth and rhythm Patterns, using the already programmed material as a basis for a new Pattern. See page 54.

Transpose...

The Transpose dialog (Macintosh version).

This only applies to synth Patterns. It allows you to transpose the Pattern to another key. See page 54.

Vintage ReBirth Synth Sound
This switch allows you to select between two types of synth envelope decay settings:

• When this switch is turned on, the decay is shorter. This corresponds to the way the envelope always behaved in ReBirth RB-338 version 1.5 and earlier.

• When this switch is set to off, the decay is slightly longer. This is the standard setting in ReBirth 2.0 and later.

When you create new Songs, this switch is by default turned off. However, when you open Songs saved in ReBirth RB-338 version 1.5 or earlier, this switch is automatically activated, so that the Song plays back with the same sound as when it was created.
Preferences...

This dialog contains a number of overall settings and options for the program:

The Windows Preferences dialog.

The Mac Preferences dialog.
<table>
<thead>
<tr>
<th>Control:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Card Driver (PC only)</td>
<td>Use this to select one of the card drivers in your system. See page 10 for more details about the available options.</td>
</tr>
<tr>
<td>Playback Performance slider (PC only)</td>
<td>This is used for setting the size of the buffers associated with audio playback. The smaller this number, the faster ReBirth will react to changes on the front panel. On the other hand, smaller settings require a faster audio card driver and computer. Again see the online help and page 184 for details.</td>
</tr>
<tr>
<td>Buffer Size</td>
<td>This indicates the size of the audio playback buffer, as adjusted with the slider.</td>
</tr>
<tr>
<td>Underruns (PC only)</td>
<td>This shows the number of instances that the playback buffers have been “too small” with the current setting. If you get underruns, you need to raise the size of the buffer.</td>
</tr>
<tr>
<td>Multitasking friendly/Crackle safe (Macintosh only)</td>
<td>This allows you to select between two modes for creating audio on your computer. See page 11 for details.</td>
</tr>
<tr>
<td>Buffer size (Macintosh only)</td>
<td>This should be set to the lowest possible value that provides glitch free audio playback.</td>
</tr>
<tr>
<td>MIDI Input</td>
<td>This is used for selecting a MIDI Input for synchronization and remote control, see page 112 and page 126.</td>
</tr>
<tr>
<td>MIDI Clock Sync Enable</td>
<td>This is a double up of the setting “Sync to MIDI Clock”, on the Options menu, See page 112.</td>
</tr>
<tr>
<td>Adjust Sync</td>
<td>This setting is used for trimming the synchronization, so that ReBirth RB-338 “locks in” with the master. See page 117.</td>
</tr>
<tr>
<td>Remote MIDI Control</td>
<td>This is used for turning Remote MIDI Control on/off. When this is activated, ReBirth can be controlled via MIDI as set up in this dialog (and possibly also in the Quick Mapping dialog).</td>
</tr>
<tr>
<td>MIDI Channel</td>
<td>This is used for specifying a MIDI channel for remote control messages.</td>
</tr>
<tr>
<td>Use ReBirth’s Standard Mapping</td>
<td>When this is selected, practically all controls on the front panel can be accessed via MIDI. However, the “mapping” between MIDI messages and front panel control is fixed, you can not modify it. See page 130 for details.</td>
</tr>
<tr>
<td>Control:</td>
<td>Description:</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use Quick Mapping</td>
<td>When this is activated, only a selection of front panel controls can be accessed via MIDI Controller messages. However, by clicking the Edit button you can set up exactly which, and how.</td>
</tr>
<tr>
<td>Edit</td>
<td>Clicking this button opens the Quick Setup dialog.</td>
</tr>
<tr>
<td>Patterns and knob settings for new Songs</td>
<td>The two options here are used for setting whether new Songs should have default Patterns and knob settings or if they should “inherit” Patterns and settings from the current Song. This is used for “customizing” the contents of New Songs. See page 136.</td>
</tr>
<tr>
<td>Play Mod Startup Sound</td>
<td>When this is activated, and you select a Mod, it will play its startup Sound.</td>
</tr>
</tbody>
</table>
Quick Setup

This dialog is used for “mapping” incoming MIDI Controller messages to controls on the ReBirth front panel, in Quick Setup mode.

Manual setup

1. Select a function you want to use, from the set of pop-up menus.

2. Click in the field to the right of the pop-up and type in the number of the controller message you want to use.

Using Learn

1. Select a function that you want to use, from the set of pop-up menus.

2. Move the controller you want to use for this function.
   The field at the bottom of the dialog shows the number for this controller. If it doesn’t, this is an indication that your MIDI connection is not set up correctly.

3. Click the Learn button associated with the function you want to use.
   This controller number will then appear in the corresponding value field.
<table>
<thead>
<tr>
<th>Control:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReBirth knob pop-ups</td>
<td>Use this to select a knob on the ReBirth front panel that you want to control via MIDI.</td>
</tr>
<tr>
<td>MIDI Control ID fields</td>
<td>Use this to type in the MIDI Controller number you want to use for controlling the knob selected in the pop-up.</td>
</tr>
<tr>
<td>Learn buttons</td>
<td>When you click a Learn button, the last received MIDI Controller number (as displayed in the “Received MIDI Control ID to Learn” field) is automatically entered in the box just to the left. Use this as quick way of mapping controls on your synth, fader panel or similar, to knobs on the ReBirth front panel.</td>
</tr>
<tr>
<td>Received MIDI Control ID to Learn</td>
<td>This field shows the number of the last received MIDI Controller message. Use this as verification of incoming MIDI and in conjunction with the Learn buttons.</td>
</tr>
</tbody>
</table>
Edit menu (Song mode)

The contents of the Edit menu varies with the “mode” of the program. Below follows the items available when you are in Song mode:

**Undo**

This is not used in ReBirth RB-338.

**Cut Loop**

This menu item removes measures from the Song and puts them in the Clipboard. More specifically, Cut removes all measures inside the Loop. This can be used for two purposes:

- **When you want to make the Song shorter.**
- **Together with Paste, to move measures from one section of the Song to another.**

**Copy Loop**

This menu item copies all the measures inside the Loop and puts them in the Clipboard from where they can be pasted in.

**Paste at Song Position**

Adds the Cut/Copied measures to the Song, beginning at the Song Position. The measures are *inserted* into the Song, so that is *lengthened*.

If you for example have Cut four bars and use “Paste at Song Position”, at Song Position 13, you will get four new measures between measure 13 and 16. These contain the pasted material. Whatever was at bar 13 *before* the operation is now at bar 17.

**Paste Replace at Song Position**

Similar to Paste at Song Position, but when this option is selected, the Pasted material *overwrites* the material currently in those measures.

Again, if you Cut four bars, and use “Paste Replace at Song Position”, at Song Position 13, the contents of measures 13, 14, 15 and 16 will be replaced by the measures on the Clipboard.

**Initialize Loop from Pattern Mode**

This “initializes” the measures inside the Loop. This can be a convenient way to use the settings currently in Pattern mode, as initial settings for some measures in the Song you are building.

*Please note that this command clears all the Pattern changes and knob recordings currently inside the Loop!*
When you use “Initialize Loop from Pattern Mode”, all measures inside the Loop are filled with the settings currently made in Pattern mode. That is, the Patterns selected in Pattern mode will be used, as well as all knob and other control settings.

**Initialize Song from Pattern mode**

This is used for initializing the Song, to start over from scratch. It also allows you to use the settings currently in Pattern mode as your initial settings for the Song you are about to build.

- Please note that this command clears all the Pattern changes and knob recordings currently in the Song!

When you use “Initialize Song from Pattern Mode”, all measures in the Song are filled with the settings currently made in Pattern mode. That is, the three Patterns selected in Pattern mode will be used, as well as all knob and other control settings.

**Copy touched controls to Loop/Song**

This menu item allows you to insert “static” settings for any control, for a number of bars. For example, you might want to turn on the Delay and make sure that it is turned on for the whole Song, or you might want to adjust some level control, for a specific number of bars.

A full explanation of this function can be found on page 83.

**Vintage ReBirth Synth Sound**

See page 170.

**Preferences...**

See page 171.
Mods Menu

Mod items

The first items on this list correspond to the Mods installed into your Mods folder. Selecting one applies it to the current Song. See page 89 for more information.

Select Mod...

This opens a dialog with options related to Mods:

<table>
<thead>
<tr>
<th>Option:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mod pop-up</td>
<td>This list the Mod files found in your Mod folder in your ReBirth folder. Selecting one and clicking OK, applies it to the active Song.</td>
</tr>
<tr>
<td>Mod Splash Screen</td>
<td>An “About” screen for the Mod.</td>
</tr>
<tr>
<td>Mod Information text</td>
<td>Text added by the Mod creator that tells you more about this particular Mod.</td>
</tr>
<tr>
<td>Web Site link</td>
<td>An optional link to the Mod creator's web site. On this page you should find more information about the Mod, and the author. To go to this web page, click the Browser button.</td>
</tr>
<tr>
<td>OK</td>
<td>This closes the dialog and applies the Mod to the active Song document.</td>
</tr>
<tr>
<td>Cancel</td>
<td>This closes the dialog without making any changes.</td>
</tr>
<tr>
<td>Demo Song</td>
<td>This plays a demo Song that should give you a hint as to what kind of sounds the Mod provides.</td>
</tr>
<tr>
<td>Browser</td>
<td>This launches your web browser and takes you to the web site specified for the Mod. See page 180 for details on the web browser mechanism.</td>
</tr>
</tbody>
</table>

Scan for New Mods

This menu item “refreshes” the list of Mods on the Mods menu. If you have copied a new Mod to the Mods folder since you last launched ReBirth, this command adds this Mod to the menu.
Options menu

Sync to MIDI Clock
When this is activated, ReBirth RB-338 will synchronize its playback to incoming MIDI Clock.

When synchronized to MIDI Clock, the tempo is determined by the other device or application – the tempo on the ReBirth transport bar is of no relevance.

You do not need to activate Play in ReBirth. As soon as it senses that the other device/application starts, it will start automatically.

To determine which MIDI source to synchronize to, open the Preferences dialog and change the Sync Input setting.

For more information about external sync, see page 112.

Program Synth from Keyboard
When this is activated, the computer keyboard is used for programming the synthesizer that currently has the focus (see page 22 for more info about focus). To learn how to program the synthesizer from the keyboard, see page 43.

Select Patterns from Keyboard
When this is activated, the computer keyboard is used for selecting Patterns. For more information see page 20 and page 224.

Windows menu

Cascade (Windows only)
This moves and resizes the open Song documents, so that they are arranged in an overlapping pattern

Resize Application Window to Documents
This changes the size of the application window so that it exactly fits the document windows.

Stay on Top (Windows only)
When this is activated, the ReBirth window will always stay on top of other program’s windows.

Window List
This lists all the open Song documents. Selecting one makes it the active window.
Contacts/Help menu

Help... (Windows only)
This menu item open up the Topic window for the Windows on-line help system.

About the Internet menu alternatives
Regardless of which of the four Internet options you select, you will be connected to the Internet using your preferred browser (on the PC this happens directly, on the Macintosh you have to select a browser in a dialog). The browser will then take you to the page specified in the dialog.
If you prefer, you can of course note down the web address in the dialog and connect manually instead.

Go to Propellerhead's Homepage...
This take you to the main entrance on the Propellerheads web site.

Go to Steinberg's Home Page...
If you are interested in more info from ReBirth’s music retailer distributor, use this option.

Download ReBirth Songs...
This takes you to our archives of song files that you can download and use, even with the demo version. You can also contribute with your own creations!

Download ReBirth Mods...
This takes you to Mod files archives with the latest offerings in free Mod files!

ReBirth Tech Info and Support...
If you have a problem or a technical question, this is the place to go!

Order ReBirth Now...
This allows you to purchase your own personal copy of this exquisite application!

About ReBirth RB-338... (Windows only)
This menu item opens up a dialog that informs you about the version of the program and the people behind it.
Appendix A

About Audio on Computers
General Information

Audio Quality

The general audio quality in a computer based synthesizer system depends on two things:

- **The quality of the software calculating the audio.**
  In our case, this is the ReBirth DSP (Digital Signal Processing) code. And what can we say? We have invested all our expertise and an enormous amount of time to make ReBirth RB-338 sound as good as possible. All calculations are made at the highest possible resolution throughout the signal chain. The 44.1kHz sampling frequency is maintained at all times. A number of digital audio techniques are implemented that reduce the risk of “aliasing”, background noise, unwanted distortion and “zipper noise”. OK, we’ll say it straight out: ReBirth sounds awesome.

- **The quality of the hardware playing back the sound.**
  In a PC this is the sound card. In the Mac it is the built in audio circuitry or any audio card you have installed. Don’t be fooled by the “16 bit, 44.1kHz, CD quality” tags. How good some audio hardware actually sounds depends on a number of things, its frequency range and frequency response curve, the signal to noise ratio, the distortion under various circumstances, etc. Furthermore, some designs are more prone to disturbance from the other electronics in the computer, than other. Such disturbance might add hum or high pitched noise to the signal.

As you probably understand by now, this is a big subject and there’s no way we can help you find the right solution in this manual. There are a number of text books and magazines covering this subject and any music dealer specializing in computers will happily help you out. The only advice we can give you is that if you are serious about sound, choose your audio hardware carefully!

- PC users, please read the paragraphs about DirectX on page 184, it might have an impact on your choice of audio hardware.
About Latency

On any personal computer system, there is a delay between the moment you “ask” the hardware to play a sound and when it actually does it. This delay is referred to as the “latency” of the design. This imposes a problem for any system where you want real time user input to affect the sound.

What is acceptable?

As a comparison, consider a hardware synthesizer. Here, you normally wouldn’t accept a latency (between key down and sound out) of more than 3 to 7 ms (milliseconds – thousands of a second), if the instrument is to be used “professionally”.

On a regular PC or Mac, the latency is anywhere from 25 to 300ms! This is just an effect of the fact that a computer was built for many purposes, not just playing back audio. For multimedia and games, this is perfectly acceptable, but for playing a musical instrument it is not!

For this reason, you can not play the sounds in ReBirth RB-338 via MIDI. It would feel just awful.

ReBirth’s built in sequencer is not affected by latency!

However, when the sound is played back via a built in sequencer, such as in ReBirth RB-338, the timing between notes is perfect! Once playback of a ReBirth Pattern or Song is up and running, latency isn’t a consideration at all. The computer clocks the audio between the steps and does this with perfect quartz accuracy! The timing is immaculate!

Still, latency rears it ugly head in another part of the program:

• **When you move controls on the front panel, the time it actually takes before these movements affect the sound depends on the latency.**

• **The timing accuracy of the meters on the front panel is determined by latency.**

For these two reasons, ReBirth has a buffer size setting in the Preferences dialog. This allows you to minimize the latency as much as possible. How much you will be able to reduce the buffer sizes depends on your sound driver and your computer. The faster it is, the smaller the buffers required.

Reducing latency

Having said this, there are general methods for reducing latency. The problem is that most of them are based on non-standard solutions that require special hardware to be installed in your system. For a software developer they also impose problems, since special routines have to be written for each hardware solution.

On the Macintosh, it is the Sound Manager routines (part of the Mac OS) and the audio hardware in the computer that are responsible for the latency.

On the PC, it is the Windows routines and the audio card that introduce latencies. However, you do have some control over this via the choice of using MME or DirectX drivers for your audio card, see below.
PC Specific Information

About DirectX, MME and the Sound Buffer setting

There are two ways for Windows to access an audio card:

Via an MME (MultiMedia Extensions) driver

This system has been around since Windows 3.0, and it is this type of driver that is normally installed in the Control Panel and via Plug’n’Play. Most regular sound playback (like when Windows goes “bing” on startup) happens via MME.

• Practically all cards come with an MME driver. If your card appears in the System part of the Control Panel, you have an MME driver installed.
• Using a card via an MME driver gives you relatively long latency (see page 183), especially under Windows 95.
• Only one program at a time can use a card accessed via MME.
• If you use MME, ReBirth RB-338 can play in the background.
• The latency is around 160 milliseconds when using MME under Windows 95.

Via a DirectX driver

DirectX is a later system developed by Microsoft to provide developers with more efficient routines to access audio. As of this writing, DirectX version 2 is included with Windows 95 and Windows NT. However, version 3 was the latest and can be obtained from Microsoft. However, this does not mean you should always use DirectX on your system, read on.

• As of this writing, not all cards come with DirectX drivers. Drivers for some cards are included with DirectX itself.
• Using a card via a DirectX driver gives you a pretty short latency, between 40 and 90 milliseconds under Windows 95 (see page 183).
• If you use DirectX 3 or later, all programs that access the card via DirectX and make use of the DirectX “secondary buffer” feature can use it at the same time and ReBirth RB-338 can play in the background. These are the only two differences between DirectX 2 and 3 that concern Re-Birth.
Questions and Answers about DirectX

This text is by no means a complete guide to DirectX! For more information, please point your web browser to: http://www.microsoft.com/DirectX/default.asp (the “DirectX Pavilion” at Microsoft).

Should I access my card via DirectX or MME?

ReBirth RB-338 can use DirectX or MME, the program will work fine with either system. However, if, and only if, you have a card for which there is a real DirectX driver, and this driver is installed correctly, you should use DirectX. This will allow you to reduce the latency (see page 183) which makes the program more responsive. It will not make it sound better or give it any other additional features, but twisting knobs and moving controls will “feel better”.

How do I know if I have DirectX installed at all on my computer?
1. Launch ReBirth.

2. Pull down the Edit menu and select Preferences.

3. Pull down the Audio Card Driver menu in the dialog that appears and select the last driver on the list.
   Check the text just below the pop-up. If it says “Driver Type: Direct X”, then you have DirectX installed.

How do I know if I have a real driver (as opposed to an “emulated driver”) installed for my card?

Select the various alternatives on the Audio Card Driver menu described above, one at a time. The text that appears below tells you if the driver is “emulated”.

If you have a DirectX driver not indicated as emulated, use it! On the other hand, if you only have emulated DirectX drivers, don’t use DirectX. Instead use one of the MME alternatives on the menu!

How do I know which version of DirectX I have installed?

You can’t, at least not really. However, you can tell if you have version 3 or later:

1. Start ReBirth so that it’s playing.

2. Switch over to another program, for example the Desktop.
   If ReBirth keeps playing, you have DirectX 3 or later installed. If it stops you have an earlier version.
If I don’t have DirectX installed, should I install it?

There are two situations where we recommend you to install DirectX, if you don’t have it already:

• If the card vendor can supply you with a DirectX driver.

• If your card is one of the few for which a driver is included with Microsoft’s DirectX package.

The list of included drivers changes constantly. Again, please visit the “DirectX Pavilion” at the Microsoft web pages.

If I have DirectX version 2, should I install a later version?

The major difference between version 2 and later is that the later versions allow several applications to share one audio card, whereas version 2 does not.

If you’re the type that always want to keep your computer system up to date with the latest version of any software, install a later version. If you’re the type that rather stays with what you have, because you know and understand it, don’t.

Where do I get hold of DirectX?

Version 5 of DirectX is included on the ReBirth CD. For later versions, please visit the “DirectX Pavilion” at the Microsoft web pages, http://www.microsoft.com/DirectX/default.asp.

Where do I get hold of a “certified” DirectX driver for my audio card?

There are two ways:

• A driver might be included with DirectX.

• Contact the card vendor or the dealer where you purchased the audio card and ask for a DirectX driver.
Cyrix vs. Intel

As of this writing, the two major processor manufacturers are Intel and Cyrix. Both have their advantages and disadvantages, but actually, for ReBirth RB-338, an Intel processor is the best choice. Why?

This has to do with floating point calculations (counting with decimal numbers rather than with non-decimal numbers, integers.). Using floating point arithmetics ensures high audio quality. You can get high audio quality on an integer system too, but floating point is effective and accurate when it is available.

Intel Pentium processors are much faster at floating point mathematics than Cyrix 586 and 686 chips. This means that much more of your computer’s processing power will be used up when running ReBirth RB-338 on a Cyrix processor than on an Intel. This has the following effects:

- **On a Cyrix processor you need to use larger buffer sizes (the buffer size is set in the Preferences dialog), to prevent the sound from “breaking up”**.
  Larger buffers makes the program less responsive to control changes, see page 183.

- **The updating of the graphics will be slower**.
  This can be noted when moving windows, pulling down menus etc.

- **Other programs running at the same time, will not perform as fast as they otherwise do**.

- Provided the buffering is OK, the speed of the processor has no effect on the sound quality. ReBirth RB-338 will sound just as good on an Intel processor as on a Cyrix or other brand!
Macintosh Specific Information

What the Sound Manager does/is

The Sound Manager is a set of software routines in the Mac OS. These routines take care of everything related to sound.

The Sound Manager is built into the system. If you have the latest version of Mac OS, you probably don’t need to install any special Sound Manager files. However, if you run an older OS version, you can install the Sound Manager included with ReBirth, or any even more recent version you can get hold of (for example from Apple’s Internet pages: www.apple.com).

One specific character of the Sound Manager is its ability to mix audio from several applications. This means that even when you run ReBirth, you can run other Sound Manager compatible applications at the same time, and they will all sound.

Latency and Mac OS 8.1

In Mac OS 8.1, Apple have reduced the size of their sound buffers, which means that latency has been cut in half. To take advantage of this, proceed as follows.

1. Open one of the demonstration songs.

2. Activate Playback.

3. Open the Preferences dialog, from the Edit menu.

4. Make sure the Multitasking friendly option is selected.

5. Locate the Buffer size pop-up.
   This allows you to adjust the audio buffer size.

6. Select the smallest buffer size.
   This will probably make the sound completely garbled.

7. Select the next larger buffer size.

8. Repeat with the next larger buffer size, until the sound is OK.
   You now have the smallest possible buffer setting that works on your system.

Mac Audio cards

Even though all Macintosh computers have built in sound, there are Mac audio cards which add capabilities to your system. Such capabilities can be additional in-and outputs, digital connections, better sound quality, etc.

- If you have an audio card for which there is a well written Sound Manager driver (a piece of software that allows the Sound Manager to play via the card) you can use the card with ReBirth RB-338.
• If you use the card with some special software (such as a hard disk recording system) that does not use the Sound Manager, you can still use that software and run ReBirth at the same time. ReBirth will use the built in sound connectors on your Macintosh and the other software will use the card.

Installing a Macintosh audio card for use with ReBirth

If you have an audio card for which there is a Sound Manager driver, you can use it with ReBirth RB-338. Proceed as follows.

1. Quit ReBirth if it’s running.

2. Install the card as described by the manufacturer.

3. Install the Sound Manager driver for the card, as described by the manufacturer.

4. Open the Monitors and Sound control panel.

5. Click on the Sound button.

6. Select the card from the list of audio outputs.

7. Set up the levels and sound quality options as desired.

8. Switch to the warnings display and click on the sounds to check that they now play back via the audio card.

9. Close the dialog.

10. Launch ReBirth.
    It will now play back via the audio card rather than via the computer's built in audio outputs.
Appendix B

Troubleshooting
Introduction

The intent of this chapter is to help you get as effective technical support as possible. Please read through the following before you contact technical support.

Where can I get Support?

This depends on where you bought the program:

- If you bought ReBirth RB-338 directly from Propellerhead Software, support is available via the Internet. See below for details.
- If you bought ReBirth from Steinberg Soft- & Hardware there are two ways to get support: via the Internet (see below) or by contacting your local distributor. If in doubt, examine your package for details on how to contact the distributor, or contact the dealer where you bought the program.

What you need to do before Contacting Tech Support

First of all, do you need help with some functionality in the program or do you suspect something doesn’t work as intended? Read through the following points:

If the Program isn’t Behaving as Expected

Is the problem really with ReBirth RB-338?

Technical support personnel can unfortunately not help you with general problems with your computer and peripherals. Furthermore, the operation manual and technical support facilities assume you have a basic understanding of how your computer works. If not, please go back and study the documentation that came with the computer and related equipment.

“It worked before...”

Often, when a program stops working it is because you have installed something new or changed your configuration in some way. If possible, revert to the old setup and check if things work then.

When you have done so, install the new components one at a time and check Re-Birth in between each one. This will help you pinpoint exactly what it is that causes the problem.

Do other programs behave normally?

Sometimes when you have problems with general things like audio playback, MIDI or file handling, it can help using other programs to perform similar operations. For example, if none of your programs can play back audio, the problem might be with the audio card or its installation, rather than with the programs.
Is everything installed properly? Did you really follow the installation instructions?

Installing hardware and software can be a daunting task. The instructions that come with the devices and program are there for a reason. Even if you consider yourself a seasoned expert, and even if the manufacturer boasts “Plug’n’Play” support, please read the instructions and ReadMe files, there might be something there you missed!

Is there a system conflict?

Sometimes, problems that appear to be related to a certain program or device are actually caused by something entirely different. Try the following:

• Disable any system extensions and additions not required for running ReBirth RB-338.
• Remove any background (“memory resident”) programs that you have installed.
• Quit all other programs.
• Try with a simple computer configuration.
• Un-install any special hardware that might interfere with your system.
• Now, run ReBirth RB-338 again and see if the problem persists.

If there is Something you don’t understand

Did you really read the manual thoroughly?

We have to say this: a lot of time and effort was put into providing as accurate and complete documentation for ReBirth RB-338 as possible. Chances are that the information you are looking for is somewhere in this manual:

• Use the Table Of Contents for finding overall procedures.
• Use the Index to find descriptions related to certain terminology.
• Use the Find feature to search for keywords.
• Read the ReadMe files included with the program. These often contain last minute notes and information about special situations.

Reduce the number of pitfalls

When you try to come to grips with a certain procedure or function, try it on something simple. Create some simple material that you can use as “workbench”. Disable all unrelated functions and features, hold your breath, and try again. Often, when minimizing unrelated options, it is easier to see what is going on within the program.
What you need to have at hand

So, you tried all of the above, and you still have problems. This is what you need to have at hand before you contact technical support:

**Serial number and registration information**
You must be prepared to state the program serial number of the program and other registration information. This is found somewhere on the package or on a separate registration card.

**Version number**
This is very important. The version of the program can be found in the About box.

**System details**
We will need to know many things about your system, like:

- Computer brand and specifications (RAM, hard disk, installed cards etc).
- Graphic and audio card details (driver versions etc.).
- Windows/Mac OS versions.
- Details about other programs you have installed.

**A description of the problem**
The importance of this can not be underestimated. A description like “it sometimes crashes” doesn’t do much good. We need to know:

- The exact series of events that cause a problem.
- Reports about exactly where in the series of events the problem occurs.
- Detailed information about any error messages or alert boxes that appear.

How to Contact Tech Support

**If you bought the program directly from Propellerhead Software**
- Pull down the Contacts/Help menu and select “Get Technical Support”, or...
- Fire up your Internet browser and point it to www.propellerheads.se/techsupport/.

**If you bought the program from Steinberg Soft- & Hardware**
- Contact your local distributor in the way they instruct you, or...
- Point your Internet browser to www.steinberg.net.
Appendix C

Standard MIDI Mapping Tables
The tables in this appendix show all the MIDI messages used in the Standard MIDI Mapping mode.

**Mixers**

This table shows you which MIDI Controller messages are used for the various controls in the Mixers

<table>
<thead>
<tr>
<th>Control</th>
<th>Synth 1:</th>
<th>Synth 2:</th>
<th>808 Rhythm:</th>
<th>909 Rhythm:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>11</td>
<td>14</td>
<td>17</td>
<td>20</td>
</tr>
<tr>
<td>Pan</td>
<td>12</td>
<td>15</td>
<td>18</td>
<td>21</td>
</tr>
<tr>
<td>Delay Amount</td>
<td>13</td>
<td>16</td>
<td>19</td>
<td>22</td>
</tr>
</tbody>
</table>

**Controls in the Synths**

This table shows you which MIDI Controller messages are used for the various controls in the two synth sections:

<table>
<thead>
<tr>
<th>Control</th>
<th>Synth 1:</th>
<th>Synth 2:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waveform</td>
<td>23</td>
<td>30</td>
</tr>
<tr>
<td>Tune</td>
<td>24</td>
<td>31</td>
</tr>
<tr>
<td>Cutoff</td>
<td>25</td>
<td>32</td>
</tr>
<tr>
<td>Reso</td>
<td>26</td>
<td>33</td>
</tr>
<tr>
<td>Env Mod</td>
<td>27</td>
<td>34</td>
</tr>
<tr>
<td>Decay</td>
<td>28</td>
<td>35</td>
</tr>
<tr>
<td>Accent</td>
<td>29</td>
<td>36</td>
</tr>
</tbody>
</table>
### Controls in the 808 Rhythm Section

This table shows which MIDI Controller messages are used for the various controls in the 808 rhythm section:

<table>
<thead>
<tr>
<th>Control:</th>
<th>MIDI Ctrl #:</th>
<th>Comment:</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC Level</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>BD Level</td>
<td>38</td>
<td></td>
</tr>
<tr>
<td>BD Tone</td>
<td>39</td>
<td></td>
</tr>
<tr>
<td>BD Decay</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>SD Level</td>
<td>41</td>
<td></td>
</tr>
<tr>
<td>SD Tone</td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>SD Snappy</td>
<td>43</td>
<td></td>
</tr>
<tr>
<td>LT Level</td>
<td>44</td>
<td></td>
</tr>
<tr>
<td>LT Tune</td>
<td>45</td>
<td></td>
</tr>
<tr>
<td>LT Switch</td>
<td>46</td>
<td>On/Off</td>
</tr>
<tr>
<td>MT Level</td>
<td>47</td>
<td></td>
</tr>
<tr>
<td>MT Tune</td>
<td>48</td>
<td></td>
</tr>
<tr>
<td>MT Switch</td>
<td>49</td>
<td>On/Off</td>
</tr>
<tr>
<td>HT Level</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>HT Tune</td>
<td>51</td>
<td></td>
</tr>
<tr>
<td>HT Switch</td>
<td>52</td>
<td>On/Off</td>
</tr>
<tr>
<td>RS Level</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>RS Switch</td>
<td>54</td>
<td>On/Off</td>
</tr>
<tr>
<td>CP Level</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>CP Switch</td>
<td>56</td>
<td>On/Off</td>
</tr>
<tr>
<td>CB Level</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>CY Level</td>
<td>58</td>
<td></td>
</tr>
<tr>
<td>CY Tone</td>
<td>59</td>
<td></td>
</tr>
<tr>
<td>CY Decay</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>OH Level</td>
<td>61</td>
<td></td>
</tr>
<tr>
<td>OH Decay</td>
<td>62</td>
<td></td>
</tr>
<tr>
<td>CH Level</td>
<td>63</td>
<td></td>
</tr>
<tr>
<td>Instrument Selection</td>
<td>64</td>
<td></td>
</tr>
</tbody>
</table>
### Controls in the 909 Rhythm Section

This table shows you which MIDI Controller messages are used for the various controls in the 909 rhythm section:

<table>
<thead>
<tr>
<th>Control:</th>
<th>MIDI Ctrl #:</th>
<th>Comment:</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC Level</td>
<td>65</td>
<td></td>
</tr>
<tr>
<td>BD Level</td>
<td>66</td>
<td></td>
</tr>
<tr>
<td>BD Tune</td>
<td>67</td>
<td></td>
</tr>
<tr>
<td>BD Attack</td>
<td>68</td>
<td></td>
</tr>
<tr>
<td>BD Decay</td>
<td>69</td>
<td></td>
</tr>
<tr>
<td>SD Level</td>
<td>70</td>
<td></td>
</tr>
<tr>
<td>SD Tune</td>
<td>71</td>
<td></td>
</tr>
<tr>
<td>SD Tone</td>
<td>72</td>
<td></td>
</tr>
<tr>
<td>SD Snappy</td>
<td>73</td>
<td></td>
</tr>
<tr>
<td>LT Level</td>
<td>74</td>
<td></td>
</tr>
<tr>
<td>LT Tune</td>
<td>75</td>
<td></td>
</tr>
<tr>
<td>LT Decay</td>
<td>76</td>
<td></td>
</tr>
<tr>
<td>MT Level</td>
<td>77</td>
<td></td>
</tr>
<tr>
<td>MT Tune</td>
<td>78</td>
<td></td>
</tr>
<tr>
<td>MT Decay</td>
<td>79</td>
<td></td>
</tr>
<tr>
<td>HT Level</td>
<td>80</td>
<td></td>
</tr>
<tr>
<td>HT Tune</td>
<td>81</td>
<td></td>
</tr>
<tr>
<td>HT Decay</td>
<td>82</td>
<td></td>
</tr>
<tr>
<td>Hi-hat Level (CH and OH)</td>
<td>83</td>
<td></td>
</tr>
<tr>
<td>RS Level</td>
<td>84</td>
<td></td>
</tr>
<tr>
<td>CP Level</td>
<td>85</td>
<td></td>
</tr>
<tr>
<td>CH Decay</td>
<td>86</td>
<td></td>
</tr>
<tr>
<td>OH Decay</td>
<td>87</td>
<td></td>
</tr>
<tr>
<td>CC Level</td>
<td>88</td>
<td></td>
</tr>
<tr>
<td>CC Tune</td>
<td>89</td>
<td></td>
</tr>
<tr>
<td>RC Level</td>
<td>90</td>
<td></td>
</tr>
<tr>
<td>RC Tune</td>
<td>91</td>
<td></td>
</tr>
<tr>
<td>Flam amount</td>
<td>92</td>
<td></td>
</tr>
<tr>
<td>Instrument Selection</td>
<td>93</td>
<td></td>
</tr>
</tbody>
</table>
### Master, Effects and Shuffle Sections

This table shows you which MIDI Controller messages are used for the various controls in the Master and effect sections:

<table>
<thead>
<tr>
<th>Section:</th>
<th>Control:</th>
<th>MIDI Ctrl. #:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master</td>
<td>Level</td>
<td>7</td>
</tr>
<tr>
<td>PCF</td>
<td>Pattern</td>
<td>94</td>
</tr>
<tr>
<td></td>
<td>Mode (LP/HP)</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Freq</td>
<td>96</td>
</tr>
<tr>
<td></td>
<td>Q</td>
<td>97</td>
</tr>
<tr>
<td></td>
<td>Amount</td>
<td>98</td>
</tr>
<tr>
<td></td>
<td>Decay</td>
<td>99</td>
</tr>
<tr>
<td>Delay</td>
<td>Steps</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Triplet mode</td>
<td>101</td>
</tr>
<tr>
<td></td>
<td>Pan</td>
<td>102</td>
</tr>
<tr>
<td></td>
<td>Feedback</td>
<td>103</td>
</tr>
<tr>
<td>Dist</td>
<td>Shape</td>
<td>104</td>
</tr>
<tr>
<td></td>
<td>Amount</td>
<td>105</td>
</tr>
<tr>
<td>Compressor</td>
<td>Ratio</td>
<td>106</td>
</tr>
<tr>
<td></td>
<td>Threshold</td>
<td>107</td>
</tr>
<tr>
<td>Shuffle</td>
<td>Shuffle Amount</td>
<td>108</td>
</tr>
</tbody>
</table>
Various Switches

This table shows which keys (MIDI Note messages) that can be used in all modes, for various functions on the panel:

<table>
<thead>
<tr>
<th>MIDI Key</th>
<th>Note Number</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>C6</td>
<td>96</td>
<td>Select Patterns from Keyboard</td>
</tr>
<tr>
<td>B5</td>
<td>95</td>
<td>Program Synths from Keyboard</td>
</tr>
<tr>
<td>A#5</td>
<td>94</td>
<td>Master – Comp On/Off</td>
</tr>
<tr>
<td>A5</td>
<td>93</td>
<td>909 – Comp On/Off</td>
</tr>
<tr>
<td>G#5</td>
<td>92</td>
<td>909 – PCF On/Off</td>
</tr>
<tr>
<td>G5</td>
<td>91</td>
<td>909 – Dist On/Off</td>
</tr>
<tr>
<td>F#5</td>
<td>90</td>
<td>909 – Mix On/Off</td>
</tr>
<tr>
<td>F5</td>
<td>89</td>
<td>808 – Comp On/Off</td>
</tr>
<tr>
<td>E5</td>
<td>88</td>
<td>808 – PCF On/Off</td>
</tr>
<tr>
<td>D#5</td>
<td>87</td>
<td>808 – Dist On/Off</td>
</tr>
<tr>
<td>D5</td>
<td>86</td>
<td>808 – Mix On/Off</td>
</tr>
<tr>
<td>C#5</td>
<td>85</td>
<td>Synth 2 – Comp On/Off</td>
</tr>
<tr>
<td>C5</td>
<td>84</td>
<td>Synth 2 – PCF On/Off</td>
</tr>
<tr>
<td>B4</td>
<td>83</td>
<td>Synth 2 – Dist On/Off</td>
</tr>
<tr>
<td>A#4</td>
<td>82</td>
<td>Synth 2 – Mix On/Off</td>
</tr>
<tr>
<td>A4</td>
<td>81</td>
<td>Synth 1 – Comp On/Off</td>
</tr>
<tr>
<td>G#4</td>
<td>80</td>
<td>Synth 1 – PCF On/Off</td>
</tr>
<tr>
<td>G4</td>
<td>79</td>
<td>Synth 1 – Dist On/Off</td>
</tr>
<tr>
<td>F#4</td>
<td>78</td>
<td>Synth 1 – Mix On/Off</td>
</tr>
<tr>
<td>F4</td>
<td>77</td>
<td>Comp – Enable</td>
</tr>
<tr>
<td>E4</td>
<td>76</td>
<td>Dist – Enable</td>
</tr>
<tr>
<td>D#4</td>
<td>75</td>
<td>Delay – Enable</td>
</tr>
<tr>
<td>D4</td>
<td>74</td>
<td>PCF – Enable</td>
</tr>
<tr>
<td>C#4</td>
<td>73</td>
<td>Transport – Bar +</td>
</tr>
<tr>
<td>C4</td>
<td>72</td>
<td>Transport – Bar –</td>
</tr>
<tr>
<td>B3</td>
<td>70</td>
<td>Transport – Record</td>
</tr>
<tr>
<td>A#3</td>
<td>71</td>
<td>Transport – Stop</td>
</tr>
<tr>
<td>A3</td>
<td>69</td>
<td>Transport – Play</td>
</tr>
<tr>
<td>G#3</td>
<td>68</td>
<td>Focus to 909 Rhythm</td>
</tr>
<tr>
<td>G3</td>
<td>67</td>
<td>Focus to 808 Rhythm</td>
</tr>
<tr>
<td>F#3</td>
<td>66</td>
<td>Focus to Synth 2</td>
</tr>
<tr>
<td>F3</td>
<td>65</td>
<td>Focus to Synth 1</td>
</tr>
<tr>
<td>E3</td>
<td>64</td>
<td>Select Pattern/Program Synth</td>
</tr>
</tbody>
</table>
Pattern Selection

When “Select Patterns from Keyboard” is activated on the Options menu, the following keys (MIDI Note numbers) can be used for select Patterns.

<table>
<thead>
<tr>
<th>MIDI Key</th>
<th>Note Number</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>D#3</td>
<td>63</td>
<td>909 – Pattern 8</td>
</tr>
<tr>
<td>D3</td>
<td>62</td>
<td>909 – Pattern 7</td>
</tr>
<tr>
<td>C#3</td>
<td>61</td>
<td>909 – Pattern 6</td>
</tr>
<tr>
<td>C3</td>
<td>60</td>
<td>909 – Pattern 5</td>
</tr>
<tr>
<td>B2</td>
<td>59</td>
<td>909 – Pattern 4</td>
</tr>
<tr>
<td>A#2</td>
<td>58</td>
<td>909 – Pattern 3</td>
</tr>
<tr>
<td>A2</td>
<td>57</td>
<td>909 – Pattern 2</td>
</tr>
<tr>
<td>G#2</td>
<td>56</td>
<td>909 – Pattern 1</td>
</tr>
<tr>
<td>G2</td>
<td>55</td>
<td>909 – Bank D</td>
</tr>
<tr>
<td>F#2</td>
<td>54</td>
<td>909 – Bank C</td>
</tr>
<tr>
<td>F2</td>
<td>53</td>
<td>909 – Bank B</td>
</tr>
<tr>
<td>E2</td>
<td>52</td>
<td>909 – Bank A</td>
</tr>
<tr>
<td>D#2</td>
<td>51</td>
<td>909 – Pattern On/Off</td>
</tr>
<tr>
<td>D2</td>
<td>50</td>
<td>808 – Pattern 8</td>
</tr>
<tr>
<td>C#2</td>
<td>49</td>
<td>808 – Pattern 7</td>
</tr>
<tr>
<td>C2</td>
<td>48</td>
<td>808 – Pattern 6</td>
</tr>
<tr>
<td>B1</td>
<td>47</td>
<td>808 – Pattern 5</td>
</tr>
<tr>
<td>A#1</td>
<td>46</td>
<td>808 – Pattern 4</td>
</tr>
<tr>
<td>A1</td>
<td>45</td>
<td>808 – Pattern 3</td>
</tr>
<tr>
<td>G#1</td>
<td>44</td>
<td>808 – Pattern 2</td>
</tr>
<tr>
<td>G1</td>
<td>43</td>
<td>808 – Pattern 1</td>
</tr>
<tr>
<td>F#1</td>
<td>42</td>
<td>808 – Bank D</td>
</tr>
<tr>
<td>F1</td>
<td>41</td>
<td>808 – Bank C</td>
</tr>
<tr>
<td>E1</td>
<td>40</td>
<td>808 – Bank B</td>
</tr>
<tr>
<td>D#1</td>
<td>39</td>
<td>808 – Bank A</td>
</tr>
<tr>
<td>D1</td>
<td>38</td>
<td>808 – Pattern On/Off</td>
</tr>
<tr>
<td>C#1</td>
<td>37</td>
<td>Synth 2 – Pattern 8</td>
</tr>
<tr>
<td>C1</td>
<td>36</td>
<td>Synth 2 – Pattern 7</td>
</tr>
<tr>
<td>B0</td>
<td>35</td>
<td>Synth 2 – Pattern 6</td>
</tr>
<tr>
<td>A#0</td>
<td>34</td>
<td>Synth 2 – Pattern 5</td>
</tr>
<tr>
<td>A0</td>
<td>33</td>
<td>Synth 2 – Pattern 4</td>
</tr>
<tr>
<td>G#0</td>
<td>32</td>
<td>Synth 2 – Pattern 3</td>
</tr>
<tr>
<td>G0</td>
<td>31</td>
<td>Synth 2 – Pattern 2</td>
</tr>
<tr>
<td>F#0</td>
<td>30</td>
<td>Synth 2 – Pattern 1</td>
</tr>
<tr>
<td>F0</td>
<td>29</td>
<td>Synth 2 – Bank D</td>
</tr>
<tr>
<td>E0</td>
<td>28</td>
<td>Synth 2 – Bank C</td>
</tr>
<tr>
<td>D#0</td>
<td>27</td>
<td>Synth 2 – Bank B</td>
</tr>
<tr>
<td>D0</td>
<td>26</td>
<td>Synth 2 – Bank A</td>
</tr>
<tr>
<td>C#0</td>
<td>25</td>
<td>Synth 2 – Pattern On/Off</td>
</tr>
<tr>
<td>C0</td>
<td>24</td>
<td>Synth 1 – Pattern 8</td>
</tr>
<tr>
<td>B–1</td>
<td>23</td>
<td>Synth 1 – Pattern 7</td>
</tr>
<tr>
<td>A#–1</td>
<td>22</td>
<td>Synth 1 – Pattern 6</td>
</tr>
<tr>
<td>MIDI Key</td>
<td>Note Number</td>
<td>Function</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>A–1</td>
<td>21</td>
<td>Synth 1 – Pattern 5</td>
</tr>
<tr>
<td>G#–1</td>
<td>20</td>
<td>Synth 1 – Pattern 4</td>
</tr>
<tr>
<td>G–1</td>
<td>19</td>
<td>Synth 1 – Pattern 3</td>
</tr>
<tr>
<td>F#–1</td>
<td>18</td>
<td>Synth 1 – Pattern 2</td>
</tr>
<tr>
<td>F–1</td>
<td>17</td>
<td>Synth 1 – Pattern 1</td>
</tr>
<tr>
<td>E–1</td>
<td>16</td>
<td>Synth 1 – Bank D</td>
</tr>
<tr>
<td>D#–1</td>
<td>15</td>
<td>Synth 1 – Bank C</td>
</tr>
<tr>
<td>D–1</td>
<td>14</td>
<td>Synth 1 – Bank B</td>
</tr>
<tr>
<td>C#–1</td>
<td>13</td>
<td>Synth 1 – Bank A</td>
</tr>
<tr>
<td>C–1</td>
<td>12</td>
<td>Synth 1 – Pattern On/Off</td>
</tr>
</tbody>
</table>
Synth Section Switches

When “Program Synth from Keyboard” is activated on the Options menu, and the focus (see the main ReBirth manual) is set to one of the synths, the following functions can be activated via MIDI note messages:

<table>
<thead>
<tr>
<th>MIDI Key</th>
<th>Note Number</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>G#0</td>
<td>32</td>
<td>Pitch Mode On/Off</td>
</tr>
<tr>
<td>G0</td>
<td>31</td>
<td>Step</td>
</tr>
<tr>
<td>F#0</td>
<td>30</td>
<td>Back</td>
</tr>
<tr>
<td>F0</td>
<td>29</td>
<td>Note/Pause</td>
</tr>
<tr>
<td>E0</td>
<td>28</td>
<td>Slide</td>
</tr>
<tr>
<td>D#0</td>
<td>27</td>
<td>Accent</td>
</tr>
<tr>
<td>D0</td>
<td>26</td>
<td>Octave Up</td>
</tr>
<tr>
<td>C#0</td>
<td>25</td>
<td>Octave Down</td>
</tr>
<tr>
<td>C0</td>
<td>24</td>
<td>Pitch C</td>
</tr>
<tr>
<td>B–1</td>
<td>23</td>
<td>Pitch B</td>
</tr>
<tr>
<td>A#–1</td>
<td>22</td>
<td>Pitch A#</td>
</tr>
<tr>
<td>A–1</td>
<td>21</td>
<td>Pitch A</td>
</tr>
<tr>
<td>G#–1</td>
<td>20</td>
<td>Pitch G#</td>
</tr>
<tr>
<td>G–1</td>
<td>19</td>
<td>Pitch G</td>
</tr>
<tr>
<td>F#–1</td>
<td>18</td>
<td>Pitch F#</td>
</tr>
<tr>
<td>F–1</td>
<td>17</td>
<td>Pitch F</td>
</tr>
<tr>
<td>E–1</td>
<td>16</td>
<td>Pitch E</td>
</tr>
<tr>
<td>D#–1</td>
<td>15</td>
<td>Pitch D#</td>
</tr>
<tr>
<td>D–1</td>
<td>14</td>
<td>Pitch D</td>
</tr>
<tr>
<td>C#–1</td>
<td>13</td>
<td>Pitch C#</td>
</tr>
<tr>
<td>C–1</td>
<td>12</td>
<td>Pitch C</td>
</tr>
</tbody>
</table>
808 Rhythm Section Switches

When “Program Synth from Keyboard” is activated on the Options menu, and the focus (see the main ReBirth manual) is set to the 808 Rhythm section, the following functions can be activated via MIDI note messages:

<table>
<thead>
<tr>
<th>MIDI Key</th>
<th>Note Number</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>D#1</td>
<td>39</td>
<td>Instrument – CH</td>
</tr>
<tr>
<td>D1</td>
<td>38</td>
<td>Instrument – OH</td>
</tr>
<tr>
<td>C#1</td>
<td>37</td>
<td>Instrument – CY</td>
</tr>
<tr>
<td>C1</td>
<td>36</td>
<td>Instrument – CB</td>
</tr>
<tr>
<td>B0</td>
<td>35</td>
<td>Instrument – CP</td>
</tr>
<tr>
<td>A#0</td>
<td>34</td>
<td>Instrument – RS</td>
</tr>
<tr>
<td>A0</td>
<td>33</td>
<td>Instrument – HT</td>
</tr>
<tr>
<td>G#0</td>
<td>32</td>
<td>Instrument – MT</td>
</tr>
<tr>
<td>G0</td>
<td>31</td>
<td>Instrument – LT</td>
</tr>
<tr>
<td>F#0</td>
<td>30</td>
<td>Instrument – SD</td>
</tr>
<tr>
<td>F0</td>
<td>29</td>
<td>Instrument – BD</td>
</tr>
<tr>
<td>E0</td>
<td>28</td>
<td>Instrument – AC</td>
</tr>
<tr>
<td>D#0</td>
<td>27</td>
<td>Step 16 - On/Off</td>
</tr>
<tr>
<td>D0</td>
<td>26</td>
<td>Step 15 - On/Off</td>
</tr>
<tr>
<td>C#0</td>
<td>25</td>
<td>Step 14 - On/Off</td>
</tr>
<tr>
<td>C0</td>
<td>24</td>
<td>Step 13 - On/Off</td>
</tr>
<tr>
<td>B–1</td>
<td>23</td>
<td>Step 12 - On/Off</td>
</tr>
<tr>
<td>A#–1</td>
<td>22</td>
<td>Step 11 - On/Off</td>
</tr>
<tr>
<td>A–1</td>
<td>21</td>
<td>Step 10 - On/Off</td>
</tr>
<tr>
<td>G#–1</td>
<td>20</td>
<td>Step 9 - On/Off</td>
</tr>
<tr>
<td>G–1</td>
<td>19</td>
<td>Step 8 - On/Off</td>
</tr>
<tr>
<td>F#–1</td>
<td>18</td>
<td>Step 7 - On/Off</td>
</tr>
<tr>
<td>F–1</td>
<td>17</td>
<td>Step 6 - On/Off</td>
</tr>
<tr>
<td>E–1</td>
<td>16</td>
<td>Step 5 - On/Off</td>
</tr>
<tr>
<td>D#–1</td>
<td>15</td>
<td>Step 4 - On/Off</td>
</tr>
<tr>
<td>D–1</td>
<td>14</td>
<td>Step 3 - On/Off</td>
</tr>
<tr>
<td>C#–1</td>
<td>13</td>
<td>Step 2 - On/Off</td>
</tr>
<tr>
<td>C–1</td>
<td>12</td>
<td>Step 1 - On/Off</td>
</tr>
</tbody>
</table>
**909 Rhythm Section Switches**

When “Program Synth from Keyboard” is activated on the Options menu, and the focus (see the main ReBirth manual) is set to the 909 Rhythm section, the following functions can be activated via MIDI note messages:

<table>
<thead>
<tr>
<th>MIDI Key</th>
<th>Note Number</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>D#1</td>
<td>39</td>
<td>Instrument – RC</td>
</tr>
<tr>
<td>D1</td>
<td>38</td>
<td>Instrument – CC</td>
</tr>
<tr>
<td>C#1</td>
<td>37</td>
<td>Instrument – OH</td>
</tr>
<tr>
<td>C1</td>
<td>36</td>
<td>Instrument – CH</td>
</tr>
<tr>
<td>B0</td>
<td>35</td>
<td>Instrument – CP</td>
</tr>
<tr>
<td>A#0</td>
<td>34</td>
<td>Instrument – RS</td>
</tr>
<tr>
<td>A0</td>
<td>33</td>
<td>Instrument – HT</td>
</tr>
<tr>
<td>G#0</td>
<td>32</td>
<td>Instrument – MT</td>
</tr>
<tr>
<td>G0</td>
<td>31</td>
<td>Instrument – LT</td>
</tr>
<tr>
<td>F#0</td>
<td>30</td>
<td>Instrument – SD</td>
</tr>
<tr>
<td>F0</td>
<td>29</td>
<td>Instrument – BD</td>
</tr>
<tr>
<td>E0</td>
<td>28</td>
<td>Instrument – AC</td>
</tr>
<tr>
<td>D#0</td>
<td>27</td>
<td>Step 16 - On/Off</td>
</tr>
<tr>
<td>D0</td>
<td>26</td>
<td>Step 15 - On/Off</td>
</tr>
<tr>
<td>C#0</td>
<td>25</td>
<td>Step 14 - On/Off</td>
</tr>
<tr>
<td>C0</td>
<td>24</td>
<td>Step 13 - On/Off</td>
</tr>
<tr>
<td>B–1</td>
<td>23</td>
<td>Step 12 - On/Off</td>
</tr>
<tr>
<td>A#–1</td>
<td>22</td>
<td>Step 11 - On/Off</td>
</tr>
<tr>
<td>A–1</td>
<td>21</td>
<td>Step 10 - On/Off</td>
</tr>
<tr>
<td>G#–1</td>
<td>20</td>
<td>Step 9 - On/Off</td>
</tr>
<tr>
<td>G–1</td>
<td>19</td>
<td>Step 8 - On/Off</td>
</tr>
<tr>
<td>F#–1</td>
<td>18</td>
<td>Step 7 - On/Off</td>
</tr>
<tr>
<td>F–1</td>
<td>17</td>
<td>Step 6 - On/Off</td>
</tr>
<tr>
<td>E–1</td>
<td>16</td>
<td>Step 5 - On/Off</td>
</tr>
<tr>
<td>D#–1</td>
<td>15</td>
<td>Step 4 - On/Off</td>
</tr>
<tr>
<td>D–1</td>
<td>14</td>
<td>Step 3 - On/Off</td>
</tr>
<tr>
<td>C#–1</td>
<td>13</td>
<td>Step 2 - On/Off</td>
</tr>
<tr>
<td>C–1</td>
<td>12</td>
<td>Step 1 - On/Off</td>
</tr>
</tbody>
</table>
Appendix D

PCF Pattern Diagrams
The pictures on the following pages show the 34 PCF patterns (see page 61). The length of a Pattern is important since it determines the repetition. Let’s use two examples to illustrate this:

- Pattern 3 is a sixteenth note pattern that is 12 steps long. This means it repeats itself after 12 sixteenth notes (three quarters of a measure, in 4/4).
- Pattern 40 is a thirtysecond note pattern that is 28 steps long, which means it repeats itself after 14 sixteenth notes.

The height of the bars show the dynamics of the pattern, that is, the “velocity” of the triggering of each step.

16th Note Patterns

In the first 34 Patterns, each step represents a sixteenth note. The total length varies, but the maximum length is 32 steps (two bars).
32nd Note Patterns

In Pattern 34 to 45, each step represents a thirtysecond note. Again, the length varies, but the maximum length is 32 steps (one bar).
Additional 2.0 Patterns

Pattern 47 to 54, are of varying length. As you can tell from the horizontal axis there are mixed 16th note and 32nd note patterns and even one eighth note Pattern that spans four bars.
Pattern 54
Appendix E

Keyboard Shortcuts
Menus

File menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Mac:</th>
<th>PC:</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>[Command]-[N]</td>
<td>[Control]-[N]</td>
</tr>
<tr>
<td>Open</td>
<td>[Command]-[O]</td>
<td>[Control]-[O]</td>
</tr>
<tr>
<td>Close</td>
<td>[Command]-[W]</td>
<td>[Control]-[W]</td>
</tr>
<tr>
<td>Save</td>
<td>[Command]-[S]</td>
<td>[Control]-[S]</td>
</tr>
<tr>
<td>Song Information</td>
<td>[Command]-[I]</td>
<td>[Control]-[I]</td>
</tr>
<tr>
<td>Quit</td>
<td>[Command]-[Q]</td>
<td>[Control]-[Q]</td>
</tr>
</tbody>
</table>

Edit menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Mac:</th>
<th>PC:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>[Command]-[X]</td>
<td>[Control]-[X]</td>
</tr>
<tr>
<td>Copy</td>
<td>[Command]-[C]</td>
<td>[Control]-[C]</td>
</tr>
<tr>
<td>Paste</td>
<td>[Command]-[V]</td>
<td>[Control]-[V]</td>
</tr>
<tr>
<td>Copy Touched Controls to Loop</td>
<td>[Command]-[L]</td>
<td>[Control]-[L]</td>
</tr>
<tr>
<td>Copy Touched Controls to Song</td>
<td>[Command]-[T]</td>
<td>[Control]-[T]</td>
</tr>
<tr>
<td>Shift Pattern Left</td>
<td>[Command]-[J]</td>
<td>[Control]-[J]</td>
</tr>
<tr>
<td>Shift Pattern Right</td>
<td>[Command]-[K]</td>
<td>[Control]-[K]</td>
</tr>
<tr>
<td>Randomize Pattern</td>
<td>[Command]-[R]</td>
<td>[Control]-[R]</td>
</tr>
<tr>
<td>Alter Pattern</td>
<td>[Command]-[Y]</td>
<td>[Control]-[Y]</td>
</tr>
<tr>
<td>Alter Accents etc.</td>
<td>[Command]-[U]</td>
<td>[Control]-[U]</td>
</tr>
</tbody>
</table>

 Mods menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Mac:</th>
<th>PC:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Mod</td>
<td>[Command]-[M]</td>
<td>[Control]-[M]</td>
</tr>
</tbody>
</table>

 Mods menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Mac:</th>
<th>PC:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Synth From Keyboard</td>
<td>[Command]-[F]</td>
<td>[Control]-[F]</td>
</tr>
</tbody>
</table>

- 222 -
<table>
<thead>
<tr>
<th>Command:</th>
<th>Mac:</th>
<th>PC:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Pattern from Keyboard</td>
<td>[Command]-[G]</td>
<td>[Control]-[G]</td>
</tr>
</tbody>
</table>
Transport Controls

The following transport commands can be executed from the numeric key pad, to the left on the computer keyboard:

<table>
<thead>
<tr>
<th>Command:</th>
<th>Mac:</th>
<th>PC:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop</td>
<td>[0]</td>
<td>[0]</td>
</tr>
<tr>
<td>Play</td>
<td>[Enter]</td>
<td>[Enter]</td>
</tr>
<tr>
<td>Stop/Play</td>
<td>[space bar]</td>
<td>[space bar]</td>
</tr>
<tr>
<td>Record</td>
<td>[*]</td>
<td>[*]</td>
</tr>
<tr>
<td>Fast Forward</td>
<td>[=]</td>
<td>[4]</td>
</tr>
<tr>
<td>Rewind</td>
<td>[Num Lock]</td>
<td>[5]</td>
</tr>
<tr>
<td>Go to Loop Start</td>
<td>[1]</td>
<td>[1]</td>
</tr>
<tr>
<td>Go to Loop End</td>
<td>[2]</td>
<td>[2]</td>
</tr>
<tr>
<td>Next Bar</td>
<td>[8]</td>
<td>[8]</td>
</tr>
<tr>
<td>Previous Bar</td>
<td>[7]</td>
<td>[7]</td>
</tr>
<tr>
<td>Tempo Up</td>
<td>[+/-]</td>
<td>[+/-]</td>
</tr>
<tr>
<td>Tempo down</td>
<td>[–]</td>
<td>[–]</td>
</tr>
</tbody>
</table>

Pattern Selection

To select Patterns from the computer keyboard, make sure “Select Patterns from Keyboard” is selected on the Options menu. Use the typewriter part of the computer keyboard!

This assumes you are using an American keyboard. If not, check the illustration on page 20 instead. The keys are on absolute positions on the keyboard, not on certain character positions.

<table>
<thead>
<tr>
<th>Pattern:</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synth 2:</td>
<td>[Q]</td>
<td>[W]</td>
<td>[E]</td>
<td>[R]</td>
<td>[T]</td>
<td>[Y]</td>
<td>[U]</td>
<td>[I]</td>
</tr>
<tr>
<td>808 Rhythm:</td>
<td>[A]</td>
<td>[S]</td>
<td>[D]</td>
<td>[F]</td>
<td>[G]</td>
<td>[H]</td>
<td>[J]</td>
<td>[K]</td>
</tr>
<tr>
<td>909 Rhythm:</td>
<td>[Z]</td>
<td>[X]</td>
<td>[C]</td>
<td>[V]</td>
<td>[B]</td>
<td>[N]</td>
<td>[M]</td>
<td>[,]</td>
</tr>
</tbody>
</table>
**Synth Programming**

To program the synth section from the computer keyboard, make sure “Program Synth from Keyboard” is selected on the Options menu.

This assumes you are using an American keyboard. If not, check the illustration on page 43 instead. The keys are on absolute positions on the keyboard, not on certain character positions.

<table>
<thead>
<tr>
<th>Command:</th>
<th>Mac/PC:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step</td>
<td>[Return]</td>
</tr>
<tr>
<td>Back</td>
<td>[Backspace]</td>
</tr>
<tr>
<td>C</td>
<td>[C]</td>
</tr>
<tr>
<td>C#</td>
<td>[F]</td>
</tr>
<tr>
<td>D</td>
<td>[V]</td>
</tr>
<tr>
<td>D#</td>
<td>[G]</td>
</tr>
<tr>
<td>E</td>
<td>[B]</td>
</tr>
<tr>
<td>F</td>
<td>[N]</td>
</tr>
<tr>
<td>F#</td>
<td>[J]</td>
</tr>
<tr>
<td>G</td>
<td>[M]</td>
</tr>
<tr>
<td>G#</td>
<td>[K]</td>
</tr>
<tr>
<td>A</td>
<td>[,] (comma)</td>
</tr>
<tr>
<td>A#</td>
<td>[L]</td>
</tr>
<tr>
<td>B</td>
<td>[.] (period)</td>
</tr>
<tr>
<td>C</td>
<td>[/]</td>
</tr>
<tr>
<td>Note/Pause</td>
<td>[–]</td>
</tr>
<tr>
<td>Accent</td>
<td>[P]</td>
</tr>
<tr>
<td>Slide</td>
<td>[[](left bracket)</td>
</tr>
<tr>
<td>Octave Down</td>
<td><a href="semicolon">;</a></td>
</tr>
<tr>
<td>Octave Up</td>
<td><a href="apostrophe">’</a></td>
</tr>
<tr>
<td>Tab</td>
<td>“Tap” Rhythm</td>
</tr>
<tr>
<td>Shift + Tab</td>
<td>Delete notes during playback</td>
</tr>
</tbody>
</table>
909 Section Modifiers

<table>
<thead>
<tr>
<th>Command:</th>
<th>Mac:</th>
<th>PC:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Volume</td>
<td>[Command]</td>
<td>[Control]</td>
</tr>
<tr>
<td>High Volume</td>
<td>[Option]</td>
<td>[Alt]</td>
</tr>
<tr>
<td>Flam</td>
<td>[Command]+[Option]</td>
<td>[Control]+[Alt]</td>
</tr>
</tbody>
</table>

Rhythm Tap Programming

As described on page 32, you can “tap” the rhythm on the keyboard. This assumes you are using an American keyboard (see page 32).

<table>
<thead>
<tr>
<th>Command:</th>
<th>808 Section:</th>
<th>909 Section:</th>
</tr>
</thead>
<tbody>
<tr>
<td>–</td>
<td>AC</td>
<td>AC</td>
</tr>
<tr>
<td>A</td>
<td>BD</td>
<td>BD</td>
</tr>
<tr>
<td>S</td>
<td>SD</td>
<td>SD</td>
</tr>
<tr>
<td>D</td>
<td>LT/LC</td>
<td>LT</td>
</tr>
<tr>
<td>F</td>
<td>MT/MC</td>
<td>MT</td>
</tr>
<tr>
<td>G</td>
<td>HT/HC</td>
<td>HT</td>
</tr>
<tr>
<td>H</td>
<td>RS/CL</td>
<td>RS</td>
</tr>
<tr>
<td>J</td>
<td>CP/MA</td>
<td>CP</td>
</tr>
<tr>
<td>K</td>
<td>CB</td>
<td>CH</td>
</tr>
<tr>
<td>L</td>
<td>CY</td>
<td>OH</td>
</tr>
<tr>
<td>;</td>
<td>OH</td>
<td>CC</td>
</tr>
<tr>
<td>‘</td>
<td>CH</td>
<td>RC</td>
</tr>
<tr>
<td>Shift</td>
<td>Delete notes during playback</td>
<td>Delete notes during playback</td>
</tr>
</tbody>
</table>
Index
A
About ReBirth RB-338 166, 180
AC 149, 151
Accent
  Rhythm 35, 149, 151
  Synth button 45, 154, 156
  Synth knob 49
Adjust Sync 117, 172
AIFF files 124, 142, 167
Alter 54, 170
AMD 187
Amount (Distortion) 60, 163
Amt 66, 160
Apple menu 166
Attack 37, 152
Audio
  Buffer 12, 14
  Exporting 142
  Playing in background 123
  Setting up 10, 14
  Sharing on Mac 124
  Sharing under Windows 123
Audio card
  General 182
  Macintosh 188
  Selecting 11
  Sharing audio 123, 124
  Windows 184
Audio Card Driver 11, 172, 185
Audio Quality 182

B
Back 40, 154
Background playback 123
Bank selector 147
BD 149, 151
Benchmark Test 167
BP 65, 160
Buffer Size 172
Buffer size 12, 14

C
Cascade 179
CB 149
CC 151
CH 149, 151
CL 149
Clear Pattern 169
Clearing
  General 52
  Synth 46, 153
Close 166
Compressor
  Introduction to 67
  Level Reduction meter 68, 164
  On/Off 164
  Ratio 68, 164
  Reference 164
  Threshold 68, 164
Computer 19
Computer keyboard 19, 221
Controllers
  For controlling ReBirth 126
  Specifying 131
  Standard implementation 194
Copy
  in Song 85
  Pattern 51
Copy Loop 176
Copy Pattern 169
Copy Touched Controls 78, 83, 177
CP 149, 151
Crackle safe 14
Cubase 101
Customizing Songs 136
Cut
  Loop 85, 176
  Pattern 51, 169
Cutoff 48, 155
CY 149
Cyrix 187

D
Dec 66, 160
Decay
  Rhythm 37, 149, 152
  Synth 49, 155
Delay
  Amount 157
  Feedback 161
  Introduction to 69
  Meter 161
  On/off 161
  Pan 162
  Reference 161
  Steps (Length) 161
DirectX 11, 184
Distortion
  Amount 163
  Introduction to 59
  On/Off 163
  Reference 163
  Switch 158
Down 154
Download ReBirth Mods 180
Download ReBirth Songs 180
E
Effects
  Compressor 67
  Delay 69
  Distortion 59
  Introduction to 56
  PCF 61
  Routing 58
Env. Mod. 49
Export Loop as AIFF/Wave 124, 142, 167

F
F.Back 70, 161
Fast Forward button 146
Feedback 70, 161
Flams 30, 152
Focus Bar 22, 52
Freq 65, 160

G
Go to Propellerhead's Homepage 180
Go to Steinberg's Homepage 180

H
HC 149
Help 180
Hi-hat (open vs. closed) 35
HT 149, 151
Hubi's Loopback Device 116

I
Initialize Loop from Pattern Mode 83, 176
Initialize Song from Pattern mode 75, 177
Intel 187

K
Keyboard
  Rhythm Programming From 32
  Selecting Patterns From 20
  Shortcuts 221
  Synth Programming From 43

L
Latency 183
LB1 116
LC 149
Learn 131, 175
Level
  Introduction to 24
  Master 56
  Mixer 56
  Rhythm 37, 151
Level Reduction meter (Compressor) 68, 164
Live Sync 120
Loop
  On/Off 146
  Playback 73
  Recording 84
  Start and Length 146
LP 65, 160
LT 149, 151

M
MA 149
Master
  Level 23, 56, 165
  Meter 165
Master Section 165
MC 149
Meter
  Compressor section 164
  Delay 161
  Distortion section 163
  Master 165
  Mixer 157
  PCF 159
MIDI
  Indicator 120, 144
  Input 172
  LED 120, 132, 144
  Remote Control 126
  Standard Mapping Table 194
MIDI Channel 127, 172
MIDI Clock 112, 120
MIDI Clock Sync 113
MIDI Clock Sync Enable 172
MIDI Control ID 175
MIDI Indication 132
MIDI Input 113, 128, 172
MIDI Port 114
Mixers 23, 157
Mixing
  Introduction to 56
  Levels 56
  Master Level 56
  Muting 57
  Pan 57
MME 184
Mode 65, 160
ModPacker 96
Mods
  Creating 96
  Dialog 94
  Downloading automatically 92
  Downloading manually 95
  Installing 95
  Introduction to 89
  Memory requirements 89
  New Songs 91
  Opening Songs with 92
  Uploading 99
MT 149, 151
MultiMedia Extensions 184
Multitasking friendly 14
Muting 57

N
  New 136, 166
  Note/Pause button 154

O
  Octave 45
  OH 149, 151
  OMS 103, 113, 114
  Open 166
  Opening Songs 138
  Order ReBirth Now 180

P
  Pan
    Delay 70, 162
    Mixer 57, 157
  Paste
    Pattern 51, 169
    Song 85
  Paste at Song Position 176
  Paste Replace at Song Position 86, 176
  Pattern
    Length 36, 46
    Moving between Songs 139
    PCF 159
    Rhythm programming 25
    Selecting 20
    Synth programming 38
    Tapping 32, 44

Pattern Editing
  Alter 54
  Copy 51
  Cut 51
  Paste 51
  Random 53
  Shift 53
  Transpose 54
  Pattern mode 17, 72
  Pattern selector 147
  Patterns and knob settings for new Songs 173
PCF
  About 61
  Amt 66, 160
  BP/LP 65
  Dec 66, 160
  Freq 65, 160
  Mode 65, 160
  Pattern 65, 159
  Pattern diagrams 205
  Q 66, 160
  Routing 64
  Switch 158
  Pitch buttons 153
  Pitch Mode 42, 153
  Pitches
    from Keyboard 43
    Setting in existing Pattern 42
    Specifying 41
  Play button 145
  Play Mod Startup Sound 173
  Playback Performance slider 172
  Preferences 171
  Program Synth from Keyboard 179, 225

Q
  Q 66, 160
  Quick Mapping 130, 131
  Quick Setup 174
  Quit 168

R
  Random 53, 170
  Ratio (Compressor) 68, 164
  RC 151
  ReBirth knob 175
  ReBirth ModPacker 96
  ReBirth Tech Info and Support 180
  Received MIDI Control ID to Learn 131, 175
  Recent Documents 168
  Record button 146
  Remote MIDI
    Quick Mapping 130, 131
    Standard Mapping 130, 194
Remote MIDI Control 126, 127
Repeating measures 86
Resize Application Window to Documents 179
Reso 155
Resonance 48, 155
Rewind button 145
ReWire
   Channels 105
   Converting to Audio Tracks 110
   CPU requirements 103
   In VST Channel Mixer 109
   Introduction to 102
   Launching 104
   Limitations 110
   Memory requirements 103
   Signal Routing 106
Rhythm Patterns
   Accents 35
   Adding notes 29
   Clearing 36
   Lengths 36
   Programming 25
   Removing notes 29
   Tap recording 32
Rhythm sounds
   Parameters 37
   Reference for 808 149
   Reference for 909 151
   Selecting 28
   Shared sounds 34
RS 149, 151

S
Save 166
Save As 166
Saving Songs 137
Scan for New Mods 95
SD 149, 151
Select Mod 94
Select Patterns from Keyboard 179, 224
Shared sounds 149
Shift 53, 169
Shuffle 21
Slide 45, 154
Snappy 37, 150, 152

Song
   Customizing 136
   End 78
   Introduction to 72
   Moving Pattern between 139
   New 136
   Opening 138
   Playing 73
   Punching In and Out 79
   Recording Control changes 80
   Recording Pattern changes 76
   Saving 137
Song Editing
   Copy 85
   Cut 85
   Paste 85
   Paste Replace 86
   Remove 85
   Repeating 86
   Song Mode 17, 72, 144
   Song Position Pointers 118, 120
   Sound Manager 14, 188
   Sound Selector 28, 148
   Standard Mapping 130
   Standard MIDI Mapping Table 194
   Startup Song 136
   Stay on Top 139, 179
   Step
      Button 40, 154
      Display 147, 154
      Rhythm 29, 30
   Steps (Delay setting) 70, 161
   Stop button 145
   Straight notes/Triplets 70, 161
   Sync Indicator 121, 145
   Sync to MIDI Clock 113, 179
Synchronization
   Adjust 117
      Introduction to 112
      Live Sync 120
   Song Position Pointers 118, 120
   Sync Indicator 121
   Tempo changes 119
   Tempo Display 118
   To external device 113
   To other program 114
Synth Patterns
   Accent button 45
   Clearing 46
   Length 46
   Notes or pauses for start 40
   Octave 45
   Pitch Mode 42
   Programming 38
   Programming from keyboard 43
   Slide 45
Synth settings
  Accent 49
  Cutoff 48
  Decay 49
  Env. Mod. 49
  Resonance 48
  Tune 48
  Waveform 48
System 8 15

T
Tap recording
  Rhythm 32
  Synth 44
Tempo 145
Tempo changes 119
Tempo display 118
Threshold (Compressor) 68, 164
Tone 37, 149, 152
Transport Panel 144
Transpose 54, 170
Tune
  Rhythm 37, 150, 152
  Synth 48, 155

U
Underruns 172
Up 154
Use Current Song 136

V
Values, setting 18
Vintage ReBirth Synth Sound 170
Volume
  Master 165
  Mixers 56, 157
  Rhythm 37, 151

W
Wave files 124, 142, 167
Waveform selector 48, 155
Windows menu 138, 179